
 

Use Adobe Camera Raw to perfect your images 
in Photoshop, Elements and Lightroom

4  Unlock your camera’s raw potential
4  Learn the key image processing steps 
4  Make professional-looking adjustments

Includes 
essential 
raw fixes  
& edits
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To get the best image quality from your SLR or compact system 
camera, you need to be shooting in the raw image format. Raw files 

contain much more detail in the scene compared with a simple 
JPEG, and provide far more flexibility to adjust contrast, colour and 

exposure at the editing stage. 
There are many ways to process your raw files, and the most 

popular and best software is one of the Photoshop family of 
programs. Whether you use Photoshop CS or CC, Photoshop 

Lightroom or Photoshop Elements, the conversion process is powered 
using the powerful built-in plugin called Adobe Camera Raw.

The range of controls you get in Adobe Camera Raw depends on the 
version of Photoshop you’re using. You get a greater range of features 

with Photoshop CC, for instance, than you do with Photoshop 
Elements. But the core functionality is available in all versions, so 
whatever version of Photoshop you’re using, you’ll be sure to find 

plenty in this book to improve your photo-editing skills. Don’t forget 
to download your free images from FileSilo so you can follow our 

tutorials on your Mac or PC.
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P
hotography has long been thought of as being all 
about capturing a particular moment. The 
photographer’s job is to recognise – or create – 
that moment and produce a still image that 

encapsulates it. Before digital photography, being a 
photographer was, for many people, all about the moment 
when you press the shutter button. Further manipulation of 
the final image was limited to those who had access to a 
traditional wet darkroom and, to a large extent, the notion 
of photography as something that mostly happens ‘in the 
moment’ has endured.

As a rule, photographers like things to be as good as they 
possibly can be. Many photographers will happily attest 
that they are perfectionists who can’t rest until they have 
got the best possible result and optimum quality. For most, 

the pursuit of premium pixel performance is the most 
important consideration and so, while it demands that the 
process is extended far beyond the point of capture, the raw 
file format is, for most professionals, cardinal.

Of course, there are always photographers who prefer  
the undeniable convenience and immediacy of the 
JPEG format. One of the arguments often mentioned by 
dissenters of raw capture is that, if you understand light and 
know what you are doing in terms of metering, focusing 
and composition in-camera, then a JPEG is all you will ever 
need. However, while the JPEG approach works for some, 
the potential of raw goes far beyond salvaging in-camera 
errors and miscalculations.

Over the next few pages, you’ll discover how the pros use 
raw and the value it has for a professional workflow.

Harness the 
power of Raw
Embrace the creative potential of the pro’s file format of choice
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JPEG file 
This JPEG file has come straight out of 

the camera with a certain degree of the 
processing decisions irreversibly applied. 
Information has already been discarded

Processed raw file 
When working from a raw file, it’s possible 
to adjust the white balance, exposure and 

clarity in fine detail, while applying local 
adjustments like gradients

O
nce you are used to 
shooting raw, it’s fair to 
say that you’ll probably 
never look back. The 

level of flexibility that a raw file 
offers photographers can never be 
truly matched by a JPEG or even a 
TIFF. If you normally shoot in raw 
with your DSLR or CSC and find 
yourself restricted to using JPEG 
only, it can be quite frustrating.

Some people make an association 
between raw capture and a lack 

JPEG offers 
convenience, but raw 
offers quality

Why Raw  
matters

3 RAW AdJustmEnt #3

the white balance has been changed, 
making the processed raw file look very 
different from the JpeG.

1 RAW AdJustmEnt #1

a Graduated filter has been applied 
to the sky in order to add discreet 
adjustments to this area of the image.

4 RAW AdJustmEnt #4

the edge of the image has been 
darkened so that the eye is drawn into 
the main subject matter of the frame.

2 RAW AdJustmEnt #2

the adjustment brush has been used 
on the structure in the foreground to 
give it greater tonal separation.

1

3 4

2



Teach yourself Raw in Photoshop
Harness tHe power of raw

11

To err is human; even the best photographers are going to get it wrong from time to time and 
under or overexpose. In the old days, photographers would either hope to be able to rescue such 
mistakes at the film-processing and printing stage or would simply have to accept defeat. In these 
digital days, it’s very possible to rescue a problematic exposure using the Exposure, Highlights 
and Shadows sliders in Adobe Camera Raw, Lightroom, Capture One Pro or DxO OpticsPro.

of technical craft behind the camera, 
assuming that raw exists only to rescue 
photographers when they are unable 
to light or meter a scene correctly. 
However, this isn’t a particularly 
accurate assessment at all.

The bottom line is that your camera’s 
raw mode offers you a means to 
obtain the maximum image data and 
information, as recorded by the sensor. 
Few photographers don’t covet the best 
cameras on the market, but to buy and 
use a top-end camera while not taking 
the time to extract the maximum 
quality from it’s sensor doesn’t really 
make a lot of sense. 

Time is a pertinent concept when 
discussing raw, because there’s no 
question that if you shoot raw you need 
to invest extra time post-capture in 
order to make your images shareable 
and ready for print.

The key thing to remember is that no 
matter what, time spent working with 
raw files is time well spent. For example, 
the degree of dynamic range that you 
can extract from a raw file is far in 
excess of what you’ll get from a typical 
JPEG. It’s not uncommon to be able to 
get as much as two extra stops out of 
the shadows and highlights, a difference 
that can make a huge impact. 

The range of brightness levels that 
a raw file, either in 12-bit or 14-bit 
mode, can store is literally hundreds 
of times more than an 8-bit JPEG can 
handle – as many as 16,384 compared 
to just 256. In terms of colour, a JPEG 
carries the information for 16 million 
tones, while a raw file has 68 billion. 
With more colours, tonal transitions 
are smoother, which leaves vastly more 
editing potential before artefacts, such 
as banding, start to rear their ugly head.

“If you think back to the days of film, 
shooting JPEG is rather like taking your 
films to a high street lab and letting 
their machines make all the decisions 
about how your pictures should 
look,” says professional landscape 
photographer Mark Bauer (www.
markbauerphotography.com). “You 
might like the results, but there’s a fair 
chance you won’t. Raw is much more 
like going into your own darkroom 
and making a carefully crafted hand 
print: you’re in total control and can 
get the image looking exactly how you 
visualised it when you first pressed the 
shutter on your camera.”

WhAt is A RAW filE?

this is the information that’s been 
recorded by your camera’s sensor, 
delivered to you without interference by 
the camera – though some cameras will 
compress the data, losslessly.

Redeem your files with the help of a raw processor
RAW exposure recovery

Overexposed In this JpeG file, the highlight detail has 
been lost because the image has been overexposed by 
using too long a shutter speed.

highlights recovered fortunately, a raw file was 
recorded alongside the JpeG, enabling the highlights to 
be recovered effectively.

OvERExPOsuRE

underexposed In this JpeG file, the shadow detail is 
obscured because the image has been underexposed 
by using too slow a shutter speed.

shadows redeemed the level of detail that is able to be 
recovered from an underexposed raw file (nikon nef, in 
this example) is absolutely remarkable.

undERExPOsuRE

 drastically overexposed In this JpeG file, the image 
has been extremely overexposed and is probably 
unrecoverable, but the raw file was tested in adobe 
Camera raw, just in case.

Raw limits It’s not always possible to get as much 
detail back in the highlights. the colour information has 
been lost in this file. Many photographers will err on the 
side of underexposure.

dRAstic OvERExPOsuRE

JPEG

JPEG

JPEG

RAW

RAW

RAW
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controls in the most popular raw 
processing applications, you can 
produce an incredible array of 

different effects from a single file, all the 
while working completely non-destructively, 
with your original information remaining 
entirely intact, as Adrian Dewey (www.
adriandewey.com) explains. “One of the 
greatest advantages of raw is the fact it is 
non-destructive. All the information is there 
in the file and you can work on this image 
until your heart is content, and if after lots of 
editing you realise that you haven’t quite got 
it right, you can open the saved image and 
begin working on it all over again, taking it 
back to the start or tweaking any of your 
processes without any quality loss. A JPEG 
image loses quality every time you open, edit 

and re-save. This can become very noticeable 
if printing the image.”

On the page opposite, you’ll see an example 
of this in action. A single image, captured as 
a raw file, has been processed in six different 
ways, demonstrating the way in which 
modern raw processors have the potential 
to make a dramatic difference to the way 
your image looks. The original image is a 
fairly straightforward studio shot, but a few 
minutes in a raw processor, such as Adobe 
Camera Raw, is all that’s required to create 
a look that’s very different to the way file 
appears straight out of the camera. 

What’s more, if you find a look that you 
particularly like, you can easily save it as a 
preset that you can return to at a later date 
with ease, which is a massive time-saving 
function for busy photographers and goes a 
long way towards negating the oft-mentioned 
objection that raw is too slow and doesn’t 
offer the convenience of a JPEG file.

Although these looks are very different, it’s 
often by varying the same few adjustments 
that the diverse effects are produced. In the 
Basic tab in Adobe Camera Raw, you’ll find 
that the White Balance, Highlights, Shadows 
and Clarity sliders are remarkably powerful. 

Discover how much can be achieved with just 
a single exposure in Adobe Camera Raw

Processing potential

shARPEninG mAttERs

If your raw files look a little soft straight out of 
the camera, you might want to go to the Detail 
tab in aCr and use the sharpening sliders. 
sharpening is very subjective.

BlEnd And mERGE 
ExPOsuREs

If you’ve captured multiple raw files at different 
exposures with the intention of merging them 
into an HDr composite, you can now do this 
directly within the adobe Camera raw interface. 
simply select multiple files by holding Cmd/
Ctrl on your keyboard and then Ctrl/right-click 
to reveal a pop-up window that presents the 
Merge to HDr option. alternatively, you can 
stitch multiple frames into a panorama using 
the Merge to panorama option.

Of course, all the sliders play their part, 
but these seem to produce a particularly 
significant impact. The Tone Curve in 
Point mode is every bit as significant as a 
Curves adjustment in Photoshop, while the 
Adjustment brush and Graduated Filters 
facilitate localised enhancements that can 
make a massive difference. Each of the 
different looks took only a few minutes to 
produce, with the exception of the hand-
colouring effect, which took slightly longer – 
around ten minutes.

maximise your quality
Shooting in you camera’s raw format is 
the best way to ensure that you get the 
full potential out of your images
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Left
the original raw file
This is the image as originally captured by 
the camera, with no adjustments applied in 
post-production. Often with unprocessed 

raw files, it looks good, but a little flat

2 sketch 
This image has been processed to 
create a look that’s solarised yet also 

looks like a sketch. Converting to black and 
white in ACR was the starting point, but the 
key adjustment took place with the Tone 
Curve. The White Balance, Exposure and 
Contrast sliders were all significant here.

3 Go mono 
This is the least radical of all the 
looks here, as it’s essentially a 

standard black-and-white conversion. The 
Contrast slider was pushed up to +70 to 
avoid a flat appearance, which undermines 
mono photos. In the HSL/Grayscale tab, 
Oranges were brightened to flatter the skin.

5 cross process
This cross-processed look was 
extremely popular during the 

Nineties and can still look appealing when 
used in the right context. The main colour 
effect is created by using the Red, Green and 
Blue Curves in the Tone Curve tab, as well as 
boosting the contrast.

6 hand colour 
This hand-colouring effect takes a 
little longer to achieve, but is well 

worth the time and effort. You need to work 
with the Adjustment brush – selecting 
different colours as you go – and gradually 
build the final result, one area of the image 
at a time.  

4 split tone 
This is really an extension of the 
previous look, but the black and 

white presentation here has been enhanced 
by the use of the Split Toning tab, which 
enables you to easily adjust the tones of the 
Highlights and Shadows precisely. Exposure 
was darkened and the Clarity slider used.

Get creative in Raw
Add unique looks to your raw captures

1 cool and contrast 
This image has had micro-contrast 
added to it via the Clarity slider at +70, 

its global contrast has been boosted using 
the Contrast slider and Tone Curve. White 
balance has been cooled while the Graduated 
Filter and Adjustment brush have been used 
for localised colour and luminosity.
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RAW PROcEssinG OPtiOns

a look the most popular raw 
processing applications

s
peak to most professional 
photographers and you’ll discover 
that they almost always favour raw, 
with relatively few professing to 

prefer JPEG. Remember, these are men and 
women who make their living taking photos 
and certainly know how to handle a camera 

– but they still find RAW preferable because 
it simply offers them greater quality, 
flexibility and peace of mind. 

It really is important not to think of raw 
as a means of getting yourself out of trouble 
when you’ve messed up the exposure. 

“There used to be reasons why it was more 
difficult to process raw files than JPEGs, but 
those reasons no longer apply,” says Peter 
Eastway (www.petereastway.com). “It’s true 
that saving raw files requires more computer 
processing power and storage space, but these 
days, this simply isn’t a problem. If your 
computer is less than three years old, it can 
handle raw files.”

The choice of raw processor varies from 
photographer to photographer. Eastway’s 
editing tool of choice is Capture One Pro. “I 
use Phase One’s Capture One 8. I use it for all 
my files – Phase One, Canon, Fujifilm [and] 
Nikon etc. I can also use Lightroom, which 
is essentially the same as Adobe Camera 
Raw. Some of my friends prefer Lightroom to 
Capture One, so it depends to some extent 
on what you like – it’s a subjective decision. 
However, for me, Capture One gives me 
richer, stronger reproductions with better 
blacks and a more pleasing colour rendition. 
It suits my style of photography better than 
Lightroom [or] ACR.”

For pro photographer Mark Bauer, 
Lightroom is his preference. “I’ve used Adobe 
Lightroom for a number of years now,” he 
says. “I can do virtually everything I want 
within the one programme, without having to 
move on to Photoshop. It’s also excellent for 
organising and keywording images.”

Although processing time can indeed be 
a factor when working with raw files, for 
many this is often very enjoyable, as David 
and Janet Southard of Wild Arena (www.
wildarena.com) explain. “We may be out for a 
day taking pictures, but then have one or two 
days processing those pictures – although, 
for some people, this part of the process 
gives them the most pleasure.”

Find out how professional photographers consider 
RAW and incorporate it into their workflows

The pro perspective

KEEP An EyE  On cliPPinG

It’s always worth keeping an eye on the 
histogram in your raw processing application 
to ensure that you are not excessively clipping 
shadow or highlight detail.

Adobe camera Raw 
this is perhaps the raw processor most familiar 
to novices and professionals alike. It’s included 
as part of photoshop CC and if you drag a raw  
file into photoshop the aCr interface 
automatically opens.

lightroom 
Lightroom has developed over the last few 
years and is now, arguably, the most popular 
application among many professionals. the 
Develop tab enables you to process raw files 
similarly to aCr.

dxO OpticsPro 
though Dxo opticspro is most often associated 
with correcting lens problems such as distortion, 
this is also a very useful raw processing engine 
that’s easy to use and offers plenty of options to 
experiment with.

capture One Pro 
the Capture one pro application has many 
passionate devotees among the pros – peter 
eastway and tom Barnes both find that it 
produces results that are more pleasing than 
other raw processors.
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mAximisE EditinG 
POtEntiAl

even if you don’t intend to edit in raw, 
you can still use your raw processor  
to increase the possibilities you have 
in photoshop

cOlOuR 
sPAcE

another advantage 
of raw is the 
ability to choose 
the colour mode, 
whether that’s 
srGB, adobe 
rGB 1998 or 
pro photo rGB, 
when it comes to 
outputting your 
file from your raw 
converter.

If you want to work on a file in photoshop, with 
access to Layers and the multiple tools and 
filters available within that application, you 
might want to consider flattening out your image 
in your raw processor. essentially, this simply 
means maximising the shadow and highlight 
detail that’s present in the file, leaving you plenty 
of room for further experimentation. Keep an eye 
on the histogram and use this as a guide.

t
he big difference with raw is the 
ability to change colours in a 
responsive and effective way. 

Eastway says that colour is one 
of the main reasons why he favours raw. “All 
of the editing tools can be applied equally to 
raw and JPEG files. The difference is in how 
the files respond to your changes. A great 
example is colour balance. To change the 
colour balance in a JPEG can be a struggle, 
especially with mixed light sources and it 
can seem impossible to get just the right 
colour no matter how careful you are with the 
sliders. The problem lies within the JPEG file 
itself – it doesn’t have enough information 
to enable the changes. The same adjustments 
applied to a raw file can produce far superior 
results, simply because the raw file has more 
information to work with, whereas the JPEG 
has thrown a lot of its information away.” 
Mark Bauer agrees. “With JPEGs, there’s a 
severe limit to what you can achieve with 
colour balance,” he says. 

David and Janet Southard summarise 
the raw advantage quite neatly. “I think, for 
us, there are two main advantages to raw… 
It gives us the ultimate scope in terms of 
flexibility in our image processing. With 
no ‘baked in’ parameters at the point of 
file creation the raw file leaves the camera 
with 100 per cent of the possible data 
available making it ideal for enabling options 
afterwards. [Additionally], raw files are 
theoretically more future proof. With a file 
that contains all the possible data at its 
conception, you are always able to revisit 
processing the image in the future, possibly 
with fresh ideas or improved software. Who 
knows what options we will have in ten years!”

A closer look at how raw 
files can get the very best 
from your images

The Raw 
decision

100%

JPEG architecture 
This JPEG looks flat. There’s also 

missing highlight detail. Adjusting 
the colour and the exposure in 

Photoshop is problematic

Raw equivalent 
Making adjustments to the 

raw file, particularly the 
White Balance to correct the 
colour and some work on the 
highlights, improves it greatly

detail recaptured 
It’s amazing how much 
detail is actually present 
in the water once some 
highlight recovery has 
been performed

unedited raw file 
This unedited raw appears to 
be missing highlight detail and 
it’s a little cold – problems that 
are hard or even impossible to 
redeem in JPEG format
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d
anny Meadows: “I’ve been solely a 
professional retoucher for six 
years and a retoucher among other 
titles for years more, yet choosing 

between raw processors has never yielded a 
definitive favourite. Adobe Camera Raw is a 
great, solid workhorse of a program and the 
one I’ve chosen to use in this tutorial, 
although for colour treatments and building a 
mood for your shots Lightroom provides a 
more extensive suite. As is to be expected 
with entirely separate software developers, 
the same sliders often give different results 
and this is often the case with Capture One 
Pro… I’d lean towards preferring Capture One 
Pro’s black-and-white conversions. 
Experiment a lot and see which suits your 
look and your style.”

3 spot Removal 
ACRs Spot Removal brush is great 
for removing a few blemishes and 

marks, here I’ve quickly removed some of 
them along with a few stray hairs. It isn’t as 
versatile as Photoshop’s Clone and Heal.

1 Plan first 
Take a look over your shot and decide 
where you want to go. Here I want to 

enhance the contrast between the skin tones 
and the blues, and bring out the make-up a 
little, lightening the model’s face and eyes.

2 crop it 
The shadow in the top left corner 
made my decision for me here, but I 

think tighter framing brings more life to the 
shot. Your crop is non-destructive in raw and 
you can always undo it.

5 use the Adjustment 
brush 
This lets you to paint a separate 

conversion over local areas. Here I’ve painted 
a slightly less exposed version in the shadows 
and recesses, and lightened other areas.

6 sharpen 
This in my view should always be 
the final step and if I’m going to be 

working further in Photoshop I’ll apply little 
to no sharpening to raw. A high-amount, 
low-radius sharpening brings out fine details.

4 Adjust tones 
Most of your time developing your 
raw file will probably be spent in the 

right-hand panel creating a look for your 
shot. Go wild with it and experiment and 
don’t forget to dip into the HSL menu.

Professional retoucher Danny Meadows and Photoshop Creative’s Senior 
Staff Writer, Mark White, discuss their approaches to raw editing

Processing a Raw file

BEFoRE AFtER

Left
the original file
this is the unprocessed 
raw file that both Danny 
and Mark were given to 
work with

Right
danny’s result
this is the final look that 
Danny Meadows has 
opted for after working 
with this raw file
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Right
mark’s result

this is the final effect that 
Mark white has produced 
from the original raw file

3 deeper control 
Edit a little further with the next few 
sliders, as you scroll down on the 

right-hand side. Here, add a little tone to the 
portrait by moving the Vibrance down to -26, 
Saturation up to +38 and Blacks to -62.

1 Auto tone 
Start off by opening Lightroom and 
clicking on the Library tab. Select the 

photo you wish to edit and click the Auto 
Tone option. This will set a basic touch-up 
for your photo before you begin tweaking it.

2 make basic tweaks 
Give your picture some rudimentary 
edits, such as Temperature, Tint, 

Exposure and Contrast. By making these 
simple edits to start with, you can determine 
the mood of your picture.

5 Work on the colour 
The HSL setting of Lightroom is one 
of the most creative; turn Reds down 

to -20, Orange to +20, Purple to -100 and 
Magenta to +100 to equalise the colour in the 
picture and bring out the lips.

6 sharpen 
Go to the Detail tab to add a little 
sharpening. We’ve sharpened to the 

max, sliding each of the possible variables all 
the way to the right – should your portrait 
have more blur, you can tweak these.  

4 change the tone 
The Tone Curve is a simple and 
visual way to alter the mood of any 

picture using a histogram. I’ve moved the 
Highlights to +3, Lights to -13, Darks to -30 
and Shadows to -15 to darken the image.

AFtERRAW ExPORtinG

raw converters enable 
you to get as close to the 
full information of your 
captured image as possible 
before you export it into 
a JpeG or tIff and you 
can therefore be more 
precise with your edit and 
sharpen more thoroughly 
in a raw converter than you 
can in most photo editing 
packages. I personally enjoy 
using Lightroom to edit raw 
files before I make further 
edits in photoshop, as the 
Creative Cloud allows me to 
easily share images between 
the two programs.
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R
aw files are the digital equivalent 
of the unprocessed film, with most 
pros shooting and editing raw 
extensively. Raw files are not 

images – they are a collection of 
uncompressed data from the camera’s sensor 
along with information on the shot’s settings 
at the time of shooting. This data needs 
specific software to process it and turn it into 

an image. JPEG files from the camera have 
been processed with the camera’s firmware, 
so while you can tell it to use certain settings 
to process an image, you are essentially 
handing over control to your equipment.

Tapping into the potential of a raw file 
can open up so many possibilities, not only 
in how you process a shot, but how you go 
about shooting. Shooting raw gives you much 

more scope to correct exposure errors in 
post-processing, enabling photographers to 
concentrate on capturing the moment. 

JPEG still has its place – watch any live 
sports and you’ll see pros shooting JPEGs and 
uploading them instantly, only possible due 
to smaller sizes. Each file type is useful in 
different situations, but read on to find out 
how raw can give you total control.

5 essential 
fixes

Pro photographer Chris Humphreys 
guides you through the key ways  
that raw editing can recover  
detail and enhance  
your shots

1
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3 Easily EditEd

the original JPeG image has already had 
in-camera noise reduction and sharpening 
applied, whereas the raw file is unedited and 
can be fine-tuned for noise and sharpening 
much more easily. the higher levels of detail 
retained also help to limit noise and make for 
more effective sharpening.

1 REfinEd ColouRs

Because the raw file contains much more 
colour information than the out-of-camera 
JPeG file, you have more control over colour 
manipulation. the raw file looks far more 
realistic and hasn’t suffered from halo effects 
in the sky or desaturation of the stonework 
like the JPeG file has.

2 ExtREmE dEtail

this shot benefitted greatly from the 16,000+ 
levels of brightness in the 14-bit raw file 
compared to 256 in the 8-bit JPeG image. the 
RaW file retains so much more detail, enabling 
greater manipulation of exposure, shadows 
and highlights without compromising on 
image quality.

EditEd from rAW UnEditEd JPEG

EditEd from JPEG
3

2
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1

3

2
B

oth Adobe Camera Raw and 
Lightroom use basically the 
same controls for making 
adjustments to exposure. 

When we talk about exposure 
adjustments, we don’t just mean the 
overall brightness of the image – we 
also mean setting the points, lifting 
shadows, suppressing highlights and 
adding tone curves.

Although there are no specific rules, 
there are some key moves that can be 
applied to almost every image when 
looking at exposure adjustments. The 
black point and white point define 
the overall range of tones your image 
will have, so it’s a good starting point. 
Using the Black slider, hold down Alt 
and move it slowly to the left, pushing 
this edge of the histogram all the way 
to the far-left. Holding down Alt while 
you do this will turn the image white. 
You will start to see areas of black 
appearing, which represent clipped 
shadows – when you see this, hold 
back a little.

Next, do the same for the White 
slider adjustment, except sliding it to 
the right. This will push the right-
hand edge of the histogram to the 
right. You’ve already locked in the 
black point, so what you’re doing is 
stretching the histogram to cover the 
image’s full range. 

The next step is to look at the 
Exposure slider, which is responsible 
for the middle third of your histogram 

– in other words, the midtones. 
Essentially we are using this slider 
to adjust overall image brightness. 
More often than not, when shooting 
with DSLRs we tend to underexpose 
as it is easier to pull details out of 
shadows than it is to recover them 
from highlights. This means that most 
of the time you will be sliding the 
Exposure adjustment to the right to 
correct overall brightness. 

Two of the most useful 
adjustments in raw editing are the 
Shadow and Highlight controls. 
These enable you to pull detail out 
of shadows without affecting overall 
image brightness. Likewise, they 
enable you to subdue overexposed 

UnEditEd JPEG

EditEd from rAW

Learn how to use raw 
files to pull detail from 
images you thought 
were beyond saving

Adjust 
exposure

highlights to show more detail. Don’t 
assume you always want to max out 
these sliders – it really depends on 
the image.

Your other main exposure 
adjustment controls are your Contrast 
slider and Curves tab. Both will add or 
remove image contrast by spreading 
out the midtones across the histogram 
and deepening shadows – images 
for print or publication will usually 
require a fair dose of contrast to make 
them pop.
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5 reasons why raw comes out on top
Raw v JPEG

Raw files are typically 12- or 14-bit, which means they 
have 4,096 or 16,384 brightness levels respectively. 

this provides room for big edits and corrections.

JPeG files are 8-bit, which gives them only 256 
brightness levels. When making exposure edits, push 
the image harder, so posterisation issues can occur.

BRightnEss

noise reduction algorithms are far more sophisticated 
in raw editing software than in-camera. applying them 

in a raw editor will give you far better results. 

Out-of-camera JPeG files have already had noise 
reduction applied to them, so if you plan on making 
exposure adjustments quality will suffer as a result.

noisE

One of raw’s biggest strengths is the ability to choose 
your white balance after shooting. this is useful when 

shooting in varied or artificial lighting conditions.

JPeG images have white balance applied at the time 
of shooting, either by the auto setting or by user input. 
this makes it more difficult to correct colour casts.

WhitE BalanCE

asraw files are a collection of data, you have ultimate 
control over colour enhancements, while there are 

many more controls and options for adjustment.

JPeG images are processed for colour adjustments 
and are then converted to 8-bit format, so the colour 
information gathered by the sensor is lost forever.

ColouR

Most raw editors use non-destructive editing. as you’re 
only editing a series of data, the file can be reopened at 

any time and the original data is intact.

Because JPeG images are 8-bit and use compression, 
any time you edit or save the file, it causes further 
degradation of quality that can never be retrieved.

Quality
All images © Chris Humphreys

EditEd from JPEG

1 BRing out dEtail

While we have boosted the exposure, we 
couldn’t go too far with this as it would 
affect the highlights. We’ve increased 
the shadow slider to the maximum to 
show detail in the rocks without affecting 
everything else.

2 PREvEnt loss

to counter the increase in exposure causing 
loss of highlight detail, the Highlights slider 
has been moved to bring out maximum 
detail in the highlights around the sun area. 
this also brings out more colour from the 
reflections on the water.

3 BalanCE thE light

Overall exposure has been increased by 
+0.7eV, which has the effect of correcting 
the overall image brightness, but also lifting 
the highlights in the sky and losing detail in 
the horizon that we don’t want.
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a
djustment to image sharpness and 
reducing noise is one of the key 
benefits of shooting raw over JPEG. 
Generally speaking, sharpening is 

the very last adjustment you should be 
making to any image, so you will always be 
looking at reducing noise first and then 
sharpening the noise-reduced image.

Looking at the Detail tab in Adobe Camera 
Raw or Lightroom, you’ll see two sections 
for Sharpening and Noise Reduction. The 
Noise Reduction section is split again into 
two sections, Color and Luminance. The 
Color slider looks for areas of similar colour 
and blends them together. The default is 
set to 25 and generally this does the job. It’s 
the Luminance slider that most people will 
associate with reducing visible noise. Raw 
images as a default have no luminance noise 
reduction added, so you will need to add a 

little. Use the preview as a guide and slide 
the Luminance tab to the right – you will 
now have a completely smooth image with no 
noise whatsoever. However, you have also lost 
a fair bit of detail, so reduce this until you see 
minimal noise seep back into your image.

You can then use the Detail slider to tell 
the software how much detail you want to 
retain. Again, go easy on this as increasing 
the Detail amount will reintroduce noise as 
the software thinks you are telling it that the 
noise is detail that you want to retain – a 
figure of around 50 usually works well. 

As a final action we can add sharpening. 
This can be done in the raw editor and 
exported as is. Alternatively, save the image 
as it is and apply any final sharpening in 
Photoshop using the Unsharp Mask tool. As 
a rule of thumb, keep the Amount set to 
below 100 and the Radius below 1.

find out the right way to apply noise reduction 
techniques and how to sharpen your images

Sharpen and reduce noise

1 ContRol dEtail

the Radius and Detail sliders need to be used very 
sparingly, particularly on noisy images. the Detail 
slider controls how much detail is sharpened and the 
Radius slider dictates how many pixels are used.

2 sEt thE amount

Under the Detail tab in lightroom, the sharpening 
section was used to apply edits based on contrast 
edge detection. the most simple control to 
understand is the amount slider.

3 limit EffECts

the Masking slider is useful for images with high 
depths of field where you don’t want the whole image 
sharpened. High values tell the software to avoid 
similar tones.

1

2

3

UnEditEd 
JPEG

EditEd 
from JPEG

EditEd 
from rAWSharpen
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Bit-dEPth unRavEllEd

the principles of bit-depth are simple. DslRs 
normally capture 12-bit data, with high-end 
DslRs offering up to 14-bits. Why does bit-
depth make RaW files better to edit?

an 8-bit JPeG file contains just 256 levels 
of brightness for each pixel, while a 12-bit 
raw file contains 4,096 levels and a 14-bit file 
has 16,384 levels. When exporting to 8-bit 
JPeG from raw, you’re throwing away all those 
additional brightness levels, hence why it is 
important to carry out editing in the RaW 
editor before exporting.

so what does this mean? With a JPeG 
image you stretch the data beyond the point 
where there is sufficient information to fill 
the histogram. this is in contrast to raw files, 
which have more scope for exposure and 
adjustments as there is plenty of data.

3 BlEnd ColouR noisE

the Colour slider in the noise section 
is used to tell the software which areas 
of noise colour in the image to blend 
together. it is set to 25 as a default, which 
usually works well.

2 go Easy on slidERs

the Detail adjustment slider is used to tell 
the software how much detail you want 
to retain. Retaining detail can also mean 
keeping noise, so go easy on this slider. 
for this image a setting of 50 worked fine.

1 avoid dEtail loss

Using the luminance noise slider, the 
control was pushed far enough to reduce 
the noise in the image significantly 
without losing too much of the detail we 
want to keep.

1

2

3

EditEd 
from rAW

UnEditEd JPEG Reduce noise
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at the base of the Basic tab there are two 
settings useful for global adjustments, 
vibrance and saturation. Play about to see 
what suits your image, but as this scene 
didn’t contain skin tones it was fine to make 
adjustments using the saturation slider.

a
dobe Camera Raw and 
Lightroom have two key 
areas where you can 
enhance your image colours. 

These are the Vibrance and Saturation 
sliders together with the HSL and 
Color tab. As you are working on a raw 
image you have the maximum colour 
information available to play with, so 
don’t be afraid to experiment.

It’s easy to see that increasing the 
Saturation slider will add intensity 
to all the colours in your scene. The 
key difference between Vibrance and 
Saturation is that the Vibrance slider 
is set to deliberately limit its effect 
on skin tones. This means that if 
you’re editing portraits or shots with 
people in and want to increase colour 
saturation without creating unnatural 
skin tones then use the Vibrance slider 

– a little goes a long way.
Probably the most powerful control 

in relation to colour alteration, though, 
is the Hue, Saturation and Luminance 
tab (HSL). This tab enables you to alter 
the HSL values of virtually any colour 
in your image. Let’s say that you have 
a light blue sky in your image and you 

want it a little darker and a bit warmer 
in tone. You can click the Luminance 
tab and reduce the Blue and Aqua 
channels to darken only those colours. 
You can then click the Hue tab and 
likewise adjust the Blue and Aqua 
channels to produce a different shade 
of blue. However, even more useful 
than this is the Targeted Adjustment 
tool, which enables you to select the 
Luminance tab, then click and drag on 
an area of your image and the software 
will automatically adjust the relevant 
sliders to darken the specific colour 
you have selected.

The same works for both Hue 
and Saturation, meaning you can 
selectively adjust areas of colour. 
When looking at the Saturation slider, 
don’t just think about increasing 
saturation – look at areas of colour 
that are oversaturated already and use 
this adjustment to reduce saturation 
of that colour to bring back detail. 

Lightroom has an additional tab 
next to HSL called Color. The Color 
tab works in a similar way to HSL but 
it’s more suited to making broader 
adjustments to colours.

Bring out the vibrant hues and tones in your 
image by taking the file through your raw editor

Enhance colours What ColouR sPaCE?

You can usually set your camera to 
capture images in sRGB or adobe 
RGB, but does it really matter? the 
truth is that if you’re working in raw 
then no, not really, as you will be 
choosing your colour space once you 
export to an image file. When you do 
that, you’re faced with three options: 
sRGB, adobe RGB or ProPhoto RGB, 
each with their own benefits.

in short, sRGB has the smallest 
range of tones available, but is more 
widely used than any other colour 
space in the industry, so it’s a safe 
bet for most applications, including 
web use. adobe RGB and ProPhoto 
RGB are mainly aimed at those 
requiring high-end prints, particularly 
ProPhoto RGB.

ConvERt to mono

By using your raw editor to 
convert to mono, you have 
the advantage of knowing 
that anything you do is non-
destructive, so you won’t 
lose any information.

in lightroom, the Hsl tab 
has another tab right next 
to it called B&W – in adobe 
Camera Raw there is simply 
a box marked Greyscale. 
the really clever trick is 
that the Color Channel 
sliders can then be used 
as tone adjusters to tailor 
your image. it’s as simple 
as playing about with the 
sliders to see what settings 
look best. 

You can also use the 
targeted adjustment tool 
in both adobe Camera Raw 
and lightroom to click on a 
specific tone in the image 
that you want to darken 
or lighten. if you then drag 
them up and down, you will 
see the corresponding Color 
Channels will automatically 
adjust themselves.

1
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2 lift thE tonEs

the Hsl controls can be used in a number 
of ways. Here the sky was a little dark to 
start with, so the deep purple and blue tones 
weren’t showing through well. a positive 
luminance value was applied to the Blue 
channel to lift it.

3 sElECtivEly EmPhasisE

the saturation tab was then used to 
selectively pick out the colours that were 
lacking visual punch. Doing it in this way 
made it easy to avoid oversaturating one 
particular colour, which can happen when 
making global adjustments.

EditEd 
from rAW

UnEditEd 
JPEG

2

3
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a
djusting white balance in raw is 
probably one of the biggest 
advantages that raw has over JPEG. 
Yes, you can tweak colour casts in 

JPEG images, but the JPEG image has already 
had a white balance setting applied at the 
time it was shot, so any further adjustments 
are only going to degrade the image even 

further. Raw files have no white balance 
applied to them at the time they were shot, 
so you can adjust these settings dramatically 
without the worry of a loss of image quality.

In the raw editor you will see that the 
white balance is set to As Shot as a default 
setting. This is the setting stored in the 
metadata with the raw file at the time 

of shooting. If you click on this As Shot 
selection, you’ll see the same presets that 
you have available on your camera. There are 
three ways of adjusting the white balance 
here: by using one of the presets, using the 
White Balance tool to click on a white area of 
the image, or manually adjusting the sliders 
until you’re happy.

take control of your white balance and remove any unwanted 
colour casts from images using three simple techniques

Perfect white balance

1

2
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mimic natural lighting  
It is particularly important to remove colour 
casts from food shots. This shot was taken 

under tungsten lighting and had a strong 
yellow cast at the time of shooting, but 

editing the raw file removed it easily

1 nEutRalisE Casts

One of the most reliable ways to 
remove a colour cast is by using the 
eyedropper neutral Point tool to click 
on a part of the image you know to be 
neutral grey or white. in this case, the 
white plate worked well.

2 WaRm it uP

even though the eyedropper tool makes 
the big changes to set the correct white 
balance, you still need to check overall 
colour temperature. What is technically 
correct isn’t always the most pleasing 
to the eye, so this image was warmed 
slightly using the temperature slider.

3 adjust thE tint

it’s worth checking the tint slider is 
set correctly. look for slight green or 
purple casts, then use the slider to 
adjust it until the cast is removed. You 
can also use the editing brush to warm 
or cool specific areas.

UnEditEd JPEG

EditEd from JPEG

EditEd from rAW

If shooting raw and using a white balance 
card or device such as the SpyderCUBE 
in your frame, it would be best to use the 
Eyedropper tool, which will automatically 
adjust both temperature and tints. However, 
this can make the image look a little cold, so 
remember that while it may be accurate, a 
pleasing image isn’t necessarily one that is 
totally correct – it might be that you want 
the image to be warmer.

There are occasions where the presets or 
Eyedropper tool won’t give you the results 
that you want, so you’ll need to adjust the 
image manually. This can seem daunting 
at first, but there is a handy tip to help 

you identify any strong colour casts in 
the scene. Remember, when we’re talking 
about colour casts, we are thinking about 
cold or warm (blue or yellow) together 
with tint (green or purple). Simply slide 
the Vibrance and Saturation sliders to 
the far-right and the colours in the image 
will become saturated and quite garish. It 
should emphasise any colour cast in your 
scene to enable you to make the necessary 
temperature or tint adjustments. Once you’ve 
balanced the colour cast, you can return your 
Vibrance and Saturation sliders to 0. This 
works particularly well with architectural 
photography, but can be applied to any genre.
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Organise 
with Bridge
Get started in raw processing fast by learning the 
best ways to import and organise your images

30 Introducing the 
Bridge workspace
Get to know the key areas of Bridge’s 

photo-organising workspace and discover how to 
customise it to suit your needs

32 Import your photos 
into Bridge
Import images from your camera 

into Bridge, and organise and convert them in 
preparation for editing in Photoshop

34 Add metadata and 
keywords to your images
Discover how to protect your photos 

and make them easier to find in the future using 
embedded image metadata

38 Organise your 
images in Bridge
Use Bridge’s asset management tools

to help you find particular pictures quickly and
easily using Collections

page://20
page://22
page://24
page://28
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Introducing the 
Bridge workspace
Get to know the key areas of Bridge’s photo-organising workspace 
and discover how to customise it to suit your needs

Get to know the key features of Adobe Bridge

Photoshop Anatomy The Bridge workspace

1 FOLDERS

Click the Folders tab to browse to 
any folder of images stored on your 
PC. drag your most commonly used 
folders into the Favorites panel.

3 WORKSPACES

these links enable you to change the 
way panels and images are displayed 
in bridge. For example, the Filmstrip 
option gives you larger previews.

2 THUMBNAILS

bridge displays your images as 
thumbnails. You can use the slider 
at the bottom of the workspace to 
increase the thumbnail size.

4 METADATA

this panel emulates the display on your 
digital sLr. it reads the metadata stored 
in the currently active thumbnail so that 
you can discover what shutter speed, 
iso and aperture settings where used 
to capture the image. it also shows the 
metering modes.

 
5 FILTERS

this panel enables you to present files 
that meet specific criteria, such as 
those with a specific star rating. You 
can also filter the files’ metadata and 
discover images that were captured 
with a particular shutter speed setting, 
for example.

6 KEYWORDS

this panel enables you to quickly assign 
descriptive keywords to a photo. You 
can then use the Filter panel to display 
photos that contain a specific keyword. 
we’ll demonstrate how to add and 
search for keywords later in this chapter.

O
ne of the biggest problems we face 
as digital photographers is our 
ever-growing collections of images. 
We may have thousands of photos 

scattered across hundreds of folders on our 
computers. These folders tend to display 
images according to when they were captured, 
so we have to rely on our memory of what was 
shot when as we search for a particular photo.

All versions of Photoshop attempt to deal 
with this asset management problem 
using similar tools. The Photoshop Elements 
Organizer allows you to add star ratings and 
keywords. Lightroom’s Library module does 
a similar job. Photoshop CC and CS use a 
companion application called Bridge. If you 
access the full version of Photoshop as a 
download via the Creative Cloud service, 

you’ll need to download the Bridge 
application separately.

Bridge is a powerful image browser that 
enables you to take control over your digital 
assets before exporting them to Photoshop 
for editing. On this spread we’ll introduce you 
to the key features of Bridge, and demonstrate 
how to customise the workspace to display 
images in a more useful way.  

5 4

6
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Take a closer look at your pictures using the Filmstrip view

Overview Customising Adobe Bridge

1 FILMSTRIP

by clicking the Filmstrip workspace icon you display the 
selected thumbnail at a much larger size in the Preview window. 
shift-click to select and compare multiple images, as we’re 
doing in this image.
 

2 LOUPE VIEW

the easiest way to see if an image is in focus is by looking at it 
at 100% magnification. to do so, click the image to activate the 
Loupe view. drag the loupe to examine the image. we can see 
that the image on the right is blurred.
 

3 STACKING

to stop similar-looking images from cluttering up the 
workspace, shift-click to select them and then choose 
stacks>group as stack. Click the play icon to see each 
thumbnail contained in a stack (or drag the scroll bar).

4 EDITED IMAGES

if the colours, sharpness or tones of a raw format photo have 
already been adjusted in Photoshop, you’ll see this icon. You 
may also spot more specific icons that indicate that an image 
has been cropped, for example.
 

5 THUMBNAIL QUALITY

by default you browse a raw file’s content by displaying the 
low-resolution thumbnail that was embedded with the file 
when it was captured. For a more accurate preview of colours 
and tones, click here and choose high Quality display. this will 
demand more processing power, however.

6 SORT BY

to see your files in chronological order (with the oldest ones 
appearing on the left of the Filmstrip), set this sort by drop-
down menu to date Created. You can also use this option in the 
essential workspace to display the oldest files at the top.

1

5 6
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1 Attach your camera
On the previous pages we pointed out how to use Bridge to browse 
images that are already stored on your computer, courtesy of the 

Folders panel. This panel acts like any browser or finder window. You 
can also use Bridge to import and store images directly from an attached 
camera or memory card into folders on your PC. Kick off by attaching 
your camera via a USB cable, and then click the Import Photos from 
Camera icon in Bridge.

2 Launch Photo Downloader
A dialog will appear, inviting you to make the Photo 
Downloader launch automatically whenever a camera or card 

reader is attached. Click Yes or No as desired. You can always change 
this option later by choosing Adobe Bridge>Preferences>General and 
then tick or clear When Camera is Connected, Launch Adobe Photo 
Downloader. Whether you click Yes or No, the Photo Downloader 
window will appear.

Import your  
photos into Bridge
Import images from your camera into Bridge, then organise 
and convert them in preparation for editing in Photoshop

B
ridge is a plugin that comes 
included with all versions of 
Photoshop. If you’re not using 
Lightroom to import, organise and 

catalogue your images, then Bridge is the 
perfect tool that fully integrates with 
Photoshop. Under the File drop-down 
menu on the main menu you can 
either open Bridge as a 
standalone window or use 
the Mini Bridge option as a 

panel within your Photoshop workspace. 
Whichever option you choose you can easily 
browse to your images and incorporate them 
into your workflow.

However, Bridge is so much more than a 
browser, you can also use it to add metadata, 

create catalogues, image stacks, apply star 
ratings and more. It also offers a host 

of other useful features too, such 
as the option to select multiple 

images and merge them.

Convert to DnG

if you choose the Convert to dng option, the 
Photo downloader will convert third-party raw 
format files (such as Canon’s Cr2 or nikon’s 
neF) into the adobe digital negative format as 
it imports them. it will preserve the original raw 
format files and create a dng copy in a 
separate folder. we recommend you keep the 
original raw files somewhere very safe.
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3 Choose a location and label
Click the Advanced Dialog button. Clear any thumbnails that 
you don’t want to import. In the Save Options section, click 

Choose and browse to where you want to store the files, or leave it set 
to the default Pictures folder. Set the Create Subfolders drop-down 
menu to choose your preferred folder labelling format, such as Shot 
Date (ddmmyy). You can also rename the source files to include the 
Shot Date. They will then be numbered sequentially.

5 Advanced options
By default Adobe Bridge is set to open once you’ve imported 
the files. You can set the Photo Downloader to delete the 

original files on the memory card after they’ve been imported, 
so you can capture new images with the card without having to 
reformat it. You can also save copies of the imported files onto an 
external drive to create a backup of your photos. Click Choose to 
select your backup location.

4 Convert to DnG
In the Advanced Options panel you can decide to convert 
raw files to the DNG format as they are imported. This 

can be useful if you’re planning to share your raw files with other 
Photoshop users. Different camera manufacturers use different 
formats to create a raw version of an image and some of these 
can’t be opened in older versions of Photoshop. Adobe’s DNG 
format is also more compatible with third-party applications.

6 Apply metadata
If you plan to share your images electronically, it makes 
sense to attach your details and the copyright status, 

such as Creative Commons or Royalty Free, to each photo as it’s 
imported. This will save you the hassle of adding this information 
to individual files at a later date. We’ll look at ways to add more 
information to metadata on the following pages. Click Get Media 
to import the selected files.  
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A
t the end of the workflow on the previous spread we 
demonstrated how to quickly add your name and the 
copyright status to each file as it was imported to your 
computer by the Photo Downloader. This useful 

information is stored inside each file’s metadata, so when the image is 
shared online or emailed to a client they will know who it belongs to.

The Photo Downloader only enables you to add a limited amount 
of information to a batch of images, but once you’re browsing your 
imported images in Bridge you can add much more useful data to 
them, such as your contact details and website address. This helps 
people contact you if they need to use the image, or at least credit you 
as its creator. In this walkthrough we’ll demonstrate how to edit fields 
in the IPTC Core panel to assign your contact and copyright details to 
a file’s metadata.

You can add other useful details to metadata in Bridge, such as 
keywords that describe the contents of an image. This enables you to 
find a file according to its subject, instead of having to scroll through 
a chronological list of images trying to remember when you shot a 
particular picture. Keywords remain embedded in a file’s metadata, 
so they can be used by others to locate an image, which is handy if 
you want to sell your work as stock photography, for example. We’ll 
demonstrate quick ways to add keywords and then search for them 
using the filter tools in Bridge.

Add metadata 
and keywords 
to your images
Discover how to protect your photos and 
make them easier to find in the future using 
embedded image metadata



Teach yourself Raw in Photoshop
organise with bridge

35



Teach yourself Raw in Photoshop
organise with bridge

36

1Examine the metadata
When importing images into Lightroom you can type your 
name into the Photo Downloader’s Creator field. If you’ve 

chosen this option, you can check that your name is attached to 
the file. Click the thumbnail of an image and then toggle open 
the IPTC Core section of the Metadata panel. Next to the Creator 
label you’ll see your name. If you didn’t add your name while 
importing, you can still do so by typing in the adjacent text field.

3Apply the changes
If your image contains a person or a place, then you can add 
the appropriate details in Bridge’s IPTC Extension panel. This 

panel also enables you to inform viewers of the image if there’s 
a model or property release form available, which is useful for 
purchasers of stock photography. Once you’ve finished editing the 
metadata, click anywhere outside the Metadata panel. You’ll then be 
asked if you want to apply the changes. Click Apply.

2Assign your copyright
You can also add your contact and website details to the 
file’s metadata by typing in the appropriate fields. Scroll 

down in the IPTC Core panel to find the Copyright Status pop-
up menu. Choose an option such as Copyrighted. When the 
photograph is opened in Photoshop the image tab will display a © 
symbol, indicating that the image is copyrighted. Viewers of the 
image can go to File>Info and read the info that you’ve added.

4Create a metadata template
To speed up your workflow you can use Bridge to create a 
metadata template that contains useful generic information, 

such as your contact and copyright details. To do so, go to 
Tools>Create Metadata Template. Give the template a name, such 
as ‘My contact details’. Type in the information. Any properties 
you add will automatically be checked. Click Save. You can create 
as many custom metadata templates as you like.
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5Batch process the metadata
Once you’ve created a custom metadata template you can 
apply it to multiple images. Shift-click to select a range of 

thumbnails in Bridge. Go to Tools and choose Append Metadata. 
You can then choose your custom metadata template. Your contact 
details will then be added to all the selected files in an instant. 
Click a thumbnail and check the Metadata panel’s IPTC Core 
section to see the added information.

7Create new keywords
To assign existing keywords to a selected image, tick the 
box next to a keyword category, such as People, or a 

subcategory, such as a person’s name. If a keyword isn’t available, 
click the fly-out icon at the top right of the Keywords panel and 
choose New Keyword. Type the keyword into the text field. Hit 
Enter. Drag the new keyword into a particular category. Tick the 
new keyword to assign it to the selected thumbnails.

6Add keywords
The IPTC Core panel also has a keyword field, so you can 
add a series of descriptive keywords to a particular file, 

such as macro, butterfly, leaf etc. You could also add common 
keywords, such as your name, to a metadata template. To help 
you add keywords quickly, Bridge has a Keywords panel adjacent 
to the Metadata tab. Here you’ll find a collection of useful preset 
keywords, plus any that you’ve manually added to any images.

8Filter via keywords
To find images that contain a particular keyword, go to 
the Filter panel on the left of the Essentials workspace, 

then simply click a keyword in the list to display the appropriate 
thumbnails in the Preview window. You’ll see a number next to 
each keyword that indicates the number of files that contain that 
particular keyword in their metadata. You can also type keywords 
into the Search field at the top right of Bridge’s workspace.  
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A
s we revealed on the previous pages, Bridge 
enables you to create and assign keywords to 
single images or batches of images so that you 
can find them with ease using filters. Keywords 

provide one of the most powerful and useful ways of 
helping you to locate specific photographs, although 
Bridge has other tools that will help you to organise 
your ever-growing library of images.

In pre-digital days we’d place our favourite prints into 
photo albums. These tended to gather and present images 
using particular themes, such as weddings or holidays, for 
example. In these digital days we have many more images 

to manage, so we can end up scrolling through hundreds 
of thumbnails in search of a particular image. In this 
walkthrough we’ll demonstrate how to use the old photo 
album model to collect themed images together so that they 
are easier to access, courtesy of Bridge’s Collections panel. 
You’ll also learn how to use the powerful Smart Collections 
feature to find photos according to specific metadata 
information, such as the shutter speed or camera model used 
to capture the images.

We’ll kick off by demonstrating how to quickly separate 
the wheat from the chaff by assigning labels and star ratings 
to particular pictures.

Organise your 
images in Bridge
Use Bridge’s asset management tools to help you find 
particular pictures quickly and easily using Collections
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2 Label your images
You can also assign ratings by clicking the Label menu 
at the top of the workspace. There are also colour-

coded labels that indicate the status of a file. If a picture is 
ready for print, you could apply a green Approved label. 
Images that require editing might have a purple To Do label.

1 Assign ratings
Click the Filmstrip workspace so that you can get a good 
look at each image when you click its thumbnail. If you 

like an image, you can click the star icons below a thumbnail 
to assign up to five stars. You can also assign star ratings by 
pressing Cmd/Ctrl+ a number between 1 and 5.

4 Create a Collection
To create an album-style Collection, click the 
Collections panel. Click the New Collection icon at 

the bottom. Label the Collection with an appropriate name, 
such as Landscape collection. Drag thumbnails from the 
Filmstrip into the Landscape collection’s folder.

3 Filter your photos
Once you’ve assigned ratings and labels, you can 
search using them. Go to the Filter panel and click a 

coloured label to see all the files with that label. Narrow down 
your search by clicking other criteria such as a particular 
rating. You can also use the Filter items by rating option.

6Export to Photoshop
Once you’ve finished organising files in Bridge, you can 
double click to take a specific file into Photoshop. You 

can also go to Tools>Photoshop and use shortcuts that will 
jump-start a variety of Photoshop edits, such as placing two 
images into separate layers in the same document.  

5Create a Smart Collection
Click the New Smart Collection icon. Choose a Source 
for Bridge to look in. In Criteria, choose an attribute, 

such as Rating equals five stars. Click the + icon to add other 
criteria if necessary. Click Save. The Smart Collection will 
automatically gather appropriate images together.
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The Camera 
Raw editor
Familiarise yourself with the controls in Photoshop’s 
professional-level image-processing digital darkroom

42 Raw versus JPEG: which 
is the better format?
Discover the advantages of shooting 

and editing photos using your camera’s raw format, 
compared with the JPEG format

44 Introducing the 
Camera Raw panels
Learn how to fix common photo 

problems using the tools in the powerful image-
processing panels in Camera Raw

46 Introducing the 
Camera Raw toolbar
Familiarise yourself with the wide 

range of picture-processing tools placed in the 
Camera Raw toolbar

48 Master preferences and 
workflow settings
Set up Camera Raw with your 

preferred colour space, bit depth and more to suit 
your image-processing requirements

50 A typical Camera 
Raw workflow
Discover how to open a raw file, fix its 

colour and tone problems, sharpen it for print, and 
then save the changes
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Raw versus JPEG: 
what’s the difference?
Discover the advantages of shooting and editing photos using 
your camera’s raw format, compared with the JPEG format

W
hen your camera captures an 
image, it saves it as a raw file or a 
JPEG. JPEG format images are 
compressed, so these files present 

a shorthand description of the colours and 
tones in the scene. If you shoot images using 
your camera’s raw format, then the photos 
will be uncompressed, meaning much more 
information about the colours and tones in 
the images are captured.

Shooting in the JPEG format is comparable 
to snapping your subject with a Polaroid 

camera. Once the image has been developed 
in-camera, you’re stuck with the finished 
print. Shooting in raw format is like using 
print or slide film. You can take your negative 
into the darkroom and recover missing tonal 
detail more easily. Indeed, Adobe’s raw DNG 
format reflects the nature of a raw file by 
calling it a digital negative.

Like traditional negatives, your DNG 
files need to be worked on before they look 
their best. This is why we refer to the Camera 
Raw workspace as the digital darkroom. When 

you capture a photo as a JPEG, the camera 
applies processing settings to the image, and 
you risk adding unwanted artefacts such as 
noise and blocky pixelated areas when you 
later try to improve on the image. 

By shooting in raw, you have more freedom 
to make changes while still preserving the 
quality of the image. For example, you can 
change the colour balance of a raw photo 
with a click, as if you were back on location 
experimenting with your camera’s white 
balance presets.  n

See p194 to  
find out more

Free  
assets!  
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Get better-looking pictures by shooting and editing in raw

Photoshop Anatomy Head to head

different camera 
manufacturers use 
different processing 
techniques to 
produce raw 
files, and the files 
created by the latest 
cameras may not 
be compatible with 
older versions of 
Photoshop. adobe 
introduced the dng 
(digital negative) 
raw format [1] to 
make it possible 
for photographers 
to open raw files 
using older versions 

of Photoshop. 
canon cameras 
save raw files with 
a cr2 suffix [2] 
(which stands for 
canon raw 2). 
nikon cameras 
save raw files 
with a neF suffix 
(nikon electronic 
Format) [3]. Some 
of the latest nikon 
cameras produce 
nrw (nikon raw) 
files [4]. You 
can open any of 
these formats in 
Photoshop cc.

Belt and Braces

Like a traditional print or film 
negative, a raw file will need to be 
processed in Photoshop before 
it’s ready to be shared. this will 
take time. You can set your 
camera to create a raw and JPeg 
version of a photo at the same 
time. the JPeg will feature the 
results of the camera’s current 
scene mode. For example, the 
camera’s Landscape scene 
mode will boost the saturation 
of natural colours such as blues 
and greens. You can instantly 
upload the processed JPeg to an 
online gallery or mail it to a client. 
If you need to make changes to 
the photo, then you have a high-
quality raw file to work on at your 
leisure. You can also use the raw 
file to experiment with different 
looks and effects.

5 WHIte Balance

the whites in our processed JPeg look a little cold. 
the white Balance presets and temperature slider in 
camera raw enable you to quickly get whites looking 
white, creating tint-free colours in the rest of the image.

6 clarItY

the clarity slider in camera raw enables you to tease 
out more fine midtone detail, such as the textures in 
the water in this photo. It also adds contrast, creating 
a much punchier image.

1 tOnal ranGe

when shooting a high-contrast scene, your camera 
will struggle to capture detail in the shadows and 
highlights at the same time. with a raw file you have a 
much better opportunity of restoring missing highlight 
or shadow details.

2 draB cOlOUr 

after brightening a JPeg’s under-exposed areas, you’ll 
notice that they lack colour information, even after 
boosting the Vibrance. a raw file will have more hidden 
colours for you to reveal in camera raw.

3 arteFacts

In a JPeg version of a scene, compression artefacts 
can appear as jagged blocks or noticeable bands. In 
the raw version, the same area will be displayed as a 
smoother gradient.

4 nOIse

If there’s an exposure problem with a JPeg, you’ll 
struggle to restore tonal detail without adding artefacts 
such as noise. the processed raw version of a scene 
will feature less noise.

Understanding…
RAW FORMATS 

2
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Introducing the 
Camera Raw panels
Learn how to fix common photo problems using the tools 
in the powerful image-processing panels in Camera Raw

Fix common photo problems using the tools in this key panel

Photoshop Anatomy The Basic panel

1 TABS

click the icon on a tab to access its 
raw-editing tools. the Basic panel is 
selected by default because it features 
the most commonly required tools.

3 AUTO

click here and camera raw will adjust 
the sliders automatically in an attempt 
to create a healthy spread of tones 
and tint-free colours.

2 WHITE BALANCE

this basic drop-down menu enables you to 
access white-balance presets that will help 
you to produce natural-looking colours in 
various lighting conditions.

4 EXPOSURE

this slider enables you to 
make global changes to the 
photograph’s exposure in 
a similar way to opening or 
closing the camera’s aperture 
on location. the value in the 
box equates to your camera’s 
exposure compensation setting.

5 HIgHLIgHTS 
ANd SHAdOWS

these Basic panel highlights 
and Shadows sliders enable you 
to target and fix specific tones, 
such as over-exposed highlights, 
without altering other parts of 
the photo.

6 CLARITy, 
VIBRANCE ANd 
SATURATION

this separate panel section 
is designed to help you boost 
colour saturation. Vibrance 
is designed to boost weaker 
colours without over-saturating 
stronger ones, which helps you 
to keep the colours within a 
printable range.

I
f you open a raw file in Bridge or 
by using File>Open in Photoshop, 
Photoshop will recognise the file’s 
raw format and automatically bring 

it into Camera Raw. This is your digital 
darkroom, with a collection of tools designed 
to help you process your photos.

In Camera Raw, you can claw back missing 
tonal detail caused by incorrect camera 

settings, thanks to the extra information 
packed into an uncompressed raw file. You 
can easily correct problems with colour, 
too. Inappropriate or ineffective camera 
white-balance settings can produce washes 
of cold blue or warm orange. You can use 
the white balance presets in the Basic panel 
to experiment with different white balance 
settings and produce natural tint-free colours 

with just a few clicks. Unlike a JPEG format 
file, your raw format file is free from the 
processing applied by the camera’s chosen 
scene mode, so you can experiment with 
different looks much more easily.

We’ll kick off by looking at the most 
commonly used image-processing tools in 
Camera Raw’s Basic panel, and then move on 
to introduce the other tabbed panels.  

5
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Discover other tabs that can help you to improve or creatively process your images

Overview Other key editing panels

1 TONE CURVE

this tab gives you access to even more powerful tone-tweaking 
tools that enable you to make selective tonal adjustments by 
dragging sliders or manipulating points on a curve. It also has a 
collection of Point curve presets.

2 dETAIL

this useful tab enables you to sharpen up a soft-looking 
photo to tease out more fine detail. this is an effective way of 
producing a print with more punch. You can also reduce the 
presence of colour and luminance noise in shots captured using 
a high ISo setting.

3 HSL/gRAySCALE

this tab enables you to target and tweak the hue, saturation 
and luminance of specific colours. It also enables you to create 
a more effective monochrome conversion by using colour 
sliders to lighten or darken particular parts of the image based 
on their original colour information.

4 SPLIT-TONINg

after desaturating a photo using the hSL/grayscale tab, you 
can add washes of colour to the shadows and highlights to 
change the mood of the monochrome conversion.

5 LENS CORRECTION

this panel enables you to use lens profiles to correct lens-
related distortions. It also features sliders to help you 
counteract distortions manually, and remove artefacts 
such as chromatic aberration.

6 EFFECTS

this panel enables you to mimic film effects by adding natural-
looking grain. You can also add or counteract vignetted corners, 
and these darkening or lightening corrections will still be 
applied evenly to the corners even after you crop the image.

1
5

6
3 4
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Introducing the 
Camera Raw toolbar
Familiarise yourself with the wide range of picture-processing 
tools with the icons placed on the Camera Raw toolbar

I
n a traditional print darkroom, a 
photographer would have access 
to a collection of tools that 
enabled him to tweak the colours 

and tones of a negative to produce a well-
exposed print. For example, by placing bits of 
card between the enlarger and the photo 
paper, a photographer could vary the amount 
of light hitting the paper and create selective 
exposures that revealed detail in lighter or 
darker parts of a scene.

Camera Raw has a toolbar that’s packed full 
of tools that do similar jobs to those tools 
offered by the traditional darkroom. The 
advantage of working with Camera Raw tools 
is the fact that the adjustments that you make 
are non-destructive. If a traditional darkroom 
photographer makes a mistake, he has to 
throw away the exposed photo paper and 
start from scratch. A Camera Raw user can 
experiment with more freedom, such as 
trying out different compositions using the 

Crop tool and then reverting the image to 
the original composition (even if he closes 
and then re-opens the processed raw file). 
A raw file’s original information can’t be 
destroyed or altered by any of the Camera 
Raw tools and panels. Camera Raw simply 
records the changes that you make using its 
tools, and then applies them to the raw file 
when you re-open it. Here we’ll introduce 
you to the key image-processing tools in 
Camera Raw.  
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Get to know the key digital darkroom tools Camera Raw offers

Photoshop Anatomy The toolbar

If you rotate the 
camera to shoot in 
portrait or landscape 
orientation, the 
image will need to 
be displayed the 
right way up. most 
digital cameras will 
store the orientation 
of the camera in 
the metadata of a 
photo so that it will 
automatically be 
displayed correctly in 
camera raw. however, 
you can also click to 

rotate the photo in 
a clockwise [1] or 
counter-clockwise [2] 
direction. the color 
Sampler [3] enables 
you to discover the 
rgB values used to 
create the colour of an 
area. If the resulting 
rgB values are equal, 
the sampled colour is 
a shade of grey. the 
radial Filter [4] is like 
the graduated Filter, 
but it creates a 
circular gradient.

XMP

when you process a raw format 
image such as a canon cr2 file or 
a nikon neF file in camera raw, 
Photoshop creates a sidecar XmP 
file that stores all the camera 
raw tool and slider settings used 
to adjust the image. when you 
re-open the image at a later date, 
this XmP file ensures that the 
settings are as you left them. You 
can then continue fine-tuning the 
raw file at your leisure. If you share 
the raw file, but forget to include 
the XmP file, then the settings 
won’t be applied. however, if you 
save your edited raw file using 
adobe’s cross-platform dng 
(digital negative) file format then 
the changes made by the tools and 
panel sliders will be stored within 
the dng.

5 ADJUSTMENT BRUSH

this tool enables you to make selective brush-
based adjustments, such as lightening (dodging) 
or darkening (burning). unlike traditional darkroom 
dodge-and-burn tools, you can modify the results 
produced by these digital versions.

6 GRADUATED FILTER

this tool acts like a graduated neutral density filter on 
a camera’s lens, enabling you to darken bright skies 
without blowing out a correctly exposed landscape. 
alternatively, you could use it to brighten an under-
exposed landscape without over-exposing the sky.

1 WHITE BALANCE

this tool enables you to fix a white-balance problem 
by sampling something that should be white. If the 
sampled pixels are too warm, the tool will cool down 
the colours to make whites look white. this will remove 
colour casts from the rest of the photograph.

2 TARGETED ADJUSTMENT

this powerful tool enables you to adjust the tones of a 
particular area of the image. click the image and drag 
upwards to lighten the tones, or downwards to darken 
them. You can set the tool to selectively adjust colour 
saturation too.

3 CROP TOOL

this enables you to improve composition by 
removing some of the edges of the frame. the tool 
is non-destructive, so you can restore missing edge 
details at any time. hold down the mouse button 
on the crop tool icon to modify the way it behaves. 
the neighbouring Straighten tool enables you to 
counteract tilted horizons.

4 SPOT REMOVAL

this tool enables you to hide unwanted image 
elements such as sensor spots in skies or spots on 
the subject’s face in a portrait. It’s the camera raw 
version of the main editor’s clone Stamp and 
healing Brush tools.

Understanding…
OTHER RAW 
TOOLS
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Master workflow 
and preferences
Set up Camera Raw with your preferred colour space, bit 
depth and more to suit your image-processing requirements

Set up workflow presets to meet various image-editing challenges

Photoshop Anatomy Workflow options

1 WORKFLOW

click here to open the workflow 
options window. the edited workflow 
settings will replace the camera raw 
default values.

3 COLOR SPACE

click here to choose a colour space. If 
you’re editing for print, choose adobe 
rgB (1998). If you’re editing your 
work for digital display, chose srgB.

2 PRESET

click here and choose new workflow 
Preset. a new workflow Preset window 
will appear. type in a suitable workflow 
name such as Print or web. click oK.

4 DEPTH

to access more information in your 
raw files, consider increasing the Bit 
depth to 16/Bits Per channel, although 
this will reduce the number of menu 
commands you can apply in the main 
Photoshop editor.

5 RESIZE

If you’re editing a series of photos that 
are destined for print, set camera raw 
to automatically resize them to typical 
print-friendly dimensions. You can also 
choose a high resolution to pack the 
print with detail.

6 SHARPEN

a little sharpening will give printed 
pictures more impact. choose a suitable 
paper type and sharpening amount 
from the drop-down menu in this 
section of the workflow options window.

7 SMART OBJECTS

once you open a raw file in Photoshop, 
it behaves like an ordinary JPeg. By 
ticking this box, you can edit the photo 
in Photoshop and then re-open it in 
camera raw to fine-tune. to override 
this preference for specific images, 
press Shift when you click open Image.

B
efore processing your photos in 
Camera Raw, it’s worth taking a 
little time to set up the preferences 
and tailor its workflow options to 

suit your specific image-editing needs. This 
enables you to speed up the way you work, 
and produce more effective results.

For example, if you plan to print your 
pictures, you’ll benefit from setting up a 

Camera Raw colour space that produces 
printer-friendly colours. Your PC displays 
millions of colours by mixing the red, green 
and blue channels together. Printers, on 
the other hand, create a narrower range of 
colours by mixing cyan, magenta, yellow and 
black. Set up Camera Raw to use a printer-
compatible colour space, such as Adobe RGB 
(1998), and the prints of your carefully edited 

images will look more similar to the on-
screen versions.

You can also modify the Camera Raw 
preferences to speed up your workflow. This 
enables you to adjust the default settings so 
that Camera Raw will automatically apply 
tonal adjustments when you open an image, 
for example. We’ll kick off by setting up 
print-friendly and web-based workflows.  
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Customise the way Camera Raw behaves to suit your way of working

Overview Choose your preferences

1 PREFERENCES

to access the camera raw Preferences window, click here in 
the toolbar. alternatively, you can summon the camera raw 
Preferences window while working in Photoshop by going to 
Preferences>camera raw.

2 SIDECAR

any camera raw slider or tool-related changes you make are 
recorded in an XmP file that’s stored in the same folder as the 
raw file. If you move the raw file, you need to move the XmP file 
too, to preserve the changes to the image.

3 DATABASE

You can store a record of any adjustments made to a raw file in 
a database on your mac or Pc. this database is indexed by file 
content, so the image will retain camera raw adjustments even 
if the raw file is moved or renamed.

4 AUTO TONE

tick this box to have camera raw analyse the exposure of 
the image and automatically adjust the sliders in the Basic 
panel to try to create a healthier spread of shadows, midtones 
and highlights.

5 DEFAULTS

You can customise the noise reduction settings to apply 
different amounts of default smoothing to photos captured with 
fast or slow ISo speeds.

6 CACHE

the cache stores information about changes made in camera 
raw, which helps speed up the opening of images in camera 
raw. It also rebuilds previews in Bridge when an image is 
adjusted in camera raw.

1

5

6

3

4
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1 Open the image
If you’re using Bridge, right click your starting image and choose 
Open in Camera raw from the context-sensitive pop-up menu. 

Alternatively, if you’re in Photoshop choose File>Open. Browse to your 
starting image and click Open. The file is in DNG (digital negative) 
format, so it will automatically open in Camera Raw. The shot looks 
under-exposed, the contrast is flat, the colours are drab and the water 
looks warm and muddy.

2 Boost the exposure
To understand the exposure problem more clearly, take a look 
at the Histogram panel. In this instance, the graph is clumped 

towards the shadows on the left, with no strong highlight information 
on the right. This is a typical histogram shape for an under-exposed 
photo. By dragging the Exposure slider right, the graph’s under-
exposed tones slide towards the highlights, creating brighter highlights 
in the image. A value of +1.5 does the trick in this instance.

The Camera  
Raw workflow
Discover how to open a raw file, fix its colour and tone problems, 
sharpen it for print, and then save the changes you’ve made

A
ll the information about the 
colours and tones in a scene are 
contained in the raw file, but you’ll 
need to do some work to display 

tones that are missing in darker or brighter 
areas. You may also find that colours suffer 
from a warm or cool tint due to incorrect 
white-balance settings used by the camera at 
the time of capture.

In this tutorial we’ll show you a typical 
photo-fixing workflow that will demonstrate 

the ways you can use to analyse a raw file for 
typical exposure and colour problems, and 
then correct them using the sliders in the 
Basic panel. Once your processed photo looks 
more like the scene did on 
location, you can build 
on this basic workflow 
by applying more 
complex tools and 
effects to  
the image.  

SAving OptiOnS

once you’ve improved your photo, you have 
a variety of choices. click done to record the 
slider changes and store them with the raw file, 

so you can fine-tune them at a later date. to 
continue editing the image in Photoshop, 

choose open Image. to save a JPeg 
version to share online, click Save Image. 
Set the Format drop-down menu to 
JPeg and click Save.
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3 Lighten the shadows
Our photo now has a wider spread of tones, but the shadows 
lack detail. You can selectively target tones like these by 

dragging the Shadows slider right to +81. If a photo’s highlights were 
too bright, then you’d drag the Highlights slider left to claw back 
missing detail. Camera Raw enables you to make effective selective 
tonal adjustments and create a stronger contrast. Drag Contrast to +17 
for slightly blacker shadows and whiter highlights.

5 increase Clarity
When you reveal tones in under-exposed scenes, the 
colours can look drab. Pop down to the last section in the 

Basic panel and drag Vibrance right to +46. This boosts blues and 
greens in nature shots (while avoiding over-saturating warmer skin 
tones in portraits). In the same section you’ll find the Clarity slider. 
Use this to boost midtone contrast and tease out fine details and 
textures. A value of +28 will do the trick in this example.

4 improve the colour
If the colours look too warm or cold you can experiment 
with different white-balance presets to produce 

whiter whites. This will create more natural-looking tint-free 
colours in the rest of the image. For this image, manually drag 
Temperature left to 4600K to cool down the warm colour and 
create neutral, less muddy-looking whites. Press Q to cycle the 
Before and After views.

6 Sharpen the image
Camera Raw applies a little post-production sharpening to 
your image. If you plan to print your photo, you can give 

the hard copy extra impact by sharpening it a little more. Select the 
Zoom tool and right click to see the image at 100%. This enables 
you to see how sharp it is. Go to the Detail tab and increase the 
Amount slider in the Sharpening section to around 44. You’re now 
ready to save your processed picture.  
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Camera Raw 
basic editing
Learn how to open and process multiple raw files 
and perform basic image-editing transformations

54 Introducing the Magnifier 
and Grab tools
Work more effectively on particular

parts of a raw file with help from the Camera Raw 
image navigation tools

56 Use the Histogram 
to assess exposure
Discover how to use the Histogram 

window to analyse the spread of tones in a raw 
image, and then fix any exposure problems

58 Batch process 
your raw files
Save time and effort by opening

and processing multiple photos taken at the same 
time in the same lighting

60 Improve colour 
and tone locally
Target and tweak the hue, saturation 

and brightness of specific regions of a photo using 
the Targeted Adjustment tool

64 Resize and save your 
processed raw files
Discover how to save your edited 

photos in different image formats at different sizes 
to suit your file-sharing needs
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The Magnifier 
& Grab tools
Work more effectively on particular parts of a raw file 
with help from the Camera Raw image-navigation tools

T
o successfully improve your raw 
files, you’ll need to get to grips 
with the Camera Raw navigation 
tools. For example, if you look at a 

raw file on your camera’s LCD display, it may 
look nice and sharp. However, the file may be 
actually soft due to the camera’s inability to 
find a focal point, or because of a shallow 
depth of field caused by a wide aperture 
setting. You can only discover how soft or 
sharp a photo really is by opening it in 

Camera Raw and then magnifying the image 
to see its actual pixels.

As with the Photoshop workspace, Camera 
Raw has a toolbar that contains a Zoom tool. 
This navigation tool enables you to magnify 
the image in a series of increments so that 
you can take a closer look at soft-focus  
areas, or tackle retouching challenges more 
easily such as cloning out a small but 
unsightly sensor spot. There are a range of 
techniques that enable you to jump to a 

closer look of a particular section of a 
raw file, and we’ll cover all of these in our 
annotated image on the next page. You can 
then experiment and decide which zooming 
method you prefer.

Once you’ve zoomed in for a closer look, 
you’ll need to pan around your magnified 
image to discover more problematic areas to 
fix. The Zoom tool works in tandem with the 
Hand tool, so you can scrutinise and edit the 
pixels of your picture quickly and effectively.  
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Take a closer look at any part of a picture

Photoshop Anatomy Navigation tools

the maximum 
magnification that 
you can achieve 
using the Camera 
raw Zoom Level 
options or the Zoom 
tool is 400% [1]. 
at this extreme 
magnification, you 
can see the blocks 
of colour and tone 
[2] that create 
the image. each 
photo is made up 
of millions of these 
pixels (hence the 

term, megapixel). 
although each pixel 
is square, they are 
small enough to 
create smoothly 
curved shapes when 
viewed at a lower 
magnification such 
as 100% or Fit in 
View [4]. when 
editing an image in 
Photoshop, you can 
zoom into a massive 
3200%, which gives 
you a much closer 
look at the pixels.

Keyboard 
shorTcuTs

when working with 
any tool in Camera 
raw, you can zoom 
in by simultaneously 
pressing Cmd/Ctrl 
and the + key, or 
zoom out by pressing 
Cmd/Ctrl and the 
– key. to quickly 
zoom into 100% 
magnification, double 
click the Zoom tool 
icon in the Camera 
raw toolbar. in 
Photoshop’s general 
Preferences menu, 
you can tick a box that 
enables you to zoom 
in using your mouse’s 
scroll wheel, but this 
option doesn’t work in 
Camera raw.

5 coNTeXT-seNsITIVe MeNu

right clicking with the Zoom or Hand tools summons 
the Zoom Level window wherever the cursor happens 
to be, which saves your cursor a trip down to the 
bottom left corner of the workspace.

6 sPecIFIc ZooM

the Zoom Level commands enable you to magnify the 
image in specific incremental jumps. to zoom into a 
specific object or area of the image, drag a rectangle 
with the Zoom tool.

1 ZooM TooL

if you need to take a closer look at an area, click this 
icon in the Camera raw toolbar to activate the Zoom 
tool. alternatively, press Z to summon it with the 
keyboard shortcut.

2 haNd TooL

Once you’ve magnified the image using the Zoom tool, 
click this icon to summon the Hand tool (or press H). 
You can temporarily summon the Hand tool when 
using any other tool by holding down the space bar. 
Let go of the space bar to jump back to the previously 
active tool.

3 draG

when the Hand tool is active, this icon will appear over 
the cursor. drag the mouse to pan the magnified image 
in any direction.

4 ZooM LeVeL

Click the plus or minus icons to zoom in or out in 
increments, type a specific percentage value into 
the field, or click the pop-up menu and choose a 
magnification percentage.

Understanding…
MAGNIFIED  
PIXELS
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Use the Histogram 
to assess exposure
Discover how to use the Histogram window to analyse the spread 
of tones in a raw image, and then fix any exposure problems

Discover the exposure problems in any image

Photoshop Anatomy Histogram window

1 OPEN IMAGE

Choose File>Open, browse to your 
chosen starting image. it will open 
in Camera raw. make sure it looks 
under-exposed to the naked eye.

3 SHADOWS

this shot has plenty of midtone and 
shadow information. the strength of 
the darkest shadows are represented 
at the far left.

2 SHADOW CLIPPING

Click the shadow Clipping warning 
to reveal clipped (under-exposed) 
shadows as patches of blue.

4 GRAPH

the undulating graph shows the 
strength and spread of the shadows, 
midtones and highlights in the image.

5 HIGHLIGHTS

the brightest highlights peter out in 
the middle of the histogram. in a well-
exposed photo, they’d stretch to the 
far right.

6 HIGHLIGHT CLIPPING

Click the Highlight Clipping warning to 
reveal clipped (over-exposed) highlights 
as patches of red.

O
ne of the main challenges we face 
when taking a photograph is to 
meter the scene to capture detail in 
the shadows, midtones and 

highlights. After capturing an image, you may 
discover that it’s under- or over-exposed. 
Some cameras enable you to summon a 
Histogram graph in the camera’s Live View 
display when setting up the shot. This graph 

demonstrates the spread of tones in the scene. 
A correctly set camera should display a 
histogram graph that spreads from the far left 
(where the darkest shadows are) to the far 
right (where the brightest highlights are).

Despite your best efforts, you may capture 
an image that has exposure problems, such 
as our under-exposed starting image. Camera 
Raw’s Histogram window enables you to 

analyse the spread of tones in a picture so 
that you can see precisely where the exposure 
problems are. You can then use the Histogram 
window to help you create a wider spread of 
tones that reveals missing detail and creates 
more contrast. In our first annotation, we’ll 
look at how to analyse an under-exposed 
photo’s histogram, before moving on to fix it 
in the second annotated image.  

2

3

65

1

4
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Adjust the spread of tones in the histogram graph

Overview Create a correct exposure

1 REGIONS

Place the cursor on part of the graph, and you can see which 
tonal region is being represented as a lighter grey bar.

2 EXPOSURE

in this example, we’ve placed the cursor on the part of the 
histogram graph that represents the tones controlled by the 
exposure slider.

3 DRAG

by dragging right inside a specific region (such as exposure) 
you can slide the graph right toward the highlights. this also 
increases the value of the exposure slider.

4 REMAP

by boosting the exposure and Highlights you remap the under-
exposed midtones and highlights and give them brighter values. 
the graph now stretches further to the right, indicating a wider 
spread of tones.

5 WHITES

You can target and tweak a narrow range of tones by using 
sliders such as whites. this slider brightens the lightest 
pixels without interfering with tones in the rest of the image. 
a correctly exposed photo should have some black shadows 
and white highlights for a strong contrast.

6 BEFORE AND AFTER

Click here to toggle through the various before-and-after views 
so you can compare your adjusted image with the original.

1

5

6

3
4
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2Tweak the colour and tone 
Click on an image and then click Select All to include 
the other images. We dragged Exposure up to +0.70 to 

brighten up an under-exposed image then pull Highlights left 
to -20 to avoid blowing out detail on the brighter petals. We 
then cool Temperature to 4100 and drag Tint to +20.

1Open the images
In Bridge, Shift click to select the batch of three starting 
images, starting with ‘PMZ11_batch.dng’. Alternatively, 

in Photoshop choose File>Open and Shift click to select the 
three files. Click Open. The open files’ thumbnails will be 
visible in Camera Raw.

W
hen shooting a series of shots in the same lighting 
conditions (and using identical camera settings), 
you may end up with a collection of images that 
have similar problems with colour and tone (such 

as our under-exposed starting images). You could open each 
image in turn and manually tweak its colours and tones, but 
this would be rather time-consuming.

Because our collection of images have similar problems 
we can use the Basic Camera Raw sliders to apply the same 
tonal and colour adjustments to every shot in the series 
and they’ll look consistently better. Adobe understand 
that most photographers would prefer to spend more time 
taking photographs and less time editing them, which is why 
Camera Raw enables you to batch process multiple photos at 
the same time.

As you’ll see from our walkthrough, Camera Raw 
enables you to make manual adjustments to a photo that is 
representative of the problems in a batch of similar images, 
and it will simultaneously apply the adjustments to all of the 
open files. If necessary you can then look through the batch-
processed files and fine-tune the adjustments to suit their 
individual needs.

Batch process 
your images
Save time and effort by opening and processing multiple 
photos taken at the same time in the same lighting

BEFORE

See p194 to  
find out more

Free  
assets!  
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4Fine-tune individual images 
The changes will be applied to all the files. Click the 
other thumbnails to see if they need fine-tuning. 

Our other two images are slightly brighter, so we tweak their 
Exposure to -65. Drop Highlights to -70. Click the Before 
and After icon to see how your edited images compare.   

3Reduce Vibrance
Boost Clarity to +16 to increase contrast and reveal 
fine details. For more natural-looking colours, drag 

Vibrance down to -15. Vibrance selectively reduces the 
saturation of the stronger colours without desaturating the 
weaker ones. This helps to keep the colours printable.

BEFORE

BEFORE
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4Adjust the Hue  
If you set the Targeted Adjustment tool to Hue, then 
you can drag on a particular colour and quickly change 

the hue of all similar colours. Here we dragged down on the 
red top to change the hue of the Reds in the HSL panel to 
pink. This turned the red lipstick pink too.

3Adjust the colour
Click and hold the Targeted Adjustment tool icon 
and choose Saturation. Click to sample a colour. Drag 

upwards to make that colour more saturated. Drag down 
to make it less saturated. This automatically changes the 
appropriate colour sliders in the HSL panel’s Saturation tab.

2Darken the shadows
Click to sample a shadow and drag down to make 
all the blacks in the image look blacker. These curve 

tweaks give the image a stronger contrast. Notice that the 
appropriate Highlights and Shadows sliders in the Parametric 
Curve panel have been adjusted automatically.

1 Brighten the highlights
Open the starting image. Click the Targeted Adjustment 
tool in the Tools panel. To see how the tool tweaks the 

photo’s curves, click the Tone Curve panel and choose the 
Parametric Curve tab. Click to sample the eye whites and drag 
upwards to brighten the highlights. 

C
amera Raw is packed full of tools and sliders that 
enable you to selectively target and adjust 
properties such as colour or tone. However, it can 
be quite daunting to decide which tool to pick or 

slider to adjust. The beauty of the Targeted Adjustment tool 
is that you can click a particular area to sample it, and then 
drag to adjust a range of properties.

The Targeted Adjustment tool will tinker with the 
Parametric Curve, which you’ll find in the Tone Curve 

panel. This panel provides you with a powerful way to 
adjust specific tones, but you can get carried away and end 
up blowing out highlights or clipping shadows if you’re 
unfamiliar with curves. The Targeted Adjustment tool 
enables you to tweak curves without using the sliders in the 
Parametric Tone Curve panel, so it’s more intuitive to use.

We’ll show you how to tweak colour hue, saturation and 
general tones simply by clicking them and dragging the 
cursor up or down.

Improve colour 
& tone locally
Alter the hue, saturation and brightness of specific 
regions of a photo using the Targeted Adjustment tool

See p194 to  
find out more

Free  
assets!  
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after using the targeted adjustment tool to perform common 
photo fixes such as increasing contrast and boosting colour 
saturation, you can use it to experiment with more creative 
looks. Here we set the targeted adjustment tool to alter 
Hue and turned the sampled blues a more cross-processed 
cyan [1]. we also altered the Hue of the reds to turn them 
orange. Here’s an alternative cross-processed look with 
greener graffiti, created by sampling and changing the Hue 

of the blues and Purples [2]. You can also set the targeted 
adjustment tool to grayscale mix. this enables you to drag 
down on a sampled colour to create darker tones in a 
monochrome conversion, or up to lighten the tones. Here 
we’ve created luminous white skin to make the model stand 
out more in contrast with the darker background [3]. Here 
we’ve sampled and darkened the reds of her dress and lips 
for a gothic look [4]. 

1

3

2
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4Choose a size
Use Image Sizing to create a version of your raw file 
with specific dimensions (such as a 4x7-inch print). 

For a high-quality print, keep resolution at 300. For the web, 
you can drop the resolution to 72. Sharpen the file for screen 
or print. Click Save to create a resized JPEG version.  

3Set the quality
The Format drop-down menu will change to the file 
format you’ve chosen. To create a smaller JPEG you 

could drop the Quality setting, though obviously, this creates 
a lower quality image. If you plan to share the photo onscreen 
set Color Space to sRGB. Use Adobe RGB for print.

2Choose a format
To save the image in a web-friendly format, click the 
Save Image button at the bottom left. The Save Image 

window will appear. In Destination, click Select Folder and 
choose a folder to store your saved photo in. Click Select. 
Label the photo and choose a format such as JPG.

1Process the picture
Open the image. Our raw file is too warm, so drag 
Temperature to 450 for more natural skin tones. The 

highlights are too bright, so we drop Contrast to -23 and 
Highlights to -43. We drag Blacks to -53 for more contrast and 
set Clarity to -11 for softer skin then boost Vibrance to +33.

A
fter processing a raw file, you have a choice of 
several image-saving options. By default, when 
you make changes to a raw file and click Done to 
close the image, Camera Raw will create an XMP 

file that’s stored in the same folder as your original raw file. 
This sidecar file describes the position and value of any 
sliders that were tweaked in Camera Raw, as well as any 
modifications that you’ve made using tools to crop, clone or 
selectively tone the raw image. When you re-open the raw 

file in the future, Camera raw will read the XMP file and then 
automatically reapply all the image adjustments and slider 
settings that you made earlier.

You may want to click Open Image to continue editing 
the raw file using tools and filters that aren’t available in 
Camera Raw. Alternatively, you might want to create a 
compressed version of the processed picture that’s suitable 
for posting online. Here’s how to save your raw file in a 
variety of formats.

Resize and save 
your raw files
Discover how to save your edited photos in different image 
formats at different sizes to suit your file-sharing needs

See p194 to  
find out more

Free  
assets!  
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Fix photo 
problems
Quickly improve composition, tones, and colour, 
and remove unwanted elements from your photos

68 Improve the tonal quality 
of your photos
Discover how to brighten under-

exposed images and add punch with additional 
contrast using the Basic panel

70 Improve image colours 
with the Basic panel
Use the colour-enhancing tools in the 

Basic panel to create strong and natural-looking 
colours in your photos

72 Remove unwanted 
spots and marks
Discover how to identify and remove 

unsightly spots, blemishes and other unwanted 
artefacts in your photos

page://58
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4Tweak the contrast
For a healthy contrast we need some white whites 
and black blacks. We could drag the Contrast slider 

to darken shadows and lighten highlights equally. For more 
control drag Whites to +17. Darken the Blacks slider to -10. 
This allows a touch of blue shadow clipping patches to appear 
in unimportant areas.  

3Reveal shadow detail
In this example the clipped highlights only appear in 
the specular reflections in her eyes and earring, so 

we’re not losing any important highlight detail. It’s good to 
have some bright highlights in an image if it gives a healthy 
contrast. To reveal detail hidden in the photo’s shadows, 
boost the Shadows slider to +55.

2Discover clipped highlights
When boosting highlights you risk clipping (over-
exposing) them and losing detail. Clipped highlights 

appear as a peak at the right of the graph. To reveal them in 
the image, we can click the Highlight clipping warning icon 
at the right of the Histogram, or press O for over-exposed. 
Clipped highlights will appear as patches of red.

1Boost highlight strength 
Open the image in Camera Raw. The histogram graph 
needs to stretch from the far left to the far right if 

we’re to have a correctly exposed shot. As the highlights are 
weak, drag the Highlights slider right to 100. This causes the 
graph’s weak highlights to slide right too, indicating that they 
have been made stronger.

A
shot that looks correctly exposed on your camera’s 
illuminated display may look a little dull and 
suffer from a lack of contrast when printed out as 
a hard copy. Our starting image looks fairly 

well-exposed to the naked eye, but if we look at the Camera 
Raw Histogram we can see that the undulating graph doesn’t 
quite stretch to the far right. This indicates that while the 
shot has plenty of shadow and midtone information, it lacks 
strong highlights. It’s a simple matter to tweak a few sliders 

in the Camera Raw Basic panel to selectively boost the 
strength of the weak highlights. We’ll also show you how to 
reveal some extra detail in our subject’s darkest shadows, 
while creating an image that enjoys a strong contrast with 
some black shadows and white highlights. This increase in 
contrast will help the image look less flat and give it more 
impact. As the Basic panel’s tone-tweaking sliders enable you 
to target and adjust specific tonal ranges, you can use them to 
fix common exposure problems quickly and effectively.

Improve tones
Discover how to brighten under-exposed images and add 
punch with additional contrast using the Basic panel

See p194 to  
find out more

Free  
assets!  
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2Warm up the colours
Go to the White Balance drop-down menu. Here you’ll 
find a series of settings that are similar to those you 

can select in camera. Experiment to see which produces the 
most tint-free colours. In this instance Auto does a good job 
of removing the cold blue colour cast.

1Open the image
Opening the image in Camera Raw, our unprocessed 
starting image’s colours look very drab, so we need to 

reveal the extra colour information hidden in the raw file. The 
colours look a little cold too, so we’ll need to warm them up 
slightly to remove the slightly blue colour cast.

I
f you capture your photos in JPEG format then 
the colour settings that you choose in your 
camera’s menu will be applied to the image 
as it's saved onto the memory card. This 

means that it will be harder for you to change a photo’s 
pre-processed colours in Photoshop. By using in-camera 
colour settings such as Vivid or Natural you’ll produce a 
range of dramatically different looking colours. If you use 
an inappropriate white-balance setting when shooting 
JPEGS then your photos may suffer from colour casts too. 
These warm or blue tints in a compressed JPEG will also 
be more challenging to correct in Photoshop compared 
to working with a raw file.

By photographing in raw you have more colour 
information to work with. The colour boosting and 
correcting tools in the Camera Raw Basic panel can be 
used to produce a range of different looks, from a vivid 
colour palette to a more natural, less saturated look. 
This gives you more freedom and quality than you’d 
get by applying an in-camera colour preset to a JPEG 
version of the image. Here’s a quick colour-enhancing 
walkthrough you can apply to your own photos.

Improve 
image colour
Use the colour-enhancing tools in the Basic panel to 
create strong and natural-looking colours in your photos

BEFORE
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Free  
assets!  



Teach yourself Raw in Photoshop
Fix photo problems

71

Fix photo problems

4Boost the saturation
Drag Vibrance up to +19. This selectively boosts the 
saturation of weaker colours without over-saturating 

stronger ones. This makes the colours look more evenly 
saturated. We give the colours a global boost by pushing 
Saturation up to +36. A Clarity of +15 reveals more texture.  

3Correct the exposure
From the histogram we can see that the image is 
under-exposed. It’s always worth fixing exposure 

problems before adjusting colour saturation, because this can 
reveal more colour problems. We drag Exposure up to +0.50, 
increase Highlights to +32 and Whites to +36.
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W
hen shooting subjects that feature a large 
clear expanse of bright colour or tone, such 
as a sky or a studio backdrop, then you may 
notice small grey blobs in these sections of 

the image. Unsightly sensor spots are caused when 
specks of dust enter the camera body (when changing 
lenses, for example) and come to rest on the sensor. 
Your SLR may enable you to vibrate the sensor in an 
attempt to clean it, but this may not be enough to shake 
the more tenacious spots. You could attempt to clean 
the sensor by removing the lens, opening the shutter 
and blasting the sensor with a gust of air from a blower 
brush. However, this physical fix won’t remove sensor 
spots from older photos in your collection.

If shooting a portrait, then your subject may suffer 
from spots and pimples on the skin. Although these 
types of spots aren’t a camera-induced artefact, you 
may still want to flatter the subject by creating 
a spot-free complexion.

Camera Raw has a spot-removal tool that can 
eradicate skin or sensor spots quickly and effectively. 
It works by sampling clean pixels and placing them over 
an adjacent spot. We’ll show you how to modify the 
tool to reveal the location of spots more effectively, so 
that you can remove them with a few clicks.

Remove unwanted 
spots and marks
Discover how to identify and remove unsightly spots, 
blemishes and other unwanted artefacts in your photos
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2   Adjust the tolerance
To reveal more subtly contrasting spots lurking in 
smooth patches of skin, we drag the Visualize Spots 

slider right. This makes it more sensitive. The trick here is 
to get a balance between revealing spots in patches of white, 
without including other details such as skin pores.

1 Find the spots
We begin by clicking the Spot Removal tool in the 
toolbar (or pressing B to summon it). To discover the 

location of the most unsightly spots, we tick the Visualize 
Spots box in the Spot Removal panel. By default only the 
most contrasting edges will be visible in white.

4 Reposition the overlays
Untick Visualize Spots to see the image. As you click 
a spot, a red overlay surrounds it. The attached green 

overlay automatically samples a clear patch of skin to place it 
over the unwanted spot. Reposition a green overlay to find a 
cleaner patch of skin.

3 Set up the tip
We increase the Size slider so that the Spot Removal 
tool’s tip is large enough to cover the average spot. 

Set the Type drop-down menu to Heal. This will cause 
sampled and relocated skin to be seamlessly blended with its 
new surroundings. Click a white spot to turn it black.

6Remove lines
The latest version of Camera Raw enables you to draw 
irregular shapes with the Spot Removal tool, so that 

you can select and remove lines and wrinkles in a single 
stroke. These longer strokes are represented by pins. Click a 
pin to activate and edit the attached overlay.  

5 Fine-tune the size
Drag the edge of an overlay to resize it. To restore 
a missing birth mark or freckle that’s a permanent 

part of the subject’s character, click an overlay and hit the 
Backspace key to delete it. To get a clearer look at the subject, 
tick the Show Overlay box.
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There are some adjustments you’ll need to make to almost 
every photo. Find out what they are and how to apply them

76 Reduce unsightly 
image noise
Smooth away distracting luminance 

and chrominance noise caused by using high ISO 
settings in low-light conditions

78 Correct lens distortion 
and vignetting
Remove unwanted lens effects 

from your photos such as image distortion 
and vignetting using lens profiles

82 Correct perspectival 
distortion
Straighten converging verticals in 

your photos of buildings using the powerful 
Upright command in Camera Raw

84 Re-create in-camera 
picture styles
Make changes to the colours and 

tones of a photograph with just a few clicks by 
applying different camera profiles

88 Sharpen up 
your images
Discover how to make your photos 

appear crisp and sharp without introducing image 
noise in blurred areas

Essential 
corrections
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Reduce 
unsightly image noise
Smooth away distracting luminance and chrominance noise 
caused by using high ISO settings in low-light conditions

W
hen shooting in low lighting 
conditions your camera will 
struggle to capture a correct 
exposure. You could pop up the 

flash to add artificial light, but this may not 
always help. Flash won’t illuminate distant 
objects and may not be permitted in certain 
locations. By setting your camera to a faster 
ISO speed you can make it more sensitive to 
available light. This enables you to use a 
narrower aperture and a faster shutter speed 
in low light, but it can result in pictures 
suffering from noise. There are two types of 

digital noise present in a photo captured 
using a high ISO. The most distracting is 
Chrominance (or colour) noise. This appears 
as rainbow-coloured dots scattered 
throughout the image. Fortunately, this 
unsightly type of noise is easy to remove 
without smoothing out important details.

The second type of noise is Luminance 
noise. This appears as greyscale specks of 
digital grain. Camera Raw counteracts this 
type of noise by smoothing it using the 
Detail panel’s Noise Reduction sliders. 
However, this operation can also smooth 

out fine details in the image, so you need to 
juggle the sliders to get a balance between 
smoothing unwanted noise while preserving 
the detail you want to retain.

There are lots of different ISO speeds to 
choose from. The higher the ISO speed, the 
noisier the results. After showing you how to 
smooth noise while preserving detail, we’ll 
demonstrate how to set up the Camera Raw 
preferences so that the correct amount of 
noise reduction will be applied to suit the 
specific ISO speed of any picture that you 
open in future.  

BEFORE
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find out more
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Remove luminance and chrominance noise using the Detail panel

Photoshop Anatomy Noise Reduction

By default, the camera 
raw noise reduction 
sliders are set with 
luminance at 0 and 
color at 25. You can 
tailor these noise 
reduction defaults to 
apply suitable settings 
to different iso speed 
images. Go to camera 
raw preferences and 
tick Make defaults 
specific to camera 
iso setting. click oK. 
open an image with a 
particular iso speed 

(such as our lizard’s 
iso of 1000). set 
the noise reduction 
sliders to smooth out 
the noise [1]. click the 
fly-out icon [2]. click 
save new camera 
raw Defaults [3]. 
click Done to close 
the raw file. When you 
open another iso1000 
image, click here [4] to 
apply the appropriate 
noise reduction 
settings that you 
applied previously.

Give it 100%

to see precisely how much noise 
is blighting your photograph, you 
need to view the shot at 100%. 
this actual-size magnification 
enables you to use the noise 
reduction sliders to smooth 
out noise more accurately while 
preserving important details in the 
scene. click the select Zoom level 
pop-up menu and choose 100% 
from there. alternatively, you can 
double click the Zoom tool icon 
in the toolbar, and the image will 
automatically jump to 100%. You 
can then press H to summon the 
Hand tool and drag the magnified 
image to find a noisy area to 
work on. We chose a section that 
showed a mixture of smooth 
background and the lizard’s 
detailed texture.

5 COLOR DetAiL

this slider provides a balance between reducing 
colour bleed and colour speckling. Drag it right 
to reduce bleed or left to reduce speckling. 
a value of 73 will be fine in this instance.

6 COLOR SMOOtHNeSS

this slider is designed to remove low- 
frequency colour mottling, though in the 
case of this image the default setting of 50 
produces good results.

1 COLOUR NOiSe

chrominance noise is visible 
as specks of colour. By default 
the camera raw color slider 
is automatically set to 25 to 
remove colour noise from all 
photos. to remove it from this 
image a color value of 35 is 
sufficient here.

2 LUMiNANCe 
NOiSe 

this type of greyscale digital 
noise equates to the grain 
produced by fast iso speed 
film, although clumps of grain 
are considered more attractive 
than sharp dots of digital noise.

3 LUMiNANCe

Drag this slider right to smooth 
out noise. Drag it left to restore 
fine detail. this is the most useful 
slider to start working with. 
a value of 69 dramatically 
reduces the presence of noise, 
especially in the background blur.

4 LUMiNANCe DetAiL

enables you to get a balance between smoothing out luminance 
noise while protecting important details. Drag right to sharpen 
blurred details, or left to blur more noise. You can reveal fine detail by 
increasing luminance contrast, though that will exaggerate noise.

Understanding…
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W
hat you see with the naked eye isn’t always what you get 
in a photo. This is due to problems produced by the 
camera’s lens. When shooting with a wide-angle lens, 
horizontal and vertical lines can look curved instead of 

straight. This distortion is especially noticeable when shooting 
architecture. Barrel distortion causes the edges of the frame to bulge 
outwards (as if you’d wrapped the photo around a barrel). Pincushion 
distortion causes the edges to bulge inwards. These types of 
lens-related problems are referred to as geometric distortion.

Due to the way a lens is manufactured, you may find that less 
light enters at the edges. The resulting uneven exposure can cause 
the edges of the frame to look darker (or vignetted). You may find 
fringes of green or purple clinging to the contrasting edges of your 
subject. This ugly and distracting chromatic aberration is caused 
by the lens’s inability to focus different wavelengths of light onto the 
same spot on your camera’s sensor. It’s more noticeable when using 
cheap lenses, but even the L-series lens used to take our starting 
image features a little fringing. We’ll show you how to use the Lens 
Correction panel’s Color tab to remove colour fringes automatically, 
or take manual control where necessary. The aptly named Lens 
Correction panel also has tools dedicated to counteracting geometric 
distortion and vignetted corners. One of the most useful tools is the 
Profile tab, because it enables you to remove lens-induced artefacts 
with a click.

Fix lens 
distortion
Remove unwanted lens effects 
from your photos such as image 
distortion and vignetting
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1Open the image
Open this image in Camera Raw. Looking below the Histogram 
window we can see that a wide-angle lens was used to capture 

this example picture. The additional @24 information tells us that 
the lens was at its widest setting. This will cause some geometric 
distortion and possibly lead to vignetting around the edges. Thanks 
to the lens’s wide-angle setting, the building’s edges also suffer from 
perspectival distortion.

3Before and after
If your lens’s make and model details don’t automatically appear, 
choose your lens’s manufacturer (such as Canon) from the Make 

drop-down menu. This should be enough for Camera Raw to find the 
precise lens used, and apply a profile that counteracts any geometric 
distortions that the lens produces. Toggle the profile on and off to see a 
before-and-after version of the shot. You can see that the image suffers 
from vignetted edges and barrel distortion when the profile is off.

2Use a profile
Click the Lens Corrections panel. Click the Profile tab. We can 
use this tab to make a lens profile from the metadata stored in 

the raw file. Once Camera Raw knows which lens and focal length you 
used to capture the image, it will automatically be able to counteract 
geometric distortion and create more evenly exposed edges. Tick 
Enable lens Profile Corrections. Your lens’s manufacturer and lens 
model details should appear.

4Fine-tune the corrections
In this uncorrected version of the demo image, the sky is darker 
at the top left corner. The profile counteracts this vignetting 

and creates a more evenly exposed sky. We can fine-tune the effect 
of the profile using the Correction Amount sliders at the bottom. To 
counteract the barrelling even more, we push the Distortion slider 
right to 143. To gently reduce the strength of the vignette correction, 
we drag Vignetting left to 66.
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5Create a custom profile
After tweaking the Correction Amount sliders, you’ll have created 
a custom profile. You’ll see the word Custom appear in the Setup 

drop-down menu. If you want to apply the same corrections to other 
images captured with this lens, click the Setup drop-down menu. Click 
Save New Lens Profile Defaults. Setup will change to Default, but now 
when you apply the Default profile to a shot, it will use the numerical 
values you applied to the Correction Amount sliders.

7Remove the coloured fringes
If the Remove Chromatic Aberration box doesn’t work, you 
can manually choose the colour of the fringes that you need to 

remove. Untick the box. We drag the Green Amount slider right to 16. 
The green fringe is still visible. To widen the range of the tool to include 
more green hues, drag the Green Hue slider to the right. In this case a 
value of 86 is enough to include and remove the colour of the unwanted 
green fringe. Set Purple Amount to 9 to remove the purple fringe.

6Remove the chromatic aberration
Grab the Zoom tool and click to magnify the image to 100%. 
We can hold down the spacebar to summon the Hand tool and 

drag to view the church tower. You’ll notice a green fringe clinging to 
the right of the tower as the dark building contrasts against the lighter 
sky. Clinging to the left of the tower is a less noticeable but still visible 
purple fringe. In most cases you should be able to remove all traces of 
fringing by clicking the Remove Chromatic Aberration box.

8Correct the perspectival distortion
We zoom out to see the whole image. The church’s walls are 
converging inwards towards the top. To straighten them, we 

click the Manual tab. Drag the Vertical slider to the left to counteract 
the perspectival distortion – a value of -30 does the trick in this 
example. After manually adjusting the verticals, you’ll need to use the 
Crop tool to hide the transparent corners at the bottom of the frame. 
We’ll look at this panel in more detail on the next spread.  
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2Auto correction
Although the tower is corrected, the walls at the 
far left and right are still converging, and we’ve created 

transparent edges that need cropping. As an alternative, we 
tick the Auto button in the Upright section. This produces 
a similar perspectival correction and scales up the shot to 

1Straighten the building
Open ‘PMZ106_upright.dng’, then open the Lens 
Corrections panel and click Manual. Tick Show Grid. 

By dragging Vertical left to -22 we can make the tower’s 
vertical lines run parallel with the frame edge. If the corrected 
building looks a little too squat, we can drag the Aspect slider 
right to slim it down a little.

W
e take it for granted that most buildings have 
vertical walls that extend at a 90-degree angle 
from the ground. However, in photographs, the 
walls often appear wider apart at the ground, but 

tilt inwards towards the top (as you can see in our starting 
image). These converging vertical lines are created by 
perspectival distortion.

As you get closer to a building, you’ll need to tilt your 
camera at a steeper angle to get the top of the structure 
in shot. This will create the perspectival distortion. 
Converging lines can also be exaggerated when you use 
a wide-angle lens to fit the building into the frame.

The Manual tab on the Lens Correction panel contains 
a Distortion slider that enables you to counteract 
converging verticals. However, this can create large 
transparent areas at the bottom of the image that will 
need to be cropped out. The Upright tools enable you to 
distort your image automatically to make the subject’s 
verticals actually look vertical. They can also produce 
results that need less cropping. If you do need to crop a 
corrected shot, we’ll show you a trick that enables you 
to fill in the transparent edges with appropriate detail.

Correct 
perspectival 
distortion
Straighten converging verticals in your photos of buildings 
using the powerful Upright command in Camera Raw
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4Remove the transparent edges
Click Open>Image. To fill any transparent edges 
with appropriate pixels, we grab the Magic Wand 

tool. Untick Contiguous. Click to select the edges. Choose 
Select>Modify>Expand. Type in a value of 15. Click OK. 
Choose Edit>Fill. Set Use to Content-Aware. Click OK. This 
fills the transparent edges with grass.  

3Force the verticals
The Auto button produces a subtle, balanced 
perspective correction. This means that the edge 

verticals will still tilt a little. To force all the walls of the 
building to run parallel with the edge of the frame, we click 
the Vertical button. We can then drag the Scale slider left to 
reveal more of the frame’s edge details.
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2Choose a profile
Leave Process set to 2012 (Current) to use the latest 
raw processing tools. Camera Landscape increases 

contrast and boosts the colour saturation of natural colours 
such as greens without over-saturating the subject’s skin 
tones, so settle with that profile as a starting point.

1Choose your processing options
Open up our starting portrait. Click the Camera Calibra-
tion panel. Camera Raw 8 uses the 2012 processing en-

gine, but you could jump back to the 2010 process to replace 
the Basic panel’s Highlights and Shadows slider with the 
older Recovery and Fill light sliders.

M
any digital cameras provide the 
opportunity to process a shot as they 
capture it, using a range of preset 
applied adjustments such as Portrait, 

Landscape, Neutral and so on. These presets change 
the look of the captured shots’ colours and tones. 
For example, a camera’s Landscape preset might 
boost the saturation of natural colours such as 
blues and greens. The Neutral preset will avoid 
boosting the colour and contrast so that you can 
get the look you want manually by adjusting the 
sliders in Camera Raw.

If you shoot in JPEG format, then the results 
of these in-camera presets will be harder to alter 
in Photoshop. However, if you shoot in your 
camera’s raw format then you can experiment with 
different looks quickly and effectively, courtesy of 
the profiles and sliders in the Camera Calibration 
panel. This panel provides you with a springboard 
for quickly adjusting a raw file’s colour and tone. 
You can then fine-tune the results of a particular 
preset profile using the Basic panel’s sliders.

Re-create camera 
picture styles
Make changes to the colours and tones of a photograph 
with just a few clicks by applying different camera profiles
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4Back to Basic
We pop back to the Basic panel to finish improving the 
image. Set the Shadows slider to +34 to reveal more 

detail in the dark irises. Drop Clarity to -13 to smooth skin 
pores. Push Vibrance to +17 to boost weaker colours without 
over-saturating stronger ones (or skin tones).

3Fine-tune the profile
We draw attention to the vegetation by boosting 
Vibrance to +40. This selectively boosts the saturation 

of typical landscape colours without over-saturating any skin 
tones that may be present. Click the Presets tab. Click the 
New Preset icon at the bottom of the tab.
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if you want to take more manual control over the colours and 
tones of an image, use the camera neutral profile. this gives 
you a very flat contrast and helps avoid clipping detail in the 
shadows and highlights [1]. it also produces desaturated 
colours. You can then boost the colour saturation and increase 
the contrast using the sliders in the Basic panel. For an instant 
high-contrast shot with vivid colours, choose the Vibrant profile 

as your starting point [2]. For more creative looks, experiment 
with the mix of Primary reds, Primary Greens and Primary 
Blues. Here [3] we’ve adjusted the Hue and saturation values to 
create a shift towards a predominantly yellow hue. You can also 
use the camera calibration panel to tint the photo’s shadows 
green or magenta, courtesy of the tints slider. We’ve boosted the 
presence of the magentas in this example [4].  

1

3

2
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I
t can be a challenge to get your shots looking 
sharp. For starters, some digital cameras have a 
built-in filter that blurs the shot a little in an 
attempt to avoid producing moiré patterns. This 

low-pass (or anti-aliasing) filter can also soften important 
details such as the fine textures in an insect’s eye. If you 
shoot with a wide aperture then key details may become 
blurred due to the resulting shallow depth of field. An image 
that may look nice and sharp on your camera’s display can 
turn out to be soft when viewed on a larger PC monitor.

The Camera Raw Detail panel has a Sharpening section that 
has a collection of sliders designed to tease out fine details 

in a soft shot. These post-production sharpening techniques 
work by increasing the contrast around the edge of details 
in the image, giving them more impact. However, when you 
digitally sharpen an image, you risk exaggerating picture 
noise in smooth areas such as our starting image’s clean 
blurred background. You can also introduce artefacts such as 
blown-out highlights, clipped shadows and distracting haloes 
clinging to the edge of the sharpened areas.

We’ll demonstrate how to use the Detail panel to restrict 
the sharpening to key areas, while protecting other sections 
of the image from being sharpened (and therefore minimising 
unwanted artefacts).

Sharpen 
your images
Discover how to make your photos appear crisp and 
sharp without introducing image noise in blurred areas
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2  Increase the sharpening
By default Camera Raw applies a sharpening Amount 
of 25 to give the picture a bit more punch. We’ve set 

Amount to 0 so that you can see how soft the subject really 
looks. By dragging Amount to the maximum of 150 we can 
tease out the fine textures in the moth’s eye.

1 Magnify the image
Open our moth image in Camera Raw. To see exactly 
how sharp the shot really is, grab the Zoom tool. Right 

click and choose 100% from the pop-up menu. Hold down 
the space bar to summon the Hand tool and drag to view the 
eye. Click the Detail panel’s tab.

4 Adjust the Radius
Experiment by dragging Radius back and forth. This 
increases the spread of the contrast change, which 

helps make contrasting details look sharper. If you combine a 
high Amount with a high Radius you add black or white lines 
(or haloes) to edges in the scene. Set Radius to 2.0.

3 Reduce the noise
By increasing the Amount we increase the strength of 
the contrast change around details in the image. This 

makes the fly’s eye look sharper, but it also exaggerates the 
picture noise in the smooth blurred background. Drop the 
Amount to a lower 96 to reduce the noise.

6Adjust the Masking
This slider stops noise in smooth areas from being 
sharpened. We hold Alt and drag the Masking slider 

until the background appears in black and the fly in white. 
Now the sharpening adjustments will only be applied to the 
white areas. You can now boost the Amount to 130.  

5 Adjust the Detail
The Detail slider helps you get a balance between 
sharpening the shot while keeping noise to a 

minimum. Drag it left to soften the scene and remove the 
noise, or right to reveal more detail and noise. Hold Alt as you 
drag to get a greyscale preview of the details being revealed.
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Improve 
tones
Adjust the highlights, shadows and midtones 
of a photo either globally or in selected areas

92 Adjust highlights 
and shadows
Target and tweak the highlights 

and shadows of a photo independently to reveal 
missing tonal detail

94 Improve tones 
with curves
Target and adjust specific tones 

in an image by editing the shape of the tone 
curve in Camera Raw

98 Dodge and burn with 
the Adjustment Brush
Learn how to make selective brush-

based tonal adjustments to tease out detail in your 
photos where it’s needed

102 Reproduce the 
solarisation effect
Harness the power of the Tone 

Curve panel to mimic a traditional darkroom 
image-processing technique

page://94
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2Adjust the shadows
We drag the Highlights slider down to -30 to correctly 
expose them. To reveal more shadow detail without 

interfering with the correctly exposed highlights, we drag the 
Shadows slider right to +50. The shadows in the histogram 
have slid right a little, indicating their brighter status.

1Adjust Exposure
You can see from the histogram that ‘PMZ92_
shadowhighlight.dng’ features strong shadows and just a 

few weak highlights. Drag the Exposure slider to +0.85. This 
reveals more shadow detail, but the highlights now look a 
little too bright here.

I
n the starting image for this tutorial the 
foreground mountains are in shadow due to the 
clouds, but the distant sunlit hills and sky are 
much brighter. If we meter the camera to capture 

detail in the shadows then we blow out the highlights in the 
distance. As it’s harder to recover missing highlight detail 
than it is shadow, we’ve prioritised the highlights when 
setting the exposure. As a result, our unprocessed raw file 
features a large area of under-exposed shadows that lack 

detail. We need to brighten up the shadows without over-
exposing the highlights. The Camera Raw Basic tab enables 
you to combine global exposure adjustments that brighten or 
darken the entire image with local adjustments that enable 
you to adjust the shadows or highlights independently. By 
combining global and local adjustments, you can reveal detail 
precisely where its needed and produce a photo with 
correctly exposed shadows and highlights. You’re editing a 
raw file, so there will be much more tonal detail to work with.

Reveal detail
Target and tweak the highlights and shadows of 
a photo independently to reveal missing tonal detail

4 Increase the midtone contrast
Drag the Clarity slider right to +18. This increases the 
midtone contrast and makes the textures in the rocky 

shadows stand out more effectively. We’re only adjusting the 
midtones so the correctly exposed shadows and highlights 
remain unaltered. Boost Saturation to +8 for extra colour.  

3Boost the colour
When we brighten up under-exposed shadows, the 
colours that are revealed in these areas tend to look 

drab. By dragging Vibrance to +48 we can boost weaker 
colours in the shadows without over-saturating strong 
highlights in the brighter areas.
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C  amera Raw recreates a photo’s shadows, 
midtones and highlights using a range of tonal 
levels. The darkest blacks have a level of 0, 
while the brightest highlights have a level of 

255. All the shades in a picture are produced using levels 
that fall between these two extremes. When you import 
an unprocessed raw image into Camera Raw, you will see 
the tones created by its input levels. These are tones that 
are captured using the camera’s aperture and shutter 
speed settings. In the case of our starting image, the shot 
is under-exposed. The shadow input levels are too low 
and lacking in detail. We need to remap these low (dark) 
input levels to higher (brighter) output levels. In the 
Histogram window, our example image’s highlights peter 
out before they hit the far right of the graph. This 

indicates that the highlight input levels aren’t as strong as 
they could be, so we can remap these too.

The Basic panel’s tone-tweaking tools (such as the 
Shadows and Highlights sliders) are designed to target 
a specific range of input levels and remap them to new 
output levels. In most cases you can overcome typical 
problems with exposure using these sliders. An alternative 
way to target and adjust a specific range of levels can 
be found in the Tone Curve panel. This tool also uses a 
histogram to present the image’s current input levels as 
an undulating graph. A diagonal straight line crosses the 
histogram, from the darkest section at the bottom left to 
the brightest section at the top right. By making parts of 
the line curve up or down you can lighten or darken the 
levels of specific tones on the underlying histogram.

Use curves to 
improve tones
Target and adjust specific tones in an image by 
editing the shape of the tone curve in Camera Raw
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find out more
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1Examine the levels
To get a clearer understanding of the tonal levels that make 
up our example shot, we’ve got to grab the Zoom tool, moving 

the Zoom tool over the brightest area that we can find, such as 
the white patch on the model’s dress. Below the Histogram you’ll 
see the RGB values of the sampled area. In this example we have 
a value of 214, 211 and 188. A pure white area would have levels of 
255, 255, and 255.

3Open the Tone Curve panel
To brighten up this under-exposed shot and reveal more 
detail in the shadows and midtones, we click the Tone Curve 

panel. Curves come in two categories – a Parametric curve and a 
Point curve. The Parametric curve is easier to use because it breaks 
the curve up into four tonal regions – Shadows, Darks, Lights and 
Highlights. You can use sliders to target and adjust a specific region 
without altering tones with different levels. 

2Sample the shadows
From the sampled level we can see that the brightest whites 
are quite dull and under-exposed. Press U to turn on the 

shadow clipping warning. We notice a blue patch of clipped pixels on 
the dress. Move the Zoom tool over this area to take an RGB reading. 
In this example, this clipped section has RGB values of 0,0, and 0. 
This indicates that this part of the picture is pure black, and will 
print with no detail.

4Adjust the shadows
Initially, our curve is a straight diagonal line. To start curving 
it (and remapping the input levels to new output levels) we 

drag the Shadows slider right to +30. This causes the lower left 
section of the diagonal line to curve upwards. As this part of the 
curve overlaps the darker sections of the histogram graph, it remaps 
these shadow areas to brighter output levels. The remapped shadow 
tones in the Histogram window will slide right a little.
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5Adjust the midtones
To lighten up midtones, drag the Darks slider to +50. This pushes 
the middle of the curve upwards. This section of the curve 

overlaps the midtones on the histogram, so they are remapped to a 
lighter level. The subject’s midtones and shadows now look lighter, and 
more detail is visible. We still have a little shadow clipping on the dress, 
but there’s no important detail here, and it’s good to have some black 
shadows for contrast.

7Fine-tune the look
You can fine-tune the effect of the four sliders by tweaking 
the range of levels that they alter. To let more midtones fall 

under the influence of the Shadows slider, go to the bottom of the 
Parametric curve’s histogram. Here you’ll find triangular control points 
that indicate the boundary between each slider’s region. Drag the left 
control point from its default value of 25 to 38. This lightens up the 
midtones a little more.

6Adjust the highlights
Press O (for over-exposed) to turn on the Highlight clipping 
warning so that you can spot blown-out (pure white) highlights 

as patches of red. To make the highlights slightly brighter, we push the 
Lights slider to +10 and the Highlights slider to +4. The top right of 
the curve will move upwards, brightening levels at the far right of the 
histogram graph. Don’t push the highlights too far or you’ll exaggerate 
the unflattering sweat reflections on the skin.

8Add contrast with a Point curve
The adjacent Point Curve tab is handy if you have a shot that 
lacks contrast. The Curve drop-down menu allows you to 

choose preset point curve adjustments such as Strong Contrast. This 
creates a classic S-curve shape. A point pulls the curve down at the 
left to darken the shadows. Another point pulls the curve up at the 
top right to lighten the highlights. You can drag the points to fine-
tune the results.  
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T  he Camera Raw Basic panel has plenty of tone- 
targeting sliders that are designed to selectively 
adjust a shot’s shadows, midtones and highlights. 
The Shadows slider lightens shadows without 

over-exposing stronger highlights. You can claw back missing 
highlight detail without under-exposing correctly exposed 
shadows thanks to the Highlights slider. The Clarity slider 
enables you to increase midtone contrast and make subtle 
textures and details pop out from the processed picture. 
Camera Raw also has tools that enable you to make gradated 
tonal adjustments, so you can darken a bright sky without 
altering the correctly exposed terrain in the bottom section 
of the scene. You can even click the Histogram and see which 
tonal region is represented by a particular part of the graph. 
If you drag to the right you can brighten the selected region 
of tones (such as shadows), or drag left to darken them.

Most tone-related problems can be tackled by applying a 
combination of the tools or techniques mentioned above, but 
for even more selective tonal corrections, you can use Camera 
Raw to mimic the traditional darkroom technique of dodging 
and burning. By placing a shaped piece of card between the 
enlarger and photo paper, a photographer could reduce the 
amount of light hitting parts of the print. This dodging 
would lighten the masked sections. To darken a particular 
area, the photographer would cut a shape in a piece of card. 
The extra light travelling through the hole would darken (or 
burn) details in the print. We can recreate these dodging and 
burning techniques using the Adjustment Brush.

Dodge and burn with 
the Adjustment Brush
Learn how to make selective brush-based tonal adjustments 
to tease out detail in your photos where it’s needed

See p194 to  
find out more

Free  
assets!  
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1Open the image
The Histogram in our demonstration image above indicates  
the presence of strong shadows on the left of the graph, but  

the tones peter out towards the highlights on the right. The image  
is under-exposed. Before we start making some time-consuming 
selective brush-based adjustments, we need to use the Basic panel’s 
sliders to give the photograph a healthier looking histogram with a 
wider tonal range.

3Lighten the shadows
We now have a photo that possesses some bright highlights. 
To reveal more detail in the shadows, we click near the left of 

the Histogram to target the Shadows and drag right on the Histogram 
to remap the original shadows to a brighter value. The Shadows slider 
will move to the right. A Shadows value of +72 is a good starting 
point. The Histogram graph now has a wider spread of tones, and the 
image looks more correctly exposed as a result.

2Boost the highlights
Place the cursor on the section of the Histogram graph that 
represents and controls the Highlights. The label Highlights will 

appear below the graph. We drag right to lighten the under-exposed 
highlights. The highlight section of the graph will slide to the right, 
indicating the presence of brighter tones. Drag until the Highlights 
slider reads 100. Drag the Whites slider right until a hint of red 
clipping warning appears in the brightest area.

4Adjust the midtones
Our picture is now correctly exposed, but it lacks contrast. 
Textures such as the motion-blurred foamy water lack 

impact. This area is a mass of flat contrast midtones. To tease out 
more detail in the water, we increase the Clarity slider to +45. This 
increase in midtone contrast lightens the water and darkens the 
greyscale rocks that were hidden just under the surface, making 
them more visible.
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5Dodge the water
Use the Select Zoom Level tool to view the image at Fit In View. 
We’ve made all the selective tonal tweaks that we can using the 

Basic panel’s sliders, so it’s time to grab the more versatile Adjustment 
Brush from the toolbar. The Adjustment Brush panel will appear. Click 
to place a pin on the greyscale foamy water. Push Exposure up to +0.15. 
Set Contrast to +43. Set Highlights to +63. Boost Clarity to 60. Paint 
with a soft-edged brush over the foamy water to lighten (dodge) it.

7Burn the clouds
The distant grey clouds on the horizon are barely noticeable 
because they’re lost in hazy midtones. We can darken the grey 

clouds while boosting the contrast of their lighter surroundings to 
help them stand out. Click New (or press N) to start making a new 
adjustment. Click to place a pin on the distant clouds. Set Contrast to 
+43 and Highlights to +63. Drop Shadows to -65. Boost Clarity to +60. 
Tick Auto Mask.

6Lighten the rocks
Click the New button at the top of the Adjustment Brush 
panel. To tease out more detail and colour in the rocks, click to 

place a second pin. Set Shadows to +43 and boost Clarity to +57. Push 
Saturation up to +6. Paint over any rocks poking out of the water. The 
settings will lighten the rock’s shadows and increase their contrast, 
which helps emphasise their texture. A hint of shadow clipping will 
appear, but there's no important detail to lose in these areas.

8Use Auto Mask
Paint with a small soft brush tip along the horizon to darken 
the grey clouds and make them contrast with their lighter 

surroundings. The Auto Masks option stops the effects of the 
Adjustment Brush from straying below the distinct horizon line. 
Turn on Show Mask to see which areas are being adjusted and which 
are being left untouched by this particular pin. We’ll look at Auto 
mask in more detail in the next chapter.  
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4Fine-tune the effect
By remapping the brightest highlights from a bright 
255 to a dark 0, you've turned them black. For a more 

striking contrast, drag the central control point upwards so it 
has an Input of 128 and a brighter Output of 255. In the Basic 
panel, drop Blacks to -50 for a darker background.  

3 Invert the highlights
Click the Tone Curve panel and then click the Point 
Curve tab. Click to place a control point on the middle 

of the linear diagonal line at an input and output value of 128. 
Click the highlight control point at the top right of the line 
and drag it down to an Output of 0 to create a curve.

2 Increase the contrast
Go to the Basic panel. Pop Exposure up to +0.20. 
Increase Contrast to +22. Boost the Highlights slider 

to +70 to make the lightest skin tones stand out against the 
darker background. For darker contrasting shadows, drop 
Blacks to -30. Drop Clarity to -20 to smooth the skin.

1Desaturate the image
Kick off this project by going to the HSL/Grayscale 
panel and clicking the Convert to Grayscale box. Tick 

the Auto button to help create a little more contrast in 
your image. In this instance, we pushed Oranges up to +14 
to lighten the skin a little.

T
hroughout this chapter we’ve demonstrated how 
to remap your photographs’ tones to reveal detail 
where it’s needed, including using the Tone Curve 
panel to selectively adjust shadows, midtones and 

highlights. You can also use the Tone Curve panel to emulate 
the darkroom-based solarisation technique made famous by 
surrealist photographers such as Man Ray. This developing 
technique harks back as far back as 1920s. At first glance, 
a solarised photo may look like a negative version of a mono 

image. However, in a negative all the shadows and highlights 
are reversed so that blacks become white and vice versa. In 
solarised images, only some of the tones are reversed. 
Another distinctive property of a solarised photo is the sharp 
white line that appears around high-contrast areas.

The solarisation effect was discovered by accident and is 
tricky to produce in a traditional darkroom. By combining 
the Camera Raw Basic sliders with the Point Curve, you can 
create a solarised image with ease.

The solarised look
Harness the power of the Tone Curve panel to mimic 
a traditional darkroom image-processing technique

See p194 to  
find out more

Free  
assets!  
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Improve 
colour
Sensitively enhance the colour rendition in your photos 
and add extra interest with creative special effects

106 Create spot-colour 
special effects
Isolate and preserve the colour of 

a specific element in a monochrome conversion for 
a stylish creative effect

108 Selectively adjust 
colour saturation
Use the HSL sliders in Camera 

Raw to target and tweak the saturation of specific 
colours to make them pop!

110 Enhance colours 
in portraits
Use the Vibrance slider to enhance 

weaker colours in a portrait without over-
saturating the skin tones of the subject

112 Re-create the                 
cross-processed look
Target and tweak the tone curves 

of individual colour channels to get a creative 
cross-processed effect
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2Restore selective colours
Grab the Targeted Adjustment tool from the tool bar. 
Because we’re working with the Saturation panel, this 

tool will automatically be set to target and adjust saturation. 
We click parts of the fly and drag upwards to restore colour to 
the sampled sections.

1Desaturate the image
Open our starting image. Click the HSL/Grayscale tab. 
Normally, we’d create a monochrome image by clicking 

the Convert to Grayscale box, but to preserve traces of colour 
we need to desaturate the image manually. Click the 
Saturation panel and drag all the sliders down to -100.

O
ne way to draw the eye to a specific subject in a 
photograph is to preserve that object’s colour 
information while converting the rest of the 
image’s tones to monochrome. This spot colour 

technique might be considered by some to be a bit tacky, but 
for others it’s a popular creative processing technique that’s 
fun to indulge in. For example, you can’t wander through a 
London street without seeing spot-colour postcards that 
feature iconic red buses against a monochrome backdrop.

The HSL panel enables you to target and tweak a 
photograph’s colour strength (Saturation) and brightness 
(Luminance), so you can enhance a landscape’s drab sunset 
by endowing it with more vibrant reds and oranges, while 
lightening the tones of under-exposed green hills to make 
them more prominent. In this creative walkthrough we’ll 
use these HSL controls to selectively desaturate all the 
colours in our starting image except for those of the fly. 
We’ll show you how to customise the selective slider-based 
colour adjustments by applying desaturating strokes via 
the Adjustment Brush. This enables you to restrict specific 
colours to the main subject (in this case the fly) while 
removing traces of the same colours from the background.

Make spot 
colour effects
Isolate and preserve the colour of a specific element in a 
monochrome conversion for a stylish creative effect

BEFORE

See p194 to  
find out more
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4Desaturate background colours
Once most of the fly’s colours have been restored, we 
grab the Adjustment Brush. In the Adjustment Brush 

panel, we set the Saturation slider to -100. Set Size to 8 and 
choose a Feather of 45. Set Flow and Density to 100. Paint to 
remove unwanted traces of background colour.  

3Boost the greens
As we sample and drag the cursor, similar colours in 
the rest of the frame will become saturated too, such 

as the green stems. We’ll restore these to mono in the next 
step. Avoid increasing the strength of the yellows to keep the 
flower looking monochrome.
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4Adjust the Hue
To make colours stand out even more, click the Hue 
tab and set the Blues Hue to -23. This creates a colder 

blue that contrasts with the warm skin. Drag the Purples 
slider to -52. This makes the glasses look more blue, so the 
warmer paint specks are more noticeable.  

3Tweak the skin tones
Boost the Blues slider to +44 to make the blues stand 
out more effectively. To contrast the colourful paint 

specks with the subject’s skin, we drop Oranges down to -21. 
This also creates more natural-looking skin tones, and stops 
the shadows from looking too orange.

2Make selective adjustments
Some of the skin tones in the shadows look too orange, 
so we drop Vibrance to 0. For greater control over 

saturation, click the HSL/Grayscale panel icon. Click the 
Saturation tab. We drag the Purples slider up to +34 to give 
her glasses more impact. We tease out green blobs of paint by 
dragging the Greens slider up to +47.

1Adjust Vibrance
Open the starting image in Camera Raw. Our portrait is 
packed full of colours. Experiment by dragging Saturation 

up to +50. Here, the paint specks look more vibrant, but 
the skin looks too orange. We reset Saturation to 0 and drag 
Vibrance to +50. The paint and glasses look more saturated, 
while the skin looks less orange.

T
he colours that you see onscreen don’t always look 
the same when you print your picture. This is 
because your computer’s display creates millions 
of colours by mixing the red, green and blue 

channels together while your printer combines cyan, 
magenta, yellow and black ink to create fewer colours. If you 
boost the saturation of a photo to create more vibrant 
colours, you might make weaker colours look stronger, but 
you’ll over-saturate the more vibrant colours and make them 

unprintable. You also risk making skin tones look too orange. 
You can make selective colour adjustments to a photo using 
the Vibrance slider. This selectively boosts the saturation of 
weaker colours without over-saturating stronger ones. 
Vibrance also leaves skin tones alone. 

Vibrance is biased towards boosting typical landscape 
colours such as blues and greens. If you need to boost the 
saturation of other colours then you need the services of the 
HSL panel and its colour-specific sliders.

Adjust colours
Use the HSL sliders in Camera Raw to target and tweak 
the saturation of specific colours to make them pop!

See p194 to  
find out more
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2Boost the Saturation
Here, the woman’s face looks a little bright, so drag 
Highlights to -41 to reveal more detail. By boosting the 

Saturation slider to +43 we can reveal more blues in the 
railings and enhance the greens of the plants, but this causes 
the subjects’ skin tones to look too warm and orange.

1Open the image
In Bridge, right click the thumbnail of our practice image 
and choose Open in Camera Raw from the context-

sensitive pop-up menu. Or choose File>Open in Photoshop 
and browse to the shot. Choose Open. The digital negative 
format image will open in Camera Raw.

W
hen you shoot a JPEG your camera will apply 
colour presets directly to the image. This can 
make your photographs look too vibrant, or they 
may look rather drab depending on the preset that 

you assigned using the camera’s menu options. Settings such 
as Portrait are good for producing natural-looking skin tones, 
whereas a Vivid mode might make skin tones look too 
orange. By shooting in the raw format you can process your 
images in Camera Raw and get the colours looking just the 
way you want. This gives you the power to improve on 
disappointing results produced by in-camera presets. After 
removing colour casts using tools such as White Balance 
presets or the White Balance tool, you can adjust the 
saturation of the photo’s colours to give them more impact, 
and draw the eye to specific objects in the frame.

The Saturation slider in the Basic panel enables you 
to boost the colour saturation by an equal amount. This 
provides a quick way of creating a more vividly coloured 
image, but it can over-saturate skin tones. Some colours 
(such as blues) don’t print very accurately if they are too 
saturated, so we’ll show you how to make selective colour 
saturation boosts with this example.

Enhance colours 
in portraits
Use the Vibrance slider to enhance weaker colours 
in a portrait without over-saturating the skin tones

BEFORE
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4Tweak the Saturation
Due to its bias towards altering natural colours such as 
blues and greens, the Vibrance slider is great for 

enhancing the colour in typical landscape photos. After 
boosting Vibrance, we tweak the global colour strength by 
increasing Saturation to a more subtle +14.  

3Boost the Vibrance
Drop the Saturation slider down to 0 for the moment. 
By increasing the value of the Vibrance slider we can 

selectively boost the saturation of the weaker blues and 
greens while leaving the skin tones as they are. This avoids 
producing a print featuring an orange-looking couple.
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2Tint the blues
We click the middle of the diagonal curve to place a 
control point. The point’s Input and Output values 

reads 128 each. We click the cursor on the lower half of the 
curve where the Input is 64 and drag the point upwards to 
create an output value of 14. This adds a cyan tint.

1Choose a channel
Open up the image in Camera Raw. Click the Tone Curve 
panel and then click the Point Curve tab. By default 

you’ll see a curve that controls the RGB channels at the same 
time. To target a specific colour channel, click the Channel 
drop-down menu and choose Blue.

A
photograph’s colours are created by mixing the 
red, green and blue colour channels together. By 
targeting and tweaking points on a particular 
channel’s tone curve you can produce dramatic 

changes in hue. This provides an effective way to create a 
cross-processed look. The term cross-processing refers to a 
developing technique used in chemical darkrooms. It involved 
deliberately developing print negatives using chemicals that 
were designed for use with slide film (or visa versa). The use 
of incorrect chemicals resulted in a shift in colour hue, 
leading to stylised and eye-catching images. Cross-processed 
blues often took on a green hue, for example, while a shot’s 
shadows might feature a hint of magenta.

This developing process (or at least the look that the 
traditional cross-processing technique produced) is 
still popular, especially with fine art, fashion and stock 
photographers who want their work to stand out from the 
crowd. In the days of the traditional darkroom, the results 
could be a bit hit or miss, so you had to experiment to try 
to get the desired shifts in colour and tone. By tweaking the 
tone curve of individual colour channels, you can replicate 
almost any chemical combination you might desire.

Get the cross  
processed look
Target and tweak the tone curves of individual colour 
channels to get a creative cross-processed effect
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4Tint the shadows
On the Green curve, we set an anchor point at an Input 
and Output of 128 and place a new point at an Input of 

63 and drag it to a lower Output of 53. This adds a magenta 
hue to the photo’s shadows. We now have cross-processed 
cyan blues and magenta tinted shadows.  

3Adjust the reds
We set the drop-down menu to Red and place a point 
at an Input and Output value of 128. This central 

anchor point allows you to target tones on one side of the 
point without altering tones on the other. We drag another 
point to an Input of 192 and an Output of 175.
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Selective 
adjustments
Discover how to isolate particular parts of a photo 
so you can make localised image adjustments

116 The Adjustment 
Brush tool
Lighten or darken specific regions 

of an image using the Adjustment Brush tool in 
Camera Raw

120 Enhance plain- 
looking skies
Fix dull-looking over-exposed 

skies by applying a gradated tonal adjustment 
using the Graduated Filter tool

122 Mask areas for 
selective edits
Discover how to make selective 

adjustments more accurately using Adjustment 
Brush masks

126 Make selective white 
balance adjustments
Warm up or cool down the colours 

in specific areas of a photo to remove localised 
colour casts

128 Focus attention 
on your subject
Use the Radial filter to reduce the 

impact of detail around the edges of your subject 
to make it stand out
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W
hen shooting in mixed lighting conditions it can 
be a challenge to capture an even exposure that 
features detail throughout the entire tonal range. 
In the location featured in our starting image we 

were faced with a bright sky and a patch of hill that was 
being directly illuminated by the sun. The rest of the hilly 
location was plunged into shadow. By setting the camera to 
its manual metering mode, we were able to capture detail in 
the sunlit section of the hill. It makes sense to prioritise 
capturing highlight detail because it’s harder to recover than 
under-exposed shadows. We used a narrow aperture setting 
so we could shoot in daylight with a slow shutter speed and 
turn the moving water into foam. This narrow aperture also 
contributed towards our under-exposed shadows.

Despite carefully setting up the camera, the unprocessed 
image looks disappointing. It lacks strong highlights and the 
shadows are hiding the main point of interest – the foamy 
water. However, because this is a raw file we can process it in 
Camera Raw and reveal colour and detail where it’s required. 
As the name ‘digital negative’ suggests, our DNG format 
image needs to be processed in the digital darkroom before it 
can look its best.

In traditional film darkrooms, photographers could use 
dodge and burn tools to vary the amount of light hitting 
the photo paper. This enabled them to make selective tonal 
adjustments to specific parts of high-contrast scenes. We’ll 
perform a similar technique using the versatile Camera Raw 
Adjustment Brush tool.

The power of the 
Adjustment Brush
Lighten or darken specific regions of an image 
using the Adjustment Brush tool in Camera Raw

See p194 to  
find out more
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1Open the image
Before making selective brush-based adjustments to specific 
tonal regions in our demonstration image, it makes sense to 

use the tone-targeting powers of the various sliders in the Basic 
panel to fix as many problems as we can, because these enable 
you to alter large areas quickly and easily, and the image needs 
quite a bit of work to really demonstrate the full power of the 
Adjustment Brush.

3Recover the highlights
We can see from the healthy spread of tones in the Histogram 
that the brightened highlights aren’t technically clipped, but 

some of the colour and details are now missing from the sky. By 
dragging the Highlights slider left to -80 we can claw back missing 
detail and colour in the sky without darkening the newly revealed 
shadow details in the landscape. Pull Whites down to -40 to gently 
darken the brightest pixels in the picture.

2Boost the exposure
Normally, we might start processing a picture by fixing any 
colour balance problems, but because the image is under-

exposed we can’t clearly see the colours in the shaded areas. So with 
this type of under-exposed image, we’ll start by making a global tonal 
adjustment and drag the Exposure slider right to +1.40. This operation 
reveals more shadow detail, but it blows out detail in the highlights of 
the sky and the sunlit section on the hill.

4Lighten the shadows
Lighten the darkest shadows by dragging Blacks to +50. Press 
Q to cycle between the before-and-after versions of the raw 

file. Our selective tone-tweaking sliders have improved the shot 
as best they can. We can see more detail in the shadows and we’ve 
persevered most of the highlights. However, the sky and the water 
lack contrast and look flat. We can use the Adjustment Brush to 
selectively adjust the contrast in these areas.
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5Set up the adjustment properties
Press Q until only the edited version of the image is visible. 
Grab the Adjustment Brush from the toolbar (or press K 

to summon it). The Adjustment Brush panel will appear. Click to 
place a pin on the shaded hill. We’re going to selectively lighten 
the shaded areas, so set the Exposure slider to +1.20. To produce 
a stronger contrast, set Contrast to +74 and Clarity to +57. Push 
Sharpness to +21.

7Non-destructive editing
The Adjustment Brush is a non-destructive tool, so we can click 
a particular pin to access its slider settings and fine-tune them. 

The water is a little too bright, so drag Exposure down to +0.95 and 
reduce Highlights to -22. To bring out fine textures in the sky, we click 
the New button (or press N) and then click to place a pin on the sky. 
At this stage it will use the previous slider settings, so we’ll need to 
change them to more suitable ones.

6Reveal more shadow detail
To control the spread of the localised brush-based adjustment, 
we set Size to 12. Create a soft edge to help blend the edited 

areas with their un-edited neighbours by choosing a Feather of 80. We 
paint over the shaded hill and river to lighten these areas and boost 
their contrast. We have to be careful not to paint on the sunlit section 
of hill or we’ll over-expose it. We now have a more evenly balanced 
exposure, and we can see more detail in the shadows.

8Enhance the sky
We set the new pin’s Exposure to +0.50, Contrast to +0.74 
and Highlights to -43. To darken some of the greyer clouds 

set Shadows to -35. Tease out more fine midtone texture and 
detail in the clouds by setting Clarity to +57. Give the weak blues 
more impact by setting Saturation to +45. We can use the same 
Size settings to cover large areas quickly. We paint over the sky to 
selectively reveal more texture and detail.  
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O
n a bright day your camera can struggle to capture 
detail in contrasting lighting conditions. You could 
pop a neutral density filter over the lens to limit 
the amount of light hitting the sensor at the top of 

the frame. This physical filter enables you to set the camera’s 
aperture and shutter speed to reveal darker details in the lower 
section of the frame without over-exposing the brighter sky 
detail near the top. If you don’t have an ND filter, you can 
recreate the effects of one in Camera raw, courtesy of the 
Graduated Filter tool. In many shots you’ll see an overcast sky 
that appears to contain little detail. If you drag the Exposure 

to the left you’ll notice that there’s more cloud texture and 
colour hidden in the raw file’s sky. However, this global 
exposure adjustment will plunge your correctly exposed 
landscape into darkness. The Graduated Filter tool enables 
you to drop the exposure value at the top of the frame by a 
desired f-stop or two. It gradually reduces the strength of the 
exposure adjustment so that the brighter areas in the sky 
blend seamlessly with the correctly exposed landscape. As you 
can apply multiple Graduated Filters to the image, you can also 
selectively adjust blown-out sky reflections in the lower part 
of the frame, as you’ll see in our walkthrough.

Enhance 
plain-looking skies
Fix dull-looking over-exposed skies by applying a gradated 
tonal adjustment using the Graduated Filter tool

BEFORE
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2   Make exposure adjustments
Drag the Exposure slider to -1.60. By dropping the 
Exposure, you reveal a hint of sky detail, but the 

land is still looking too dark. Reveal more detail in the 
land by dragging the Shadows slider to +53. The trees now 
look better exposed.

1 Warm it up
Before making gradated adjustments to reveal sky detail, 
let’s get the over-exposed darker terrain in our example 

image looking its best using the Basic panel sliders. The 
gradated sky adjustments will then blend with the correctly 
exposed land. Drag Temperature to 5800.

4 Boost the colours
Our starting image’s colours look drab, but there are 
colours hiding in the raw file that we can reveal. Boost 

Vibrance up to +47 to enhance the natural blues and greens. 
Increase Saturation to +27 to perform a global colour boost. 
The stronger saturation reveals extra textures.

3 Adjust the Clarity
To make the darker trees stand out more effectively 
against the lighter mountain, drag Clarity right to +33. 

This gentle midtone contrast adjustment makes the trees 
slightly darker so they pop out in contrast. It also gives the 
fine cloud textures more impact.

6Fix the reflection
Set Clarity to 40 to tease out cloud detail. Click the 
New button in the Graduated Filter panel. Draw a 

second gradient from the bottom of the frame to the horizon. 
Set Exposure to -1.5 to get a balanced reflection. Boost 
Saturation to +20 to reveal more cloud colour.  

5 Draw a gradient
Grab the Graduated Filter from the toolbar. In the 
Graduated Filter panel, set Exposure to -1.30. Drag 

from the top of the frame down to the horizon to draw a 
gradient. The exposure adjustment will be strongest near the 
top green line, and will gradually drop to 0 by the red line.



Teach yourself Raw in Photoshop
Selective adjuStmentS

122

BEFORE

See p194 to  
find out more

Free  
assets!  



Teach yourself Raw in Photoshop
Selective adjuStmentS

123

Selective adjuStmentS

T  here are many ways to make selective 
adjustments in Camera Raw. Sliders such as 
Shadow or Highlight enable you to target and 
tweak similar tones in every part of the image at 

once. The Vibrance slider performs selective colour 
enhancements. It can boost the saturation of weaker colours 
without over-saturating stronger ones (and avoid causing 
skin tones to become too warm and orange). The White 
Balance tool finds and removes colour casts with a click. 
All these tools have their own unique selective adjustment 
role, and working together they can dramatically improve 
the colours and tones in a raw file.

The Adjustment Brush is arguably the most versatile 
selective adjustment tool in Camera Raw. Thank to the 
Adjustment Brush panel, you can change the properties that 

it selectively adjusts. We’ll show you how to use a negative 
Clarity value to create a smoother skin complexion, and 
then use the same tool to enhance lips. Unlike sliders such 
as Shadow or Highlights, the Adjustment Brush can be 
modified to edit other properties, such as the colours, tones 
and clarity of specific regions.

To help restrict the Adjustment Brush’s influence to 
particular pixels, you can use masking. Masks appear as 
a colour overlay to help you identify precisely which 
areas are being adjusted. You can then use the mask to 
fine-tune the spread of the adjustment. Thanks to the 
Auto Mask option, you can stop the Adjustment Brush 
tip from straying over a contrasting edge, which enables 
you to quickly smooth skin without accidentally blurring 
important facial features such as an eye.

Mask areas for 
selective edits
Discover how to make selective adjustments more 
accurately using Adjustment Brush masks
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1Analyse the problems
Before we begin by selectively smoothing the model’s skin and 
whitening her eyes with the Adjustment Brush, let’s make some 

more global adjustments to correct overall colour and tone. The photo 
has a warm, greenish tint that doesn’t really flatter the subject. From 
the peaking graph at the right of the Histogram, we can see that the 
highlights are too bright. The image lacks strong shadows on the left 
of the graph.

3Correct the exposure
As the photo is a little over-exposed, drop the Exposure slider 
to -0.15. Reduce Highlights to -21. For more contrast, drop 

the Blacks slider to -17. The Histogram now shows a wider spread of 
tones. After clicking the Before and After view we can see that the 
colours in the edited version now look more natural compared with 
the unprocessed original. We’re now ready to make more selective 
adjustments to improve the subject’s complexion.

2Correct the colours
Before adjusting any tone-related sliders, let’s remove 
the slight colour cast and create healthier looking skin 

tones. Grab the White Balance tool. Click an area that should be 
white (such as the whites of the model’s eyes). This will adjust 
the Temperature and Tint sliders to create a neutral white in the 
sampled area, creating tint-free colours in the rest of the image 
at the same time.

4Set up the Adjustment Brush
We go back to Single View, zooming in to 33% for a closer 
look at the subject’s skin. Grab the Adjustment Brush (or 

press K to summon it). In the Adjustment Brush panel, set Clarity 
to -58. Boost Saturation to +15 to add more colour to the model’s 
cheeks. Untick the Auto Mask box. Click to place a pin on her 
cheek. Paint over the cheek to smooth the pores. Avoid painting 
over important details such as the eyes.
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5Modify the mask
In the Adjustment Brush panel, tick the Show Mask box. 
A translucent white patch will appear, indicating which areas 

we have adjusted. This white mask has a soft edge, so it could easily 
stray into other areas such as the model’s hair, which we want to 
remain as sharp as possible. Tick the Erase button and paint over 
areas that you don’t want to smooth. The mask will change shape to 
show the newly adjusted areas.

7Use Auto Mask
To make the Adjustment Brush’s mask more sensitive to 
changes in contrast, tick the Auto Mask box, clicking the pin 

we placed earlier. Continue painting over the skin. Click the Add 
button at the top of the Adjustment Brush panel. As we paint, the 
brush will recognise contrasting edge details such as the lips and 
eyes and avoid softening them. The more intelligent mask will have 
a sharper edge to it.

6Change the mask colour
The default white mask colour can be hard to spot if you’re 
working on white areas such as eyes. Click the Color Swatch 

next to Show Mask. Choose a contrasting colour from the Color 
Picker. We chose this luminous green. Click OK. We can change the 
mask Opacity to make it more noticeable, but it helps to see some of 
the original details through the mask, so leave this Opacity slider at 
its default setting.

8Enhance the lips
To see the smoothing affect of the Adjustment Brush 
on the skin, untick Show Mask. Click the New button. 

Boost the Saturation slider to +35. Push Temperature and Tint 
to a warmer +25. Set Clarity to -10. Paint on the model’s lips 
to give them more impact. The Auto Mask option will stop 
adjacent areas such as the model’s teeth from being altered by 
this selective adjustment.  
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N
ormally, white balance problems are easy to fix. 
If a shot suffers from a cold blue (or warm orange) 
colour cast, then you can drag the Basic panel’s 
Temperature slider to counteract the tint by 

warming up the image or cooling it down until the colours 
look more natural. If the scene is cloudy or sunny then you 
can experiment with various White Balance presets to remove 
blue or orange colour casts.

However, in our supplied starting image we have a scene 
featuring contrasting colours and lighting conditions. The 
orange sunset contrasts with the cold blue sea. Due to the 

mix of clear sky and clouds, some of the ocean’s colours are 
neutral, and don’t suffer from the blue colour cast that’s 
noticeable in the shaded foreground. If we warm up the 
photo’s colour temperature to remove the foreground blues, 
then the correct colours in the more distant part of the ocean 
will look too warm. In this walkthrough we’ll show you how 
to use the Color Sampler tool to help identify areas of the 
image that are suffering from colour casts, and which areas 
that are tint-free. You’ll then know which areas to selectively 
warm up and cool down. To make the selective white balance 
adjustments we’ll use the Graduated and Radial Filters.

Selective white 
balance editing
Warm up or cool down the colours in specific areas 
of a photo to remove localised colour casts

BEFORE
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2  Sample a colder spot
We click to sample a colder blue part of the ocean in 
the foreground. This creates sample number 2. In our 

example we’ve sampled an area with RGB values of 107, 131 
and 153. The numbers are much farther apart, indicating that 
this second sampled area has a colour cast.

1 Take a neutral sample
Open our starter image and grab the Color Sampler tool 
from the toolbar. Click the cursor on a section of sea 

that looks close to a neutral white. We’ve sampled an area 
that has RGB values of 152, 157 and 154. If the area was totally 
tint-free then the RGB values would be identical.

4 Analyse the RGB values
Although sample 2’s RGB values are now balanced and 
tint-free, sample 1’s values are wider apart at 175, 157, 

and 139. This indicates the presence of a colour cast in our 
previously neutral area. We need to selectively warm up the 
cold foreground without making the ocean look too orange.

3 Adjust the temperature
Grab the White Balance tool. Click the colder sample 
2 icon. This tool will sample the RGB values, work 

out that there’s a colour cast and then adjust the values so 
that they are equal. This creates a tint-free colour in similar 
shaded sections of the sea.

6Add a radial gradient
To selectively colour correct smaller sections such as 
the cold blue patch of sea on the right, we need the 

Radial Filter. In the Radial Filter panel, tick the Inside button. 
Draw an ellipse. Push Feather to 68. Tweak the Temperature 
values to create a neutral colour inside the ellipse.  

5 Draw a linear gradient
Set the White Balance drop-down menu to As 
Shot. Grab the Graduated Filter. Drag a diagonal 

line from the bottom left towards the middle of the frame. 
Drag the green start point to create a narrower gradient. Set 
Temperature to +59 and Tint to +16.
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4Fine-tune the shape and size
To use the Crop tool to remove some of the empty 
space around our subject, we need to reposition and 

resize the Radial Filter to suit the new composition. The 
alternative Post Crop Vignette will automatically reapply the 
vignette to the recomposed image. 

3Modify the effect
To create cool vignetted edges that contrast with the 
subject, we drop the Temperature slider to -50 and 

push Highlights up to +64 to help over-expose the highlights 
in the vignetted area. To reduce distracting detail outside the 
Radial Filter’s ellipse, drop the Clarity slider to -100.

2Draw an ellipse
In the Radial Filter panel, we set Exposure to +1.40 to 
lighten the edges. To make the Radial Filter alter 

details outside the ellipse, we tick the Outside button at the 
bottom of the panel. Draw an elliptical shape that centres on 
the woman. Drag the filter’s control points to refine its shape.

1Correct the colour and tone
We start by setting the White Balance drop-down menu 
to Auto to quickly cool down the orange colour cast and 

create more natural-looking skin tones. The shot is 
a little lacking in shadows so we set Exposure to -30, Con-
trast to +27 and Blacks to -28, then grab the Radial Filter.

I
n Camera Raw you can deliberately darken (or 
lighten) the edges of your images. By adding 
vignette effects you can reduce the impact of 
details around the edges of the frame and draw 

attention to the central subject. If your main subject is 
framed in the centre of the photo, then you can use the 
Effects panel’s Post Crop Vignette sliders to lighten or darken 
the image’s edges. If the subject is off-centre then the Radial 
Filter can be used to produce a similar but off-set vignette 

effect. Unlike the Post Crop Vignette tool, the Radial Filter 
enables you to edit extra properties such as colour 
temperature, so you can create cooler edges that contrast 
with the subject’s warmer palette.

In this tutorial we’ll demonstrate how to use the Radial 
Filter to brighten the edges in a way that complements 
the photo’s sunny location, creating an abstract high-key 
background that helps to focus attention on the correctly 
exposed woman in the lower part of the frame.

Focus attention
Use the Radial filter to reduce the impact of detail around 
the edges of your subjects to make them stand out

See p194 to  
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Get the look
Discover how to transform your photos using 
Camera Raw’s creative image-processing tools

132 Convert your photos 
to black and white
Create stunning black-and-white 

pictures using the Grayscale Mix panel to lighten 
or darken specific colours

136 Apply the split-tone 
effect to your monos
Add separate washes of colour 

to the highlights and shadows of a monochrome 
conversion to replicate the split-tone effect

138 Reveal fine detail 
using Clarity
Discover how to boost midtone 

contrast and give distant details in landscape 
images more impact

140 Create high dynamic 
range images
Discover how to combine several 

exposures into a single, highly detailed image using 
Camera Raw’s powerful HDR Merge feature

144 Create a landscape 
panorama
Use Camera Raw’s Merge 

Panorama command to combine several frames 
into one single stunning vista
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2Convert to grayscale
We boost the Vibrance slider to +35 to reveal more 
colours in the shadows. Click the HSL/Grayscale panel 

and tick the Convert to Grayscale box. This gives us a black-
and-white version of the correctly exposed image. Click Auto 
to make the colour sliders lighten or darken particular areas.

1 Tweak the tones
Before converting our image to monochrome you’ll need 
to create a well-exposed shot and tease out the colour 

information so that you can use it to lighten or darken areas 
later on. In this example we start by dragging Shadows to 
+70, then we set Clarity to +30 for more midtone contrast.

I
n pre-digital days photographers would shoot 
with black-and-white film. By placing coloured 
filters over the lens they could lighten or 
darken greyscale tones in the captured image 

based on the original colours. For example, a red filter 
would darken blue skies, enabling white clouds to stand 
out more clearly in contrast.

You could create a black-and-white version of a scene 
in Camera Raw by dragging the Basic panel’s Saturation 
slider down to 0. Although this technique would remove 
all of the colour information, you’d probably end up with 
an indistinct wash of greyscale tones. Camera Raw enables 
you to mimic the traditional colour filter technique so that 
you can lighten or darken specific colours.

We’ll demonstrate how to use the Convert to Grayscale 
panel to remove the distracting colour information, and 
then adjust the colour sliders to lighten or darken specific 
regions in the scene. This technique enables you to 
produce mono conversions that draw attention to specific 
shapes and textures in a photo.

Convert your 
photos to mono
Create stunning black-and-white pictures using the 
Grayscale Mix panel to lighten or darken specific colours
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4Target an adjustment
If you’re not sure what colour to tweak, grab the 
Targeted Adjustment tool. We click the water and 

drag upwards to lighten any colours in the sampled area. This 
brightens the Blues and helps make the water in the mono 
conversion stand out in contrast against the darker rocks.

3Lighten the yellows
Click default to reset the sliders to 0. We can manually 
adjust the sliders to lighten specify areas and create 

more contrast where it’s needed. There’s lots of vegetation in 
this scene, and this tends to contain yellow. Drag the Yellow 
slider right to lighten any vegetation and reveal its texture.
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By experimenting with the Convert to Grayscale panel’s 
coloured sliders you can produce a range of different 
looking monochrome prints from a single shot. This 
enables you to draw attention to various areas in the 
image and decide which look you prefer. These sliders 
work best with shots that have lots of different colours 
to play with, such as the colourful car in the image 
below. Here the Grayscale Mix sliders are set to the 

default of 0, so the conversion lacks contrast [1]. 
By clicking Auto, the results aren’t much different 
[2]. By manually increasing the Yellows to +68 and 
the Greens to +69 you can lighten the vegetation and 
make the darker car stand out more effectively [3]. You 
can create an even more striking contrast by selectively 
darkening the car’s paintwork  [4]. To do so, set the 
Oranges slider to -38 and the Reds to -71. 

1

3

2

4
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4Fine-tune the results 
Set the Shadows Hue to a cooler 224 to create a 
contrasting wash of blue. Set Balance to -52 to tint a 

wider range of shadows and midtones. We can then play with 
different saturation values until we achieve the desired split-
tone look. We finish off by adding a post-crop vignette.  

3Tint the tones
Crop the image using a 1:1 ratio. Click the Split 
Toning panel’s tab. Boost the saturation of the 

Shadows and Highlights to 20. By default both the shadows 
and highlights will be tinted red. We then set the Highlights 
Hue to 60 for a wash of sepia.

2Convert to monochrome
Click the HSL/Grayscale panel. Tick the Convert to 
Grayscale box. We click Auto to let Camera Raw produce 

a mono conversion based on the colours in the original shot. 
To create more contrast between the goat’s darker fur and its 
white markings, drag the Orange slider left to -46.

1Correct the exposure
Our unprocessed demonstration image is very under-
exposed, so we boost the Exposure slider to 2.25 to 

reveal more detail and create a healthier spread of tones in the 
Histogram. Boost Highlights to +84 and Whites to +42. Push 
Clarity to +55 to reveal fine hair detail.

A
traditional way of creating an eye-catching scene 
is to remove the photograph’s original colour 
information. This helps the eye focus on tonally 
contrasting shapes and textures in the scene 

instead of being distracted by colour. You can enhance your 
monochrome conversions by gently reintroducing fine 
washes of colour to the greyscale image’s shadows and 
highlights. A hint of colour can make a monochrome shot 
look more interesting. The split-toning effect also helps 

change the mood evoked by the image. In the split-toned 
image on the right, the goat’s shadows feature a cool blue tint 
while the lighter highlights of the animal’s fur are tinted with 
a warmer wash of sepia. These contrasting cool and warm 
colours help tease out the different textures in the image.

Before adding a split-toned look to your image, you’ll 
need to make sure that there’s enough contrast between the 
shadows and highlights to add colours to, so we’ll kick off by 
adjusting the image using the Basic panel.

Split-tone  
your images
Add separate washes of colour to the highlights and shadows 
of a monochrome conversion to replicate the split-tone effect
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2 Increase Clarity
Our histogram now has tones stretching from the 
shadows on the left to the highlights on the right. 

This indicates that the picture is now better exposed. By 
increasing the Clarity slider to +80, we increase midtone 
contrast and make fine textures and details pop out.

1Adjust the exposure
We can see from the histogram that our demonstration 
image lacks strong highlight information, so it is under-

exposed. We need to drag Exposure to +0.40 to brighten 
everything up and boost the Highlights to +89 to selectively 
brighten them.

W
hen shooting a landscape, water particles in the 
air can cause details to become diffused. Closer 
objects will have a stronger contrast because 
there’s less moisture between them and your 

camera, while more distant objects may lack contrast. The 
most distant hills in our starting image nearly disappear 
into the clouds due to their washed-out midtones. If we 
boost the Camera Raw Contrast slider to try to darken the 
distant hills then we’d risk making the already darker 
foreground shadows under-exposed while blowing out the 
brighter highlights in the sky.

You can target and tweak the washed-out midtones in 
the distant mountains without altering the photo’s darker 
shadows and brighter highlights, courtesy of the Clarity 
slider. This enables us to selectively increase the midtone 
contrast and counteract the effects of the diffuse lighting 
in the most distant parts of the background. As a bonus, 
the Clarity slider also increases the midtone contrast in 
other areas, which helps fine textures stand out more 
effectively in our starting image’s rocks and water. 
You can also make brush-based Clarity adjustments 
to target areas with more precision.

Reveal fine detail 
using Clarity
Discover how to boost midtone contrast and give 
distant details in landscape images more impact

BEFORE
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4Apply selective adjustments   
In the Adjustment Brush panel, we set Exposure to 
-0.15, Contrast to +54 and Clarity to +100. We click to 

place a pin on the distant hill and paint to selectively boost 
the midtone contrast and click the Zoom tool to exit the 
Adjustment Brush panel. Boost Vibrance to +45.  

3Select the Adjustment Brush
The increased Clarity setting creates more contrast 
between the white foam and the green sea, but the 

distant hills still look a bit washed out. To make a localised 
Clarity adjustment that gives the hills more impact, we grab 
the Adjustment Brush from the Camera Raw toolbar.
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C
amera Raw’s great HDR feature enables 
you to merge several different 
exposures into one, enabling a high 
dynamic range with detail in the 

brightest highlights and darkest shadows (which 
makes the feature particularly useful for high-
contrast landscapes and interiors). Best of all, it 
then creates a merged DNG raw file packed with 
tonal information.

Understandably, the feature isn’t as in-depth 
as dedicated HDR software such as Photomatix 
or Nik’s HDR Efex Pro, or even Photoshop’s 
own Merge to HDR command. But Camera 

Raw’s approach is slightly different. It creates a 
detail-rich raw file without resulting in the over-
processed look that puts many photographers off 
HDR. As such, it’s more HDR as a utility than as a 
style, and all the better for it.

While limited, the options within the Merge 
HDR command are very effective. There’s an 
Auto-align feature, so as long as camera movement 
isn’t too severe, you can get away with merging 
hand-held sequences. There’s also a deghost 
control to fix movement within the frame, and as 
with everything in Camera Raw, the toning process 
is completely non-destructive.

Create 
HDR images
Discover how to combine several exposures into a single 
image using Camera Raw’s HDR Merge feature
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1Shoot the sequence
To create HDR images you need to start off with a sequence of 
frames, taken in alignment with a tripod if possible. Each frame 

should have a different exposure to record detail in all areas, from the 
brightest highlights to the darkest shadows. When shooting, keep 
aperture constant and adjust the shutter speed to vary the brightness.

3Make colour tweaks
With all the frames selected, you can now make adjustments 
using the settings on the right to tweak them all at once. We 

don’t want to make any changes to exposure or contrast, because this 
is best done once the images are merged. But we can tweak the white 
balance if necessary. Here we brought Temp to 4500.

2Select all the images
Go to your images in Bridge and shift-click between the first 
and last frame to select them all, then right click them and 

choose Open in Camera Raw. This opens all four frames into the 
Camera Raw editor. Once open, press Cmd/Ctrl+A to select all the 
images in the filmstrip.

4Start HDR Merge
Once you’re ready to make your HDR, make sure all the frames 
are still selected, then go to the little flyout menu at the top left 

of the interface (next to Filmstrip) and choose Merge to HDR. When the 
HDR dialog is open, check Auto-Align to fix the slight camera 
movement between the frames that has caused misalignment here.
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5Auto-fix the tones
Next try checking Auto-tone. The Auto-tone option will bring 
out detail in the shadows and highlights and improve the 

contrast. It does the same job as clicking Auto in the Basic panel. 
Bear in mind that this is non-destructive, so once you merge the HDR 
you can go back to the Basic panel to tweak the settings if you want to.

7Merge and adjust
Click Merge and you get the option to save your new HDR 
image. It will go in the same folder as your originals. Camera 

Raw creates a new raw DNG file with the suffix, hdr. Once done, 
you can then adjust the tones in the Basic panel. Note that 
Exposure now goes from -10 to +10.

6Correct any movement
The Deghost amount helps to correct any movement within the 
frame – perhaps from blowing grass, moving clouds, or in this 

case people – by taking the problematic area from a single frame rather 
than merging several. There are four deghosting strengths. We used 
Medium here.

8Make selective tweaks
It’s worth using selective adjustment tools to finish off your 
HDR by pulling detail out of different areas. Here we’ve used 

the Adjustment Brush to lighten the lower part of the image, then 
used the Radial Filter, first to add a vignette to darken the corners, 
and second to darken the centre of the image slightly. 

GET THE LOOK
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2Choose a projection
There are three projection modes to choose from: 
Spherical, Cylindrical and Perspective. Each maps out 

the frames in a different way. Spherical places them as if 
on the inside of a sphere, Cylindrical as if on the inside of a 
cylinder, and Perspective as if placed flat. Experiment with 
each. We’ve used Cylindrical here.

1Start Merge Panorama
Cmd/Ctrl-click to select all the frames in Bridge, right 
click them and choose Open in Camera Raw. Press Cmd/

Ctrl+A to select them all again. Go to the Lens Correction 
panel, click Profile and Enable Profile Corrections. Next click 
the flyout menu at the top left of the interface and choose 
Merge to Panorama.

Create a landscape 
panorama

C
amera Raw’s Merge Panorama command 
stitches several horizontal or vertical 
frames together to create a panoramic 
raw file – perfect for those times when 

your lens can’t fit everything in, or if you want to 
pack in extra detail. When shooting the frames for 
a panorama, use a tripod to keep the camera 
position fixed, and make sure the panning motion 
remains perfectly level by checking the horizon as 
you pan (a spirit level comes in handy here). Shoot 
with your camera in the vertical orientation to 
record the maximum amount of detail, and allow 
for a generous overlap between each segment.

Camera Raw’s Merge Panorama command offers 
three Projection modes that stitch the frames 
in different ways. Spherical maps the frames as 
if on the inside of a sphere. It’s ideal for very 
wide panoramas, or ones that have several rows. 
Perspective maps the segments as if they were 
on a flat surface, keeping lines straight. As such, 
it’s good for architectural or city scenes, but it 
can lead to extreme distortion and warping at the 
edges, so check them before applying. Cylindrical 
maps the frames as if on the inside of a cylinder. 
This is ideal for panoramas because distortion is 
minimal, and vertical lines stay straight.

Use Camera Raw’s Merge Panorama command to 
combine several frames into a single stunning vista
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4Enhance the panorama
When you’re happy with the settings click Merge and 
save the new image. Once back in Camera Raw you’ll 

see the new panorama. It’s a DNG raw file so you can process 
it like any other raw file. Make any changes you like with the 
Camera Raw tonal tools. Here we’ve boosted the colours and 
added a Graduated Filter to darken the sky.  

3Auto-Crop messy edges
The Auto-crop checkbox will automatically remove 
any messy edges to give you a nice, tidy rectangular 

image. It’s non-destructive and can be changed later with 
Camera Raw’s Crop tool. Try unchecking the box just to see 
what’s being cropped off. With Perspective projection mode 
here, you can see the extreme distortion at the edges.
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2Apply Merge in the background
Uncheck Auto-tone, then click Merge. There’s no need 
to enter the HDR settings every time. You can simply 

use a keyboard shortcut to run the same command on each 
segment. Cmd/Ctrl-click to select the set of exposures for 
the next segment, then press Shift+Alt+M to merge using the 
previous settings. Repeat for the rest of the segments.

1Merge an HDR
To create an HDR panorama you’ll need a range of 
exposures for each segment. Shift-click between the first 

and last image in Bridge to select the entire sequence, then 
right click and choose Open in Camera Raw. Cmd/Ctrl-click 
on the range of exposures for the first segment, then press 
Alt+M to open the HDR Merge settings.

Produce detail-rich 
HDR panoramas

I
f you want to create detail-rich 
panoramic HDRs, two of Camera Raw’s 
newest features – HDR Merge and 
Merge Panorama – make the process 

quick and easy, producing images that pack in the 
detail while remaining natural-looking. Shooting 
for HDR panoramas requires a tripod and some 
basic exposure control. Like a normal panorama, 
you need to shoot the scene in overlapping 
segments (ideally, with a vertical camera 
orientation). But rather than shooting a single 

frame for each segment, you need three frames 
taken at different exposure values. The easiest way 
to do this is to set up your camera for bracketed 
exposures. So for example, if your panorama has 
five segments to it, you’ll end up with 15 shots.

When it comes to combining the images, first 
you merge the three frames for each segment into 
a single HDR image, then you combine all the 
HDRs to make a panorama. Using handy keyboard 
shortcuts, this is quicker than you might think. 
Here’s how it works…

Use Camera Raw’s two merge commands in 
combination to make a high dynamic range panorama
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4Tease out the details
Use Camera Raw’s tonal controls to enhance the 
panorama. Use the Basic panel sliders to reveal detail 

in the highlights and shadows, and increase Clarity for the 
HDR look. Next tease out detail with the Adjustment Brush. 
Grab the Brush from the toolbar, paint over an area, then use 
the sliders to change it.  

3Merge the panorama
Once all the HDRs have been created it’s now time 
to make the panorama. Scroll down the filmstrip and 

Cmd/Ctrl-click all the HDRs to select them, then press Cmd/
Ctrl+M to open the Merge Panorama dialog box. Choose 
a projection (Cylindrical in this case), then click Merge to 
generate your new panorama.
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Creative 
effects
Enhance your images with special effects using 
advanced tools and techniques in Camera Raw

150 Create retro 
special effects
Give your digital images the filmic 

look by adding analogue photography artefacts 
using a host of techniques

154 Make stunning portraits 
using Camera Raw
Use a host of professional 

retouching tools and techniques to make your 
portraits perfect in Camera Raw

160 Turn a daytime scene 
into a night photo
Change the colour temperature 

and tones of a photo and add light effects to create 
a simulated nocturnal scene

164 Master tonality in 
your monochromes
There’s more to black and white 

than just removing the colour. Learn how to take 
control of contrast and tones in Camera Raw

166 Multi-process 
your raw files
Learn how to pull extra detail out 

of your raw files by processing them several times 
in Camera Raw
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Y
our digital camera’s various shooting modes are 
designed to help you capture a scene’s true colours 
and display detail throughout a wide range of 
tones, while keeping artefacts such as digital noise 

to a minimum. Each shot is stored digitally, so its colours and 
tones won’t fade over time, and the image will always look as 
good as new. It therefore seems ironic to distress pristine 
digital photographs and make them look like analogue film 
prints that have faded over time, as well as producing images 
that appear to have been blighted by in-camera artefacts such 
as vignetted edges and foggy light leak patches. However, 
applying retro film artefacts in Camera Raw adds character to 
your digital shots and evokes a sense of nostalgia. In this 
walkthrough we’ll reveal how to use the Effects panel to add 

realistic clumps of analogue film grain (rather than unwanted 
dots of digital noise). This is akin to adding crackle and hiss 
to a digital sound recording to conjure up a vintage vinyl 
vibe. We’ll demonstrate how to fade colours and create a 
flatter contrast. We’ll also show you how to use the 
Adjustment Brush to mimic artefacts produced by less 
sophisticated analogue lenses, such as by blurring around 
the edges of the frame.

We’ll also demonstrate how to tinker with individual 
colour channels to create the cross-processed colours that 
are associated with old film stock and darkroom processing 
techniques. After spending time creating a retro look, we’ll 
save it as a preset, so that you can apply your analogue film 
effects to other pictures with a single click.

Create retro 
special effects
Give your digital images the filmic look by adding analogue 
photography artefacts using a host of techniques

See p194 to  
find out more

Free  
assets!  
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1Cross-process the reds
Open ‘PMZ02_retro’. Click the Tone Curve panel and then 
click the Point Curve tab. Set the RGB drop-down menu to 

Red. Click to place a point in the centre of the curve at an Input 
and Output level of 128. Place a point lower down the curve with 
an input of 64 and then drag to create a lower output of 46. 
This operation adds a green hue to the shadows and magenta 
to the skin tones.

3Reduce the contrast
To reduce our digitally sourced photo’s strong range of tones, 
go to the Basic panel and increase the Shadows slider to +30. 

Lighten the Blacks to +30. Decrease the Contrast slider to -30 to 
produce more washed-out looking tones. Drag the Clarity slider to 
-15 to reduce the midtone contrast and produce a slightly softer-
looking photograph. In essence, we’re doing the opposite of what 
we would normally do to improve a photo.

2Produce filmic colours
Go to the Blue channel and place an anchor point in the 
middle of the curve line with the Input and Output levels 

at 128. Place a second point in the top half of the curve line at 
an Input of 192, and drag it down to a lower output of 154. By 
reducing the blue highlights, you add a vintage wash of yellowy 
green to the highlights. We now have a more filmic cross- 
processed colour palette.

4Over-expose the edges
Old film lenses could be less effective at exposing the 
negative with a consistent amount of light, leading to a 

change in edge exposure. To recreate this look, toggle open the 
Effects panel. In Post-Crop Vignetting, set Amount to +40. 
Set Style to Color Priority to include more of the cross-processed 
colours in the vignetted edges. Increase Midpoint to 65 to push 
the vignette towards the corners.
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5Add film grain
Double click the Zoom tool’s icon to magnify the shot to 
100%. This will help you to produce more effective-looking 

film grain. In the Effects panel, push the Amount slider up to 20 
for more noticeable grain. Set Size to 54 for larger chunks. Increase 
Roughness to 78. This mimics the more organic-looking clumps of 
film grain (instead of the sharp greyscale dots produced by high-
speed ISO digital noise).

7Add a light leak
To add a light leak effect, click the New button in the 
Adjustment Brush panel. Set Sharpness and Clarity back 

to 0. Increase the Exposure slider to 2.30. Click the Color 
swatch. Choose an orange colour with a Hue of 44 degrees and 
a Saturation of 90%. Set Density to 73. Click and paint down 
the side of the frame to create the blown-out tones and colours 
associated with fogged film.

6Blur the edges
Zoom out to Fit in View. Click the Adjustment Brush icon. 
Drag the Clarity slider left to -100. This decrease in midtone 

contrast will add a blur effect to your brush strokes. Drop Sharpness 
to -100 too. Set the brush tip size to 12. Use a Feather of 80 for a 
soft edge. Paint around the edges of the frame. Image details will 
become gently blurred, but the grain you applied in the previous 
step will remain.

8Create a preset
Once you’ve spent lots of time producing your retro look, 
it makes sense to save all the adjustments as a customised 

preset that you can apply to other shots with just a few clicks. 
Go to the Presets panel and click the New Preset icon at the 
bottom. In the New Preset window, label it Retro Preset. Leave 
all the boxes ticked. Click OK. The new preset will appear in the 
Presets panel.  
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W
hen processing a portrait in Camera Raw you may 
feel under more pressure to produce great-looking 
results, because you’ll want the photo’s subject to 
be pleased with your image-editing skills. 

However, there are a few factors that may conspire against 
your plans to capture a perfect portrait. For starters, your 
subject may be having a ‘bad hair day’ and it’s not until 
viewing the image at 100% that you’ll notice distracting 
fly-away hairs obscuring their features. Your model may also 
be suffering from spots, which they aren’t able to totally 
conceal with make-up. If you use a burst of flash to bring out 
the shape and form of your subject’s face then you may 
inadvertently create shiny hot spots on the skin that make 
the subject look unflatteringly sweaty.

Camera Raw has all the tools you’ll need to counteract shiny 
hotspots and remove other unsightly blemishes, as you’ll 
see in our comprehensive portrait-retouching walkthrough 
starting on the next page. We’ll also demonstrate how to set 
up and store custom Adjustment Brush tips that perform a 
range of selective enhancements, such as whitening teeth, 
teasing out fine iris details and removing unsightly veins in 
the eye whites. You can then call upon the services of these 
custom portrait-enhancing brush tips in the future and 
speed up your retouching workflow on other portraits. 
We’ll also show you how to create a smoother, more youthful 
complexion by selectively adjusting the Clarity of the skin 
and creating healthier, more natural-looking skin tones with 
help from the White Balance tool.

Retouch portraits 
like a professional
Use a host of retouching tools and techniques 
to make your portraits perfect in Camera Raw

BEFORE
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1 Improve the composition
Open PMZ51_portrait in Camera Raw. When shooting models 
it can be a challenge to capture a well-framed composition. The 

subject in this portrait looks off-balance as she’s leaning left, but 
looking right. There’s lots of empty space to her left too. It’s good 
practice to improve the composition first before you start fixing other 
problems. This saves you wasting time editing an area that will be 
cropped out later.

3Tweak the tones
Click another tool (such as the Zoom tool) to apply the crop 
and rotate the image. As well as straightening her up and 

repositioning her, the subject now looks more prominent in the frame. 
Her highlights are a little blown-out and lack detail, however, so 
go to the Basic panel and drop the Exposure a little to -40. Pull the 
Highlights slider down to -12. This restores more colour and detail in 
the brighter parts of the portrait.

2Rotate and reposition
Hold the mouse down on the Crop tool icon and choose 1:1. 
This will create a square crop. Drag to crop out some of the 

empty space around the subject. Drag just outside of the crop overlay 
to rotate it. This will counteract the subject’s lean and straighten 
her up once we apply the crop. Drag inside the overlay to create 
space on the right of the frame for the subject to look into, which is 
conventional practice in portrait composition.

4Balance the whites
Our subject looks a little warm due to an incorrect or 
ineffective white-balance setting in-camera. This makes 

her skin tones look too orange. You could experiment by applying 
different White Balance presets in the Basic panel, but for more 
healthy skin tones grab the White Balance tool and click her eye 
whites. This cools down the warm tint in an instant and creates a 
custom temperature of 4650 degrees.
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5Set up the Adjustment Brush
Use the Zoom tool to magnify the shot to 100% so you 
can work more effectively on the subject’s eyes. Grab the 

Adjustment Brush tool from the toolbar. The Basic panel will be 
replaced with the Adjustment Brush panel. Click to place a pin on the 
white of an eye. Drop Saturation to -53 to reduce the impact of veins. 
Push Exposure up to +0.25 and increase Highlights to +16 to brighten 
the whites. Set Size to 3 and Feather to 67.

7Refine the mask
The mask will reveal which areas are being brightened and 
desaturated as coloured patches. Auto Mask should protect 

neighbouring regions from being adjusted, but if the brush has strayed 
outside the eye whites or teeth, tick the Erase button. Paint over any 
masked areas to stop them from being adjusted. You can also click the 
Add button and paint to include areas of eye whites or teeth that you 
may have missed.

6Whiten the eyes and teeth
To lighten and desaturate the eye whites without altering the 
iris, tick the Auto Mask box. This helps restrict the Adjustment 

Brush’s behaviour to alter just the sampled eye whites. Paint over the 
whites of both eyes to lighten and desaturate them. Paint over the 
teeth to whiten them and remove any staining. To see precisely which 
areas are being adjusted, tick Show Mask. Chose a contrasting mask 
colour from the adjacent swatch.

8Fine-tune the adjustment
Once you’ve tidied up the mask, untick the Show Mask box 
so that you can see the edited tones more clearly. When 

retouching a portrait, it’s easy to go too far and create glowing white 
eyes. To tweak the results produced by a particular pin, simply click 
the pin to target it. The sliders in the Adjustment Brush panel will 
change to the values attached to the pin. In this case, push Exposure 
up to +0.35 for slightly brighter eye whites.
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9 Save a preset
Once you’ve spent time tweaking the Adjustment Brush’s 
sliders to produce a specific result (such as whitening eyes and 

teeth), you can save it as an easy-to-access preset. Click the little fly-
out icon at the top right of the Adjustment Brush panel. Choose New 
Local Correction Settings. Label the preset as Brighten whites and 
remove stains. Click OK. You can access this preset from the fly-out 
icon at any time.

11 Save an iris preset
To help tease out fine midtone textures in the iris, 
set Clarity to +35. To bring out more of the iris’s blue 

colouring, drag the Temperature slider to -18. Boost the Saturation 
slider to +15. Now that you’ve set up the iris-enhancing brush 
tip, save it by clicking the fly-out icon and creating a New Local 
Connection preset called Iris Enhance. Click OK. Paint over the 
subject’s other iris to create a matching pair.

10 Enhance the irises
The eyes are the first thing that people notice, so it’s worth 
enhancing the subject’s irises to give them more impact. 

With the Adjustment Brush still active, click the New icon in the 
Adjustment Brush panel. Click to place a pin on an iris. Paint with a 
small brush over the iris. If you keep Auto Mask ticked, the tip won’t 
stray past the contrasting edge of the iris. Set Exposure to +0.45 and 
Contrast to +30. Boost Highlights to +26.

12 Discover spots
Select the Spot Removal tool from the toolbar. The 
Spot Removal panel will appear. Set Size to 3. Set the 

Type drop-down menu to Heal. This will help to create a seamless 
skin graft when you transfer clean skin over an unwanted spot. To 
discover spots more easily, tick the Visualize Spots box. Adjust the 
slider to get a greyscale preview of potential spots. Contrasting spots 
will stand out in white.
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13Remove the spots
Click to place the cursor over a potential spot. A circular 
red overlay will appear over the spot. A connected green 

overlay will sample adjacent clean skin and place the sampled pixels 
inside the red overlay to hide the spot. Drag inside an overlay to 
reposition it. Drag the edge of an overlay to resize it. The white spots 
in the Visualize Spots preview should be replaced by black, which 
means they’ve been eradicated.

15Resample a source
When you click (or paint an irregular shape) to place 
a spot-removal overlay on a spot or hair, the Spot 

Removal tool will automatically attempt to choose a clean patch 
of pixels that have a similar colour and tone to the areas around 
the unwanted object. If it samples an area that isn’t suitable, 
try pressing the / key. This will cause the green overlay to 
automatically sample a new area.

14Remove unwanted hairs
In older versions of Camera Raw, you could only create 
circular shapes when removing spots. From Camera Raw 

8.4.1 onwards, you can paint over non-circular shapes to retouch 
the image. Our subject has stray hairs hanging over her brow. Paint 
irregularly shaped strokes over these hairs to replace them with 
adjacent patches of clean skin. Tidy some of the fly-away hairs 
around the edges of the hair.

16 Smooth the skin
Grab the Adjustment Brush once again. The New 
button will automatically be ticked in the Adjustment 

Brush panel. Zero the sliders apart from Clarity, which you 
should set to -51. Drop Contrast to -15. Untick Auto Mask so 
that you can smooth out contrasting shiny hot spots as well as 
the midtones of skin pores. Paint over the subject’s face for a 
more flattering complexion. 
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S  hooting a location at night can produce a photo 
with a moody and atmospheric look, but it also 
raises practical challenges in relation to your 
camera settings. You could open the lens’s 

aperture to let in more light, but that will result in a shallow 
depth of field that creates background or foreground blur. 
By bumping up the ISO speed you can shoot handheld with 
a faster shutter speed, but that could add unwanted and 
distracting chroma and luminance noise to your photo. If you 
have access to a tripod, you could use a lower ISO setting, 
a slower shutter speed and a narrower aperture to get more 
detail in focus, but that approach is more time-consuming 
and it might limit your compositional choices.

By using the Camera Raw colour- and tone-adjusting tools 
to fake a nocturnal look, you can capture any location during 

the day without having to lug a tripod around. This frees 
you up to capture spontaneous events with a wider choice 
of composition. In daylight it’s also much easier to capture 
a shot with both the foreground and background detail in 
focus. It’s also a fun project!

In this walkthrough we’ll show you how to produce 
a cooler, bluer colour temperature, which helps evoke a 
nocturnal light source such as the moon’s sunlight-reflecting 
surface. To help sell the nocturnal illusion, we’ll show you 
how to add a computer-generated moon using the Radial 
filter, and then duplicate and modify the filter to add a 
contrasting lunar corona. You’ll use the Adjustment Brush 
to add the moon’s reflection to the water. You’ll also make 
atmospheric shadows close in around the edges of the frame, 
courtesy of the Camera Raw Effects panel.

Turn day 
into night
Change the colour temperature and tones of a photo and 
add light effects to create a simulated nocturnal scene

See p194 to  
find out more

Free  
assets!  
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1Cool down the colour
Open PMZ35_night in Camera Raw. Go to the Basic panel. 
Our starting image has a colour temperature of 750, which 

adds a warm hue to the scene. Drag the Temperature slider left to 
a cooler value of 5400 degrees K (or you might find it quicker to 
double click the Temperature field and type in the precise value). 
Already the image is taking on a nocturnal look, just with 
a simple temperature change.

3Desaturate the colour
Our cold blue colours look a little too saturated and garish 
(and may not print very well). For a more subtle blue cast, go 

down to the lowest section of the Basic panel and reduce the Vibrance 
slider to a value of -25. Drop the Saturation slider to -16. This should 
help to create a weaker wash of blue and mimic the effect of sunlight 
being reflected from the moon. You may need to tweak the settings 
further depending on your own monitor.

2Darken the shadows
The direct sunlight in our daytime-sourced starting image is 
too intense for our purposes. To reduce the brightness and 

evoke a weaker lunar light source, drag the Exposure slider left to 
a value of -0.70. Boost Contrast to +21. Set Highlights to -30. For 
darker shadows, drag Blacks to -45. Set Clarity to +35. Go to the 
Tone Curve panel’s Point Curve tab and set the Curve drop-down 
menu to Medium Contrast.

4Vignette the edges
To create a more atmospheric-looking nocturnal scene, you 
can make the shadows appear to close in around the edges 

of the frame. To do so, toggle open the Effects panel. Go to Post 
Crop Vignetting. Set the Style drop-down menu to Color Priority 
to darken the edge colours in a more natural way instead of simply 
tinting them with black. Set the Amount slider to -17 to add the 
moody vignette effect.
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5Add the moon
To add a convincing lunar light source, go to the toolbar and grab 
the Radial Filter. Set Exposure to 4 for a bright light source. Drop 

Feather to 11 for a relatively hard edge. Hold down Shift to constrain 
the shape to a circle, and drag to draw the moon. The apparent size of 
the moon varies naturally, so don’t worry about getting the size exactly 
right. You can reposition the moon to stop it overlapping the clouds by 
dragging the green pin at its centre.

7Create the reflection
Grab the Adjustment Brush from the Camera Raw toolbar. Set 
Temperature to a cool -45. Set Exposure to +1.20. Set Highlights 

to +47 to brighten the patches of blurred, foamy water. Drop Saturation 
to -35. Set Size to 12. Choose a soft edge by setting Feather to 80. 
Finally, set Density to 73. Paint over the sea to add a hint of the moon’s 
reflection in the water. Ensure the centre of the reflection lines up with 
the centre of the moon, or the effect will fail.

6Add the corona
Right click the Radial Filter’s pin and choose Duplicate 
from the context-sensitive pop-up menu. Hold down Shift 

and drag an edge control point to increase the duplicated Radial 
filter’s size. Drop Exposure to a weaker +1.65. Set Feather to 44 for 
softer edges. Increase Highlights to +26 to lighten the overlapping 
clouds. Increase Temperature to +95 for a warmer lunar corona that 
contrasts with the cool blue sky.

8Add the stars
You can fine-tune the position of the Adjustment Brush’s 
reflection by dragging its pin. You can click either pin and 

tweak any of the associated sliders to refine the effect that they 
produce. Finish off by grabbing the Radial Filter. Zoom in to 100% 
magnification. Shift drag to add a few tiny stars. Untick the Show 
Overlay box so you can see the stars more clearly as you draw. Resist 
the temptation to make too many! 
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2Punchy high contrast
More often than not, images converted to black and 
white will benefit from a boost in contrast, and you 

can push things much further than you would with a colour 
image. Go to the Camera Raw Tone Curve panel, click the 
point tab, then plot an S-shaped curve like the one shown to 
lift the highlights and darken the shadows.

1Delicate low contrast
For a low-contrast, understated black and white, first 
open an image in Camera Raw, then go to the HSL/

Grayscale panel and check Convert to Grayscale. Here, we drag 
Highlights down to reveal detail in the sky, and Shadows up 
to lift the boat. Hold Shift and double click the Whites and 
Blacks sliders to auto set the points.

Master tonality in 
your monochromes
There’s more to black and white than just removing the colour. 
Learn how to take control of contrast and tones in Camera Raw

BEFORECrisP Details

Clarity crisps up edges by increasing midtone contrast. try dragging 
the Clarity slider in the Basic panel upwards. if you want even more 
than 100% Clarity, you can grab the Graduated filter tool, load it 
with extra Clarity using the sliders on the right, then drag a grad 
outside the image window and direct it away from the image.

See p194 to  
find out more
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4selective enhancements
Use the Adjustment Brush and the Graduated and 
Radial Filters to help to draw the eye towards your 

subject. Grab the Adjustment Brush, set negative Exposure 
and positive Clarity, then paint to boost the island. Grab the 
Radial Filter, set Exposure -1.00, then hold Cmd/Ctrl and 
double click the image to apply a vignette.  

3Colour range control
We may have stripped the colour out, but we can still 
use the colour data to fine-tune the conversion. Either 

adjust the colour sliders in the HSL/Grayscale panel, or drag 
over points in the image with the Targeted Adjustment tool. 
Here darkening the blues reveals more cloud detail, and lifting 
the yellows lightens the grass.
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BEFORE

M
ulti-processing raw files is a great way to 
squeeze extra detail out of landscapes and 
high-contrast scenes. All you do is process the 
image a number of times, focusing on different 

areas – such as land or sky – then blend them together in 
Photoshop. This gives us the best of both worlds. You can 
use Camera Raw’s tonal controls to tease out all the detail 
in different areas of the image, and use Photoshop’s 
superior selection and compositing controls to bring 
everything together seamlessly.

To do this, you can take advantage of Photoshop Smart 
Objects. The normal way to open an image into Photoshop 

from Camera Raw would be to simply click the Open 
Image button. But by shift-clicking the button you instead 
open the image as a Smart Object. Crucially, this means 
that you can double click the little image thumbnail on 
the layer in the Photoshop Layers panel to take the image 
back into Camera Raw for further editing. You can also 
make duplicates of the original layer and process them 
separately, which allows you to concentrate on enhancing 
different areas of an image. Bringing the whole thing 
together is a simple enough job with layer masks, which 
enable you to poke a hole in one layer to reveal the 
improved area on the layer below.

Multi-process 
your raw files
Discover how to pull extra detail out of your 
raw files by processing them several times
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1Enhance the sky
First we need to process the raw demonstration file while 
paying attention just to how the sky looks. In our original 

file the sky is looking a little washed out, so we can darken it 
down to make the blues more intense. To do this, we simply need 
to go to the Exposure slider in the Basic panel and drag down 
until the tones in the sky look deeper and richer – about -1.40 
for this image.

3Open it as a Smart Object
We hold down Shift and notice that the Open Image 
button at the bottom right switches to Open Object. 

Click to open it in Photoshop. Go to the Layers panel. The newly 
opened image appears as a Smart Object layer, which means we 
can double click the thumbnail to take it back to Camera Raw at 
any time. Right click the layer and choose New Smart Object via 
Copy to create a duplicate.

2Drag a gradient
The dawn light here is creating a nice pink glow along the 
horizon, which we can enhance with a simple gradated 

tonal change. We grab the Graduated Filter from the Tools panel, 
then go to the tonal settings on the right. Dial in Temp +36, Tint 
+100, Exposure -0.40, Saturation +48, then drag up from the 
land to the sky. Hold down Shift while dragging to keep the lines 
perfectly horizontal.

4 Improve the foreground
The duplicated Smart Object isn’t linked to the first layer, 
which means it can be edited independently. We double click 

the image thumbnail on the layer to go back to Camera Raw. We 
can process this layer for the foreground water. Reset any previous 
settings. Set Exposure +1.50, Contrast -18, Shadows +27, Clarity +16, 
and Vibrance +36 to lift the foreground. Click OK to take the newly 
edited copy back into Photoshop.
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5Process for the waterfall
Once again, we right click the layer and choose New Smart 
Object via copy, then double click the thumbnail on the 

new layer to go back to Camera Raw. We can process this version 
to improve the tones in the waterfall and the mountain. Reset the 
previous settings (we can do this by clicking the flyout menu and 
choosing Camera Raw defaults, then set Shadows +44, Clarity +31, 
and Saturation +12. Click OK to go back to Photoshop.

7Select the sky
We drag the lowest layer (the one with the best sky) to the top 
of the layer stack. Rather than painting this time, we can make 

a selection to quickly isolate the sky. Grab the Quick Selection Brush 
from the Tools panel and paint over the blue sky to select it. For an 
improved selection, we click the Refine Edge button at the top and 
increase the Radius slightly to make the command seek out similar 
sky-coloured pixels along the edges.

6Mask the foreground
Now that we have three versions of the scene, we can use layer 
masks to combine them. We go to the Layers panel and click 

the Add layer mask icon. This enables us to paint with black over the 
image to hide parts of the top layer and reveal the foreground detail on 
the layer below. Grab the Brush tool, set the foreground colour to black, 
press 3 to set the brush opacity to 30%, then gradually paint over the 
water to reveal the improved foreground.

8From selection to mask
Once we’re happy with the selection, we click the Add layer 
mask icon in the Layers panel to convert the selection into a 

layer mask, which hides everything but the selected area. Now that 
the three layers are blended, we can fine-tune things to finish off. We 
can tweak each layer individually by taking them back to Camera Raw 
again, or you can adjust the layer opacity to tone down the effects of 
a layer.  
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Advanced 
tips & tricks
Save time and effort with our little-known Camera 
Raw image-processing workflow shortcuts

172 Share your processed 
raw files
Discover how to ensure that the 

processed raw files you wish to share are accessible 
by anyone using any software

174 Process JPEGs 
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JPEGs as if they were raw files using Camera Raw 
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176 Open a raw file 
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later in the process by converting a raw file into a 
Smart Object
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182 Correct distortions 
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Share your 
processed images
Discover how to ensure that the processed raw files you 
wish to share are accessible by anyone using any software

Store Camera Raw image settings inside your processed raw file

Photoshop Anatomy Save as a DNG

1 SAVE IMAGE

if you want to export your processed 
raw file as a digital negative, click 
this button here to access the save 
Options window.

3 COMPATIBILITY

to open dnG files in older versions 
of photoshop, click here. this setting 
allows our dnG to be compatible with 
cs6 and Lightroom 4.1 onwards.

2 DNG

if you set the File extension drop-
down menu to dnG, the Format 
drop-down menu will change to 
digital negative.

4 EMBED DATA

clicking here enables camera raw to 
open the file more quickly and apply 
stored adjustments, though it will 
increase the file size slightly. You can use 
a smaller camera raw cache preference 
setting if this option is regularly used.

 
5 LOSSY COMPRESSION

ticking this option creates lighter dnG 
files, but you will lose some data and 
quality. Leave it unticked (or save a copy 
as a JpeG if you need a smaller version).

6 EMBED ORIGINAL

By ticking this box you can store the 
unprocessed raw file’s data inside your 
dnG. there’s no real need to do this and 
it’ll create a much larger file size.

O
nce you’ve spent time processing 
your raw files in the Camera Raw 
editor, you’ll need to save and 
share them. There are many 

different raw format files that you can edit in 
Camera Raw, from Nikon’s NEF format to 
Canon’s CR2. If you edit one of these formats 
using any of the Camera Raw tools and then 
click Done, a sidecar file will be created and 

stored alongside the edited raw image. This 
XMP format file contains a record of every 
tool and slider setting that you applied to the 
raw image. If you share the raw file, then you 
need to include the XMP file too if others are 
to see and access the changes that you’ve 
made. Different raw formats (and raw files 
from newer cameras) can be harder to access 
in older versions of Photoshop, which is why 

it makes sense to save your processed files in 
Adobe’s Digital Negative (DNG) format. This 
embeds the Camera Raw adjustments inside a 
single DNG file, so you can share it without 
worrying about sidecar files. Digital Negatives 
are also easier to open in older versions of 
Photoshop. We’ll show you how to save files 
in the DNG format and then explore other 
sharing formats.  
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Store and share copies of your edited work more easily

Overview Save in other formats

1 LOCATION

click select Folder to choose a location for the saved version of 
your edited file. You can save it alongside the original raw file or 
choose a new location.
 

2 JPEG

to save a lightweight version of your processed picture to 
share on a web gallery, social media site or email to family and 
friends, choose JpeG from this drop-down menu.
 

3 METADATA

All raw files contain data about the camera settings used to 
capture the image. You can include all of that data (or a more 
limited selection such as any attached copyright information) 
by using this drop-down menu, but it won’t make any difference 
to the file size.

4 QUALITY

You can create a smaller faster-to-download file by dropping 
the quality value – though this can add compression artefacts. 
if posting a copy to twitter, you can tick here and choose a File 
size limit of 100k.
 

5 COLOR SPACE

if sharing online, use a screen-friendly colour space such as 
srGB. For more faithfully reproduced print colours, set this 
option to Adobe rGB (1998).

6 RESIZE

if you plan to print a copy of your picture, you can resize it to fit 
specific print dimensions such as a 10x8-inch print. it’s worth 
ticking the sharpen for screen or Glossy paper option too, 
depending on the image’s destination.

1
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2Clipping and Clarity
The histogram demonstrates that our shot lacks strong 
highlights, so drag Highlights to +39. The highlight 

clipping warning helps you avoid blowing out the highlights 
more effectively than the tools in Photoshop. Increase 
Clarity to +36 to increase midtone contrast.

1Access Camera Raw Filter
In Photoshop, go to File>Open and browse to select our 
PMZ38_raw filter.jpg starting image. Click Open. By 

default, the image will open in Photoshop (unless you’ve 
changed the Camera Raw preferences). To take the shot into 
Camera Raw, choose Filter>Camera Raw Filter.

O
nce you’ve become familiar with the tools that 
you can access in Camera Raw, you may prefer to 
edit all of your image formats in this workspace, 
even compressed JPEGs. Although JPEGS lack 

the extra information about colour and tone stored in a raw 
file, Camera Raw still enables you to correct typical photo 
problems quickly and easily. Colour- and tone-tweaking 
tools are close to hand in the Basic panel. You can also 
summon a handy before-and-after view.

By default a JPEG will open in Photoshop, but if you 
go to Camera Raw and click the Preferences icon you 
can go to the JPEG and TIFF Handling section of the 
Preferences window and set the JPEG drop-down menu to 
Automatically open all supported JPEGS. Click OK. Now 
when you open a JPEG from within Photoshop, it will be 
taken straight to Camera Raw. 

Alternatively, you may prefer to start working on your 
JPEGs in Photoshop and then take them into Camera Raw 
to apply specific effects. The Camera Raw Filter enables you 
to open your edited JPEG in Camera Raw so that you can 
access tools that aren’t in the Photoshop workspace, such as 
the Split Toning tab and the Clarity slider.

Process JPEGs 
in Camera Raw
Open and edit your compressed JPEGs as if they were 
raw files using Camera Raw tools and techniques

BEFORE

See p194 to  
find out more
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4Add extra effects
The JPEG’s compression artefacts are noticeable in the 
sky. To disguise them and add character to the image, 

go to the Effects panel. Set Grain Amount to 42 and Size to 43. 
This is a much easier way to add grain than in Photoshop. Add a 
vignette to atmospherically darken the edges. Click OK.  

3Selective contrast boost
Once you’ve tweaked the tones to create a stronger 
contrast, you can be more creative. Click the HSL/

Grayscale panel and tick the Convert to Grayscale box. Push 
the Green and Yellow sliders to the right to lighten the 
vegetation and make it contrast with the darker rocks.
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BEFORE

O
ne bonus of editing in Camera Raw is the fact that 
it’s a non-destructive editing process. Any 
changes that you make using sliders or tools can 
easily be reverted to the original settings that you 

captured in the camera. A raw file’s non-destructive status 
means you can’t make any permanent mistakes and lose 
original file data, so you’re free to experiment with different 
looks. When you click Done, the changes will be stored 
alongside your edited raw file (or inside it if it’s you save it 
as a DNG format file). You can then open the edited image at 
any time in the future and fine-tune it, or reset it to its 
original unedited state.

However, once you’ve done all you can using the tools 
and sliders in Camera Raw, you may want to take the 
processed picture into Photoshop to continue editing its 
look with filters, or add text perhaps. By leaving Camera 
Raw, you lose access to its non-destructive editing 
abilities. You also lose access to the extra colour and 
tonal information stored in the raw file. 

By opening your edited raw file as a Smart Object, you 
can continue enjoying the non-destructive power of the raw 
format, and access valuable information, even after you’ve 
started to edit the image in Photoshop. A Smart Object is a 
separate file that stores all the information about the original 
image, so you can edit in Photoshop and then pop back 
to the Camera Raw file to tweak its sliders. You can then 
continue editing the fine-tuned file in Photoshop. Here’s a 
Smart Object workflow…

Open a raw file 
as a Smart Object
Give yourself more editing options later in the process 
by converting a raw file into a Smart Object

See p194 to  
find out more

Free  
assets!  



Teach yourself Raw in Photoshop
AdvAnced tips & tricks

177

AdvAnced tips & tricks



Teach yourself Raw in Photoshop
AdvAnced tips & tricks

178

1Open the raw file
If you prefer to start your workflow from Bridge, select the 
supplied raw file’s thumbnail and choose File>Open in Camera 

Raw (or summon the same pop-up menu option by right clicking the 
thumbnail). If you prefer to start from within Photoshop, then you 
can choose File>Open As Smart Object. This will take the photo into 
Camera Raw too. Bridge users can convert the edited raw file into a 
Smart Object later, as we’ll demonstrate in this walkthrough.

3 Increase the contrast
Warm up this cold shot by dragging the Temperature slider 
to 5200. This setting also removes the starting image’s blue 

colour cast. Drop Exposure to -0.40. For a more dramatic contrast 
between shadows and highlights, drag the Contrast slider right to 
+28. To create the clipped shadows produced by the bleach-bypass 
process, drag the Blacks slider left to -19. We now have a more 
high-contrast look.

2Process the picture
However you decide to open your image into Camera Raw, you 
can process it using the following steps. We’ll use Camera Raw 

to emulate the subdued warm colours and the contrasting tones of 
the Hollywood-style bleach-bypass film-processing technique and 
then add a background bokeh to the portrait in Photoshop. We’ll 
then show you how to take advantage of the Smart Object format 
to go back into Camera Raw.

4Tweak the colours
You can double check that you have the characteristic 
clipped shadows produced by the bleach-bypass process 

by pressing U to turn on the Shadow Clipping warning. Clipped 
shadows will appear as patches of blue. To create the desaturated 
colours that are also associated with this look, drag Saturation 
down to -43. Boost Clarity up to +82 to increase the midtone 
contrast and give details more punch.
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5Open it as a Smart Object
We’ll now take the processed raw file into Photoshop and 
blur the background. If you chose to use Photoshop to open 

the raw file as a Smart Object, then click the OK button at the 
bottom left of Camera Raw. If you opened the DNG as normal, then 
you won’t see an OK button. Instead, hold down Shift and the Open 
Image button will change to Open Object. Click the button to take 
the raw file into Photoshop.

7Add a bokeh effect
Click the Smart Object layer’s thumbnail to target it. Go to 
Filter>Blur Gallery>Iris Blur. Set the Blur slider to 52 to blur 

the area outside the subject’s face. Drag the blur pin’s position, 
edges and control points to fine-tune which areas are blurred and 
which remain sharp. Increase the Blur Effects Light Bokeh slider 
until the highlights in the blurred parts of the image begin to flare. 
Click OK to apply the filter.

6Embedded Smart Object
Your processed raw file will open in Photoshop, giving 
you access to all the extra tools and filters that are 

unavailable in Camera Raw. Look in the Layers panel. You’ll see 
a little icon in the corner of the preview thumbnail that 
indicates the layer’s status as a Smart Object. We’ll use this 
status later on to fine-tune the file in Camera Raw after we’ve 
processed it a bit more in Photoshop.

8Back and forth
By double clicking the Smart Object layer you can go back 
into Camera Raw and claw back more highlight detail from 

the original raw file. Click OK to go back into Photoshop. Because 
you’re working with a Smart Object, you can double click the Smart 
Filter’s Blur gallery label and fine-tune the blur settings too. Thanks 
to Smart Objects, you can change any edited attribute in both 
Camera Raw or Photoshop.  
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Save time with 
custom raw presets
Create and apply image-processing presets in Adobe Camera 
Raw and Adobe Bridge to save time and effort later

Record slider settings and apply them with a click

Photoshop Anatomy Create a preset

1 ADJUST THE IMAGE

We boosted the Basic panel’s contrast 
slider to +18, increased vibrance to 
+62 and cooled down the temperature 
to 4300.

3 NEW PRESET

After making adjustments, click here 
to save them as a one-click preset. 
the new preset window will appear.

2 CROP

We cropped the shot to create a 
portrait-oriented image. the preset 
won’t store the composition change, 
just the colour and tonal adjustments.

4 SETTINGS

By default all the settings will be ticked. 
You can choose to save some settings 
but not others. click to select a subset 
such as the Basic sliders.

 
5 NAME

Give your preset a descriptive name 
(such as ‘contrast and colour boost’) 
so that you can easily identify and apply 
it to other images in Bridge or camera 
raw. click Ok to save the preset.

6 PRESETS PANEL

Any presets that you create will 
appear here. to apply a preset’s stored 
adjustments to a raw file, click its label. 
You can also click the fly-out icon on 
the right of the panel and choose 
Apply preset.

Y
ou’ll probably spend lots of time 
correcting common problems in 
Camera Raw over and over again. 
Under-exposed photos will need 

to be brightened up and have their colour 
saturation boosted. Over-exposed images will 
need their clipped highlight detail restored. 
If you use the same camera settings to capture 
a batch of images on location then they may 

all need identical corrections in Camera Raw. 
Applying these corrections to each photo is 
unnecessarily time-consuming. After fixing a 
photo that’s representative of the problems in 
the batch, you can record the position of the 
various Camera Raw sliders as a preset and 
then apply the look that they produce to the 
other photos with a click. As well as typical 
photo-fixing presets, you can store a range of 

creative ones. This enables you to quickly 
experiment by applying special effects to your 
raw files, for example. Once you’ve created a 
collection of photo-fixing presets in Camera 
Raw, you can apply them to single shots or 
groups of images from Bridge, without 
needing to open Camera Raw. Check out our 
annotations to discover how to create and 
apply these time-saving presets.  
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Edit colours and tones to a batch of files with a click

Overview Apply presets in Bridge

1 STORED ADJUSTMENTS

this icon indicates that the raw image’s colours and tones have 
been adjusted. We can also see that the shot has been cropped.
 

2 UPDATE THUMBNAIL

After making changes to a photo in camera raw and clicking 
done, right click the thumbnail and choose Generate High 
Quality thumbnail. the thumbnail will update to show the 
colour, tonal and composition changes.
 

3 SELECT MULTIPLE

Here we have other photos captured in the same location as the 
edited image. to tweak their colours and tones using a preset, 
you first need to shift click to select them.

4 BATCH PROCESS

After selecting a thumbnail (or multiple thumbnails), right click 
one of them and choose develop settings. Here you can access 
and apply any presets that you created in camera raw.
 

5 DEVELOP SETTINGS

You can also access and apply the develop settings menu to 
the selected thumbnails by clicking here.

6 REMOVE PRESETS

You can restore a file to its original preset-free look by clicking 
clear settings. it now reverts to its original state.
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1 Open the image
Open a raw file. In this example our raw image was produced by 
a Nikon D800 camera. Click the Open Preferences dialog button 

in the Camera Raw toolbar. In Default Image Settings, Tick the Make 
defaults specific to camera serial number box. Click Done. Now any 
custom default settings that we create (including those using a lens 
profile) will automatically be applied to other images that were taken 
on our Nikon D800 camera.

2 Choose a lens profile
Click the Lens Corrections panel. Click the Profile tab. Tick 
Enable Lens Profile Corrections. If the lens profile doesn’t 

appear automatically, choose an appropriate lens manufacturer (in 
this instance Nikon) from the Make drop-down menu. The lens 
model and a suitable lens profile will appear. Any image distortion 
and vignetting will automatically be counteracted without the need 
to manually adjust any sliders.

Correct distortions 
with a lens profile
Discover how to get Camera Raw to make lens 
profile corrections to your photos automatically

C
amera lenses can add geometric 
distortion to an image, especially 
when shooting at a wide angle. 
The edges of the frame might also 

be vignetted, causing them to contain darker 
colours and tones than the rest of the scene. 
Fortunately, Camera Raw has a handy Lens 
Correction panel that contains a Profile tab 
that can counteract these lens-induced 
distortions. By default, Camera Raw doesn’t 
automatically apply lens profile corrections to 

your raw files, so you need to manually click 
two tabs and then click a box. In this 
walkthrough we’ll demonstrate how to 
change the Camera Raw default settings so 
that it automatically applies lens corrections 
using an appropriate profile. We’ll also 
demonstrate how to make Camera Raw 
automatically apply a lens-profile correction 
to files produced by one camera, but leave 
another camera’s raw files uncorrected. Read 
on to find out how…

Metadata

After opening a raw file in camera raw, click 
Open image to take the photo into photoshop. 
Go to File>File info. in the camera data tab you 
can see what lens and camera body were used to 
capture the photo. the profile tab in camera raw 
uses the raw file’s metadata to discover which 
camera and lens were used to take the photo. 
click Ok and close the image without saving it.

See p194 to  
find out more

Free  
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Teach yourself Raw in Photoshop
AdvAnced tips & tricks

183

AdvAnced tips & tricks

3 Save the new default
Go to the Set Up drop-down menu in the Profile tab and click 
Save New Lens Profile Defaults. Click the little fly-out icon 

on the right of the panel and choose Save New Camera Raw defaults. 
Click the little fly-out icon at the top right of the Lens Corrections 
panel and choose Save New Camera Raw defaults. Click Done. Thanks 
to this new default setting, a lens profile will automatically be applied 
to any unprocessed Nikon D800 raw files we open in Camera Raw.

5 test the correction
Click the thumbnail and choose File>Open in Camera Raw. 
You may instantly notice the change, but to check that the 

lens profile corrections have been applied to our Nikon D800 image 
by default, go to the Lens Corrections panel and click the Lens Profile 
tab. The Enable Lens Profile Corrections box should already be ticked, 
thanks to our camera-specific default settings. Click Done to close the 
corrected image.

4 Clear the adjustments
Before we test the new lens profile default on another 
Nikon D800 file, browse to the photo we've just 

edited in Bridge and right click its thumbnail. Choose Develop 
Settings>Clear Settings from the pop-up menu. This resets 
the file to its original unprocessed state and clears out any 
associated XMP file that might override the Camera Raw 
defaults that we’ve just set up.

6 Camera-specific corrections
If you own another camera (such as a Canon), you may not 
want lens profile corrections to be applied by default. Open 

an unprocessed CR2 file and make sure that the Enable Lens Profile 
Corrections box is unticked. Choose Save New Camera Raw Defaults 
from the fly-out menu. Click Done. Now, when you open a Nikon 
D800 file, the profile corrections will be applied, but when you open 
a Canon shot, the box will be unticked.  
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O
ne of Adobe Camera Raw’s greatest strengths is its simplicity. Unlike 
Photoshop, which caters for designers and photographers alike, Camera 
Raw has a single purpose, and because of this, the interface is simple and 
very easy to use. However, that’s not to say that Camera Raw is lacking in 

features or depth – you may just have to dig around a little to find what you’re 
looking for. To save you the trouble, we’ve compiled 24 of Camera Raw’s most useful 
hidden features that will save you time and hassle again and again once you’re 
familiar with them. Did you know, for instance, that you can crop and soft-proof 
photos before printing directly in Camera Raw? Or that you can use Camera Raw 
without even launching Photoshop? Or that you can achieve seemingly impossible 
tasks such as applying 200% Clarity, or tweaking the Fill Light slider – a tool 
apparently unavailable in the latest version of Camera Raw? Turn the page to get the 
lowdown on these and other amazing Camera Raw secrets…

The secrets of 
Camera Raw
We delve deep into Camera Raw to 
reveal the hidden delights, handy tricks 
and little-known features that will help 
to give your raw images the edge
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1Before and After views
The buttons in the bottom right corner of the image display give 
you a set of useful preview options for comparing the before 

and after of your edits. The left icon that looks like a Y gives you 
different split-screen before/after views, such as horizontal or vertical 
comparisons and splits (hold your mouse button down on the icon to 
choose from the list, or click to toggle between each). The second and 
third icons enable you to toggle between before and after settings.

3Cache size
If you’re in the habit of bringing lots of images into Camera 
Raw at once, you might notice that the images take a second or 

two to display, in which case increase the cache size in the Preferences 
menu. The larger the size, the greater the number of image previews 
Camera Raw can hold.

2Crop the shot
The Straighten tool will automatically rotate the shot to 
counteract the angle of the tilt. The Crop tool will become active 

and a crop overlay window will appear. The Crop tool needs to crop the 
rotated image to avoid adding transparent edges to it. The edges of the 
image that will be removed by the Crop tool appear as partially greyed 
out. You could drag the crop overlay’s corner handles to fine-tune the 
tightness of the crop.

4 Sync settings
You can edit several images all at once in two different ways. 
Either select them in the filmstrip by Cmd/Ctrl-clicking 

them, and then begin your edits. Or, edit a single image first, then 
select several and use the Sync settings option in the top-left menu. 
This second option has the added benefit that you can choose exactly 
which edits are synced – useful if, for example, you need to batch-fix 
a recurring sensor mark, but leave the other settings untouched.
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5 You don’t even need to launch 
Photoshop!
Adobe Bridge can ‘host’ Camera Raw, so there’s no need to have 

Photoshop open at all. Simply open Bridge, then right click an image 
and choose Open in Camera Raw.

7 Fix the white balance
One of the great advantages of shooting in raw mode is that 
the files hold more colour information than JPEGs, which 

means you can use the raw colour data to adjust the white balance 
after taking the shot to correct colour shifts and inconsistencies. 
To do this, simply grab the White Balance tool, then look for a 
colour in the scene that should be either white or grey, such as the 
rocks in this picture.

6 Speedy spot colour
The Targeted Adjustment tool can give you a rough-and-ready 
spot-colour effect in seconds. Right click with the Targeted 

Adjustment tool, choose Saturation, then drag down over the colours 
that you want to remove.

8Save adjustments
If you find that you make a similar adjustment lots 
of times, then save time by storing the adjustment as a 

New Local Adjustment Setting in the flyout menu at the top right 
of the Adjustment Brush settings. When you want to make the same 
edit, choose the adjustment from the menu to quickly load up the brush 
with the right settings.
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9Remove wires
When using the Spot Removal tool to get rid of telegraph wires 
in a landscape image, click one end of a wire, then hold down 

Shift and click the other end to draw a straight line and fix the whole 
thing in one go.

11 Check for sensor marks
The Visualise spots check box in the Spot Removal tool 
settings is ideal for those with dirty camera sensors. 

Check it for a clear black-and-white view of the marks.

10Monochrome in a split second
Grab the Targeted Adjustment tool from the Tools panel, 
right click and choose Grayscale Mix for a speedy mono 

conversion, then fine-tune the image by dragging up or down over 
points in the image to lighten or darken them.

12Double dose of clarity
If you’re a fan of crisp details, sometimes setting +100 
Clarity in the Basic panel isn’t enough. In which case, grab 

the Graduated Filter tool, load it with extra Clarity, then click outside 
the image and drag away. This will double the amount of Clarity added.
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13Smooth skin
For soft, silky skin in seconds, grab the Adjustment Brush, 
click the minus icon next to the Clarity slider on the right 

to dial in negative Clarity to about -50, then paint over the skin, being 
careful not to go over areas of detail like the eyes and lips.

15Copy a pin
Hold down Cmd/Ctrl+Shift+Alt and drag an adjustment pin 
to make a copy – ideal for copying adjustments from one 

eye across to the other, for instance.

14Straight grads
Hold down Shift to snap Graduated Filter lines to 
horizontal, vertical or 45 degrees – this is really helpful 

when darkening a sky.

16Add a rough border with grads
For a rough-and-ready border effect that mimics the look of 
old film borders, load the Graduated Filter tool with -4.00 

negative exposure, then drag a few short lines inwards at the edges of 
the frame to add dark, thick lines to the image.
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17Auto-mask
The Adjustment Brush Auto-Mask feature transforms the 
brush by making it seek out and snap on to colours that 

are similar to the first colour you click when using it, making it much 
easier to isolate objects and shapes for adjustment.

19 Interactive histogram
The histogram is interactive, so you can drag different parts 
of the graph to adjust those areas of the tonal range, from 

the blacks on the left to the whites on the right – useful both for fine-
tuning tones, and also for understanding how histograms work.

18Use the old Fill Light slider
If you find the Basic panel’s Shadows slider isn’t 
lifting your shadows enough, go to the Camera Calibration 

panel and change the Process version to 2010, then go back to the Basic 
panel, and you’ll find the more powerful Fill Light slider.

20Check for clipped pixels
Clipped pixels are either pure white or pure black, and 
lack detail, so it’s usually best not to have too many in 

your photos. To check for clipped pixels in an image, press O (for over-
exposed) or U (for under-exposed) to toggle the clipping warnings.
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21Mask your sharpening
Often we don’t want to sharpen all of our images, just the 
areas of detail. After applying sharpening in the Detail 

panel, hold Alt and drag the Masking slider. The black areas that appear 
will be excluded from the sharpening effect.

23Desaturate portraits
If you want to give your portraits a trendy desaturated 
look, try lowering Saturation, then increasing Vibrance in 

the Basic panel. Or vice versa if you prefer more vibrant colours.

22Preview split-tone colours
When using the Hue sliders in the Split Tone panel to add 
tints, hold down Alt while dragging to preview the colour 

at 100%. This makes it easier to judge the colour first.

24Tweak monos with Temp and Tint
After converting an image to monochrome with the HSL/
Grayscale panel, you can go back to the Basic panel and 

experiment with Temp and Tint to fine-tune the look of the black-
and-white effect.
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01 Follow the on-screen 
instructions to create 

an account with our secure 
FileSilo system, log in and 
unlock the bookazine by 
answering a simple question 

about it. You can 
then access the 
content for free 
at any time, and 
download it to 
your desktop.

02 Once you have 
logged in, you are 

free to explore the wealth of 
content available on FileSilo, 
from great video tutorials 
and exclusive online guides 
to superb downloadable 
resources. And the more 
bookazines you purchase, 
the more your instantly 
accessible collection of 
digital content will grow.

03 You can access 
FileSilo on any 

desktop, tablet or 
smartphone device using 
any popular browser (such 
as Safari, Firefox or Google 
Chrome). However, we 
recommend that you use a 
desktop to download 
content, as you may not be 
able to download files to 
your phone or tablet.  

04 If you have any 
problems with 

accessing content on 
FileSilo, or with the 
registration process, take a 
look at the FAQs online or 
email filesilohelp@
futurenet.com.
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